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Important note:
An ARGUS basic package contains at least one DSL interface (ADSL, VDSL or SHDSL), 
which includes a variety of functions and tests. All other interfaces and functions are 
available as options (see datasheet). Therefore, depending on the scope of function 
supplied, individual menu options may be hidden.
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1 Introduction
1 Introduction

The compact all-rounder
Universal xDSL+GigE+ISDN+Triple Play test set
As a latest generation high-end combi tester, the ARGUS 155 contains an extremely 
powerful ADSL/VDSL chipset that meets today's demanding technical requirements. The 
ARGUS 155 is the only handheld tester and analyzer to integrate VDSL2 (all profiles and 
Vectoring), ADSL (Annex A, B, J, L, M) and SHDSL (2, 4 and 8 wire), Ethernet, ISDN 
PRI/E1, BRI/S/T/U and POTS interfaces in a single measurement device - without having 
to swap modules.

Gigabit Ethernet interface and tests
Thanks to its Gigabit Ethernet interface (GigE), the ARGUS 155 achieves a download 
speed of multiple 100 Mbit/s with HTTP and FTP downloads, such as is already standard 
with fiber optic modems (ONT) on the LAN interface. If the Ethernet cabling is faulty, the 
ARGUS 155 can immediately locate the source of the fault by means of cabling tests 
(Ethernet TDR) via the GigE interface. This makes it possible, for instance, to detect shorts, 
opens or mismatches, but also the delay or polarity of the wire pairs, among other things.

Copper test set (Cu tests)
Copper tests (Cu tests) for physical line qualification without synchronization with the 
DSLAM are always included. If necessary, these tests can also be considerably extended 
in the field by simply connecting the compact ARGUS Copper Box via USB, thus enabling 
all important electrical parameters such as voltage, current, isolation resistance, LCL, 
NEXT and many more, to be automatically and quickly determined via tip, ring and ground. 
The TDR (Time Domain Reflectometer) function makes it possible to measure line lengths 
and trace sources of faults. A high-impedance connection enables a Line Scope to display 
the time and frequency domains (FFT) in real time. The optional Active Probe II, which is 
required for this, can be connected to an existing DSL connection and switched between 
symmetrical and asymmetrical operation.

SHDSL interface
Flexible expansion capabilities mean that the existing interfaces can be extended with 
additional functions, as required. For example, the SHDSL interface also operates in 
SHDSL.bis as well as optionally in ATM, TDM or EFM modes.
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1 Introduction
Triple Play Quality and IPv6
The ARGUS 155 tests the quality of VoIP, IPTV and data services parallel over xDSL and 
Ethernet with optional Triple Play test functions. Thanks to its integrated handset, it can 
simulate not only terminal equipment such as a telephone, PC or STB, but can also 
determine all relevant quality parameters and evaluate voice quality according to the MOS 
method. It tests IPTV suitability by means of a stream analysis, a VoD test or a channel 
scan. Several of these IP tests can also be performed using the new, more powerful IPv6 
protocol.

Easy operation
The large 320 x 240 pixel colour display and an intuitive menu structure, among other 
things, guarantee user-friendly operation. A high-performance Li-Ion battery pack ensures 
long operating times in the field.

You can download free software updates to ARGUS from you PC at any time. Updates are 
available at www.argus.info/en/service/downloads.
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1 Introduction
Overview of key ARGUS functions:

xDSL interfaces (ADSL, ADSL2, ADSL2+, VDSL2, SHDSL)
- Synchronisation with DSLAM (xTU-C) and determination of all relevant 

connection parameters and error counters
- Bridge, router and terminal-device modes, via IPv4 and IPv6
- SHDSL-DSLAM simulation (STU-C)
Ethernet interfaces
- Gigabit Ethernet test interface (10/100/1000 Base-T)
- Ethernet cabling tests
IP and ATM tests via xDSL and Ethernet
- ATM Tests (only for ADSL and SHDSL-ATM)

- ATM-OAM ping, ATM-OAM cell loop, VPI/VCI scan

- IP tests
- Ping and traceroute tests (BRAS information, PPP trace, VLAN), via IPv4 and IPv6

- Download tests for measuring throughput (HTTP-download, FTP-up/download)

- FTP server test, up/download from ARGUS to ARGUS

- Parallel testing of multiple services (VoIP, IPTV,...)

- VoIP test
- VoIP terminal device simulation, including acoustics (var. codecs), via IPv4 and IPv6

- OK/FAIL assessment of VoIP speech quality (QoS) according to:
- MOSCQE (ITU-T P.800), E-model (ITU-T G.107)
- PESQ (ITU-T P.862) in conjunction with PESQ server software

- IPTV tests
- Stream request (STB mode), IPTV channel scan, IPTV passive

- OK/FAIL assessment and display of quality parameters

ISDN functions (PRI/E1 see extra manual)
- U-interface (4B3T or 2B1Q) according to ANSI T1.601

- PRI/E1 interface according to ITU-T I.430/431 in TE and NT operation

- D-channel monitoring via BRI and PRI interface

- Testing of BRI and PRI fixed lines (E1, 2 Mbit/s)

- E1-BERT via all B-channels simultaneously (MegaBERT)

- Automatic service and service-feature tests, and much more

- Assessment of ISDN speech quality directly on BRI or U-interface
- PESQ (ITU-T P.862) + MOSLQO in conjunction with PESQ server SW
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1 Introduction
Note:
Detailed explanations regarding PRI/E1 and Copper Box may be found in the 
separate documentation for the respective device.
You should receive these together with your equipment. You can also download 
the latest manuals at http://www.argus.info/en/service/downloads, or simply 
contact our Service Department:

intec Gesellschaft für Informationstechnik mbH
Rahmedestr. 90

D-58507 Lüdenscheid
Tel.: +49 (0) 2351 / 9070-0

Fax: +49 (0) 2351 / 9070-70
www.argus.info/en

support@argus.info

POTS functions
- Fully functional integrated analogue handset (POTS)

- With DTMF and CLIP display, pulse dialling

- High-ohm 2-wire monitor with voltage measurement

- Assessment of analogue speech quality directly at POTS access
- PESQ (ITU-T P.862) + MOSLQO in conjunction with PESQ server SW

Copper test (Cu test) functions
- Copper Box: expansion of the ARGUS copper test function, see ARGUS Copper Box 

manual

- R-measurement: ARGUS continually measures resistance and displays the values in 
real time (loop resistance)

- RC measurement: Test of loop resistance or capacitance of open line (including calcu-
lation of line length)

- Line Scope: High-performance realtime Line Scope with display in time and 
frequency range (FFT) up to 30 MHz

- TDR: Time domain reflectometer to measure line lengths and locate faults

Local loop acceptance log
When connected to a PC via a USB port, ARGUS can be used to generate and print out a 
detailed measurement log on the PC using the software WINplus / WINanalyse.
10 ARGUS 155



2 Safety information
2 Safety information

ARGUS may only be operated using the accessories supplied with the device. The use of 
other accessories can result in faulty measurements or even damage to ARGUS and the 
connected equipment. Only use ARGUS according to the instructions contained in this 
accompanying document. Use in any other manner can cause harm to persons or destroy 
your ARGUS.

- Before connecting ARGUS to an access, make sure that no dangerous 
voltages or voltages for which ARGUS and its accessories are not specified 
are present. Also keep in mind that the voltage can change over the time that 
the device is connected.

- Use ARGUS only according to its intended purpose at all interfaces and local 
loops.

- Voltages over 50 V AC and 120 V DC can cause death.
- Never conduct measurements without the battery pack!
- ARGUS is not waterproof. Therefore, protect ARGUS against water 

penetration.
- Before replacing the battery pack, disconnect the power adapter and all 

measuring leads and power ARGUS down.
ATTENTION: Never remove the battery pack during operation.

- Remove the power adapter from the mains socket as soon as ARGUS is 
switched off or no longer in use (e.g.after charging the battery pack)!

- ARGUS may only be used by trained personnel.
- ARGUS may only be operated using the power adapter supplied with the 

device. 
- Only manufacturer-approved headsets may be connected to the headset 

socket; any other use of this socket (e.g. connection to a home entertainment 
system) is expressly prohibited.

- Only the Active Probe II, the ARGUS Copper Box and the other 
manufacturer-approved USB devices without mains connection may be 
connected to the USB host interface (USB-A). Any other use (e.g. connection 
to a PC) is expressly prohibited.

- If external USB devices are used on the USB-host interface (USB-A), no 
warranty is assumed for occurrences outside the mechanical wear of normal 
plug-in.

- In battery power mode, always cover the ARGUS power socket with the 
supplied rubber protective cap labelled "Power".

- The electromagnetic compatibility (EMC) has been tested according to the 
regulations specified in our conformity declaration.
ARGUS is a class A device. This device can cause radio interference in 
residential areas. In this case, the user may be required to implement 
appropriate measures.
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2 Safety information
Return and environmentally compatible disposal
Currently applicable environmental legislation restricts the use of certain hazardous 
substances in electrical and electronic devices, particularly the concentration respectively 
use of lead (Pb), cadmium (Cd), mercury (Hg), hexavalent chromium [Cr(VI)], 
polybrominated biphenyls (PBB) and polybrominated diphenyl ethers (PBDE).

We hereby affirm on the basis of the assurances, designations and documentation of our 
suppliers that all our ARGUS-brand measurement technology products are free of 
substances in concentrations, preparations or applications whose market release is 
prohibited pursuant to the applicable requirements of the RoHS Directive 2011/65/EU of the 
European Parliament and Council dated 8 June 2011. Our EAR registration number is: 
WEEE reg. no. DE 92829367.

Since October 2005, we have been marking all our measuring devices with this symbol, in 
compliance with WEEE 2002/96/EC and the corresponding German statute ElektroG:

 ( (DIN EN 50419).

In other words, ARGUS and its accessories, may not be disposed of as household waste.
Please consult with our Service department with respect to the return of old devices.

- Active charging of the battery pack and automatic charging (on by default) 
may only be carried out in a temperature range of 0 °C to +40 °C.

- The device may not be used during thunderstorms.
- If ARGUS is operated under extreme conditions, it can be set to energy-

saving mode to protect the device and the user; this can interrupt the running 
test and drop the connection. 
To ensure dependable extended operation of ARGUS, always make sure that 
it is optimally protected against high temperatures.

- The device may not be opened.
- Please observe the following safety and transport information when using the 

lithium-ion battery pack.
- Before starting a test or synchronising on an interface, determine how you 

want to supply power to ARGUS (battery pack or power adapter). The car 
adapter is only for charging the device. When ARGUS is connected to this 
adapter, you should not run any tests or synchronise on a DSL interface.
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2 Safety information
2.1 Safety and transport information for the battery pack

Transport
The battery pack has been tested according to the UN directive(ST/SG/AC.10/11/Rev. 4, 
part III., subchapter 38.3). Protective functions have been implemented to guard against 
short-circuit, destruction and dangerous reverse currents. As the battery pack contains a 
lithium quantity below current thresholds, it is not subject to international regulations 
governing hazardous materials either as an individual part or mounted in ARGUS. When 
transporting multiple battery packs, however, you may also need to observe this safety 
information. Further information is available on request.

Failure to observe the following danger and warning information can impair 
the protective functions of the battery pack. This can cause extremely high 
voltages and currents which can in turn result in abnormal chemical 
reactions, acid leaks, overheating, smoke, explosion and/or fire. Additionally, 
failure to observe this information can negatively impact both the 
performance capacity and the performance duration.


Hazard information and warnings
1. Do not disassemble or short-circuit the battery pack.
2. Do not through the battery pack into fire or overheat it (> 60 °C).
3. The battery pack must not become wet or damp.
4. Active charging of the battery pack and automatic charging (on by default) may 

only be carried out in a temperature range of 0 °C to +40 °C. 
To maximise battery life, do not store the battery long-term at temperatures above 
+50 °C.

5. The battery pack may only be charged using the corresponding ARGUS device or 
an approved charger.

6. Do not puncture the battery pack with a sharp object.
7. Do not throw the battery pack or expose it to shocks. 
8. Do not use battery packs that have become damaged or deformed.
9. The battery pack contacts have a specific polarity and may not be inserted in 

ARGUS or a charging device with reverse polarity. 
10. Only connect the battery pack to the corresponding ARGUS or charger in the 

intended manner.
11. The battery pack may not be directly connected to electrical outputs such as 

power adapters, car adapters etc.
12. Only use the battery pack with ARGUS.
13. Do not attach, transport or store the battery pack together with metallic objects.
14. Do not expose the battery pack to electrostatic charges.
15. The battery pack may not be charged or discharged together with primary 

batteries or other battery packs.
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2 Safety information
16. If the battery pack fails to charge by the end of the charging time, it can no longer 
be recharged.

17. Do not expose the battery pack to excessive pressure.
18. If the battery pack emits odours or heat, becomes discoloured or deformed or 

otherwise appears different from normal during operation, charging or storage, 
immediately remove the battery pack from the device and never use it again.

19. In the event that acid leaks and comes in contact with eyes or skin, wash 
immediately with clean water. Do not rub. In both cases, seek medical attention 
immediately. Otherwise, permanent injury may occur.

20. Keep the battery pack away from children.
21. Read this manual and the corresponding safety information carefully before using 

the battery pack.
22. If odours, rust or other abnormalities are detected before the first use, contact 

intec GmbH to clarify the next steps.
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3 General technical data
3 General technical data

ARGUS user safety tested according to  EN60950-1
RoHS conformity pursuant to the WEEE directive
The electromagnetic compatibility (EMC) was tested according 
to the regulations specified in our declaration of conformity.
CE marking
ARGUS 155 complies with EC directives 2004/108/EC and 
2009/C197/03. We will be happy to provide a detailed
declaration of conformity on request

Device specifications

Dimensions/weight Inputs/outputs

Height: 235 mm 
Width: 97 mm 
Depth: 65 mm
Weight: approx. 810 g 
(1.79 lbs)
(incl. battery pack)

- RJ-45 (BRI/PRI/E1) for BRI and PRI 
- RJ-45 (Line) for xDSL, POTS, U-interface and 
  Copper tests
- Ethernet 10/100/1000 Base-T
- Ethernet 10/100 Base-T or USB-A socket, USB-
  host interface
- USB-A socket, USB-host interface
- USB-B socket, USB client interface
- Headset input

Control panel

25 keys

LCD display Temperature range

LCD colour display with 
switchable background 
illumination 320 x 240 
pixels

Temperature range for charging battery pack: 0 °C to +40 °C
Operating temperature (in battery mode): -10 °C to +50 °C
Operating temperature (with power/car adapter): 0 °C to +40 °C 
Storage temperature: -20 °C to +60 °C
Humidity: up to 95 % rel. humidity, non-condensing

Power supply

Lithium ion battery pack with 7.2 V rated voltage (observe the 
safety information) or 12 V/1.5 A ARGUS power adapter

Miscellaneous
ARGUS 155 15



3 General technical data
Supported standards

ADSL (Line):
ITU-T G.992.1, Annex A (ADSL)
ITU-T G.992.2, Annex A (G.lite)
ITU-T G.992.3, Annex A (ADSL2)
ITU-T G.992.5, Annex A (ADSL2+)
ITU-T G.992.1, Annex B (ADSL)
ITU-T G.992.3, Annex B (ADSL2)
ITU-T G.992.5, Annex B (ADSL2+)
ITU-T G.992.5, Annex J (ADSL2+)
ITU-T G.992.3, Annex L 
 (RE-ADSL2 via analogue)
ITU-T G.992.3, Annex L 
 (RE-Narrow PSD ADSL2 via POTS)
ITU-T G.992.3, Annex M (ADSL2)
ITU-T G.992.5, Annex M (ADSL2+)
ANSI T1.413

ISDN-BRI/PRI (BRI/PRI/E1):
ITU-T I.430
ITU-T I.431
ITU-T G.821
ITU-T X.31

ISDN U-interface (Line):
ANSI T1.601

VDSL (Line):
ITU-T G.993.2 (VDSL2)
ITU-T G.993.5, G.vector (vectoring)
Profiles
8a, 8b, 8c, 8d, 12a, 12b, 17a, 30a
ITU-T G.998.4 (G.INP, Retransmission)

R/RC measurement (Line):
Resistance test:
- Accuracy for 20 - 100 ±10 %
- Accuracy for 100  - 100 k ±2 %
Capacitance test:
- Accuracy for 1 nF - 1 µF: ±5 %

SHDSL (Line):
ITU-T G.991.2, Annex A (G.SHDSL)
ITU-T G.991.2, Annex B (G.SHDSL)
ITU-T G.991.2, Annex F (G.SHDSL.bis)
ITU-T G.991.2, Annex G (G.SHDSL.bis)
ETSI TS 101 524 V 1.2.1 (ETSI SDSL)
ETSI TS 101 524 V 1.2.2 (E.SDSL.bis)
IEEE 802.3.ah (EFM)
ITU-T G.994.1 (G.hs)


Dielectric strength:



Line:
DC: max. +200 V
AC: max. +100 Vpp (Copper tests only)
DC: max. +200 V (xDSL)
DC: max. +130 V (for POTS)
DC: max. +145 V (for U-interface)

BRI/PRI/E1:
DC: max. +48 V

DC voltage measurements:
- Accuracy:  ±2 %

Ethernet (LAN):
IEEE 802.3  
- 10 Base-T 
- 100 Base-T
- 1000 Base-T
Autonegotiation
Auto-MDI(X)
16 ARGUS 155



4 Quick-start guide
4 Quick-start guide

LEDs

Softkeys

Cursor keys

Enter key

Level key

 

Telephony: Answer/hang up

Power

Microphone Belt clip

Number block

LC display

Back key

Shift key

Loudspeaker

Power key

-
-
-


-




Switches on ARGUS
Reactivation after power-down (adjustable, see page 353)
Switches on display illumination (also possible with any other key). In 
battery mode, the display illumination switches off automatically after an 
interval that can be set in ARGUS (see page 353).
Switches off ARGUS (key must be held down): after an adjustable 
interval (e.g. after 10 minutes), ARGUS automatically shuts down in 
battery mode (see page 359). When the power supply is attached, the 
ARGUS battery recharges automatically once the device is switched off 
(see page 359 Using the battery pack)

Enter key

-
-
-
-

Opens menu
Switches to next display
Starts/opens test
Accepts setting
ARGUS 155 17



4 Quick-start guide
Back key

-

-
-
-

Switches ARGUS back to the previous display without saving current 
entries, e.g. changes in a configuration parameter
Cancels tests
Exits graphic displays
Switches to main menu after powering up

Cursor keys

-
-
-


-
-
-
-

Browses display lines page by page (vertical cursor keys)
Cursor movement within a display line (horizontal cursor keys)
Within selection lists or statistics, the horizontal cursor keys can be used 
to jump to the end (right cursor key) or the beginning (left cursor key) of 
the displayed list
Select a menu, a function or a test
Set measuring ranges in copper test
Move display cursor in graphic displays
Select functions in graphic status screen

Telephony

ISDN and POTS

-
-

Answers and hangs up
Simplified single call: press the handset key twice (ISDN only) 

xDSL (access mode xTU-R, xTU-R Router) and Ethernet 

- Starts VoIP telephony

 Level key

-
-

-
-
-

Opens the graphic status screen
BRI, PRI, U-interface access: starts single-layer measurement (level/
voltage)
xDSL access: displays results
Ethernet: opens results
Start/stop function for realtime analyses (Line Scope / TDR)

Number block

-
-




Entry of numerals 0 through 9, letters and special characters
Direct function call, depending on the selected access (hot key), e.g. 
page 110 et seq.
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4 Quick-start guide
ARGUS is mainly controlled using the four cursor keys, the Enter key , the Back key 

, the Level key  and the three softkeys.

The bottom line of the display shows the current softkey assignments.

In the following pages of this manual, only the respective currently valid softkey function is 

displayed in angle brackets < > , e.g. <Menu>. The softkey < > performs the same 

function as the Enter key , the softkey <>has the same effect as the cursor key  on 

the ARGUS keypad.

Softkeys

-




-

The function of the three softkeys depends on the respective situation. 
The currently assigned function appears in the bottom line of the display 
in the form of three blue fields with white letters, e.g.:
<Menu>: opens main menu
<Start>: establishes a connection or starts a test

Other softkeys are described in the corresponding chapters of this 
manual.

Shift key

In some menus, a green "S" in a green circle appears in the top line of the 
display.
In these menus, the softkeys are assigned two functions. The Shift key 
toggles the softkey assignment (see example page 179).

Example:
Press Shift to change 
the softkey assignment.
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4 Quick-start guide
Top connections

Bottom connections

PWR
For external power adapter.
When the external power adapter is connected, 
ARGUS switches off the battery power supply. 
ARGUS recharges the battery automatically once it 
is switched off (see page 359).

USB-A or USB-A 1/2
USB-host interface 
(Active Probe II + Copper Box)

USB-B (mini-USB)
USB-client interface (PC connection)

  Headset socket

ARGUS check regularly if there are any 
USB devices connected. 


Yellow Link/Data LED:
signals physical connection with another 
Ethernet port
- LED steadily illuminated: 

connecting
- Flashing LED: transmitting/

receiving 

 
BRI/PRI/E1
Access BRI 
Access PRI 

Pin assignment: 3/6, 4/51

Pin assignment: 1/2, 7/81

Line
Access POTS 
Access U-interface   
Access xDSL 
SHDSL n-wire

Access Copper 

Pin assignment: 4/5
Pin assignment: 4/51

Pin assignment: 4/5
Pin assignment: fixed 4/5 
variable 3/6, 1/2, 7/8
Pin assignment: 4/5

LAN
Connection to a PC network card.
Connection to the Ethernet interface of an xDSL 
modem, router (IAD) or hub/switch or another 
Ethernet interface (access: Ethernet).

The green Speed LED and yellow Link/
Data LED indicate transmission speed 
- LED on: 10/100 Base-T

Green Speed LED indicates transmission 
speed
- LED on: 10/100/1000 Base-T
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Charging the battery in initial operation

The battery pack compartment is on the rear of the device. Attach the battery back by 
placing it against the retaining points at the top end and then screwing down the knurled 
screw. Use only the battery pack supplied with the device. Observe the safety information 
given on page 13. Now connect your (switched-off) ARGUS to the external power supply 
supplied with the device.

Switch on ARGUS using the  key. The following display appears (you may first need to 

acknowledge warnings or messages with <Continue>):



You must first change the battery pack supplied with the device completely (see page 359 
Using the battery pack) before full capacity is reached.

Current assignment of the softkeys.

 Press

ARGUS indicates in the display when 
the battery is completely charged.

 Press: ends charging.

The Accesses display can vary 
depending on the configuration.

Selected
menu option 

Menu name
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Power-saving mode

In battery mode, ARGUS automatically switches off after five minutes of no activity 
(interval adjustable, see page 353). ARGUS does not switch off during a test e.g.  
(Loopbox) or in trace mode.

The device can alternatively be operated using the supplied external adapter. When the 
adapter is connected, power supply via the battery is automatically switched off. ARGUS 
must always be operated with the battery, regardless of the power supply type. This 
ensures e.g. uninterrupted operation of the real-time clock.

Unplug the adapter from the mains as soon as ARGUS is switched off and

no longer in use (battery charging).
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5 Configuring accesses

 Switch on ARGUS.

Continued on 
next page

After powering up, ARGUS displays all 
configured accesses (up to 100). By 
default, one access is preconfigured for 
every interface type (ADSL, VDSL, ...). 
The most recently used access is indi-
cated on the display with .
ARGUS additionally displays a preview of 
the selected access settings, see also 
page 27. The preview window opens after 

2 seconds.
<New>

<Edit>

With the <Filter> softkey, ARGUS lets 
you filter all pre-configured accesses 
according to access type (ADSL, VDSL, 
...) and displays this group. 

In this example, VDSL is selected.

All relevant accesses are displayed in 
which VDSL is specified in the confi-
guration.

The status line (above the softkeys) con-
tinues to show the access that is "still" 
selected (in this example VDSL).

<All>

<Edit>

Creates an access, see 
page 24, Fig. 2.

Edits an access, see page 24, 
Fig. 1.

Toggles softkey assignment, 
see page 30.

Switches to main menu.

Display of all possible 
accesses, see Fig. 1.

Edits the selected access 
profile.
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5.1 Access wizard

Continued on 
next page

ARGUS switches to the "Accesses" main 
menu.

You can now configure the selected 
access, here VDSL, using the access 
wizard.

The query parameters of the access 
wizard depend on the selected access 
(ADSL, VDSL, ...), see page 27.

Selection of physical interface (here 
VDSL).
- For xDSL, see page 37.
- For Ethernet, see page 79.
- For BRI, see page 218.
- For POTS, see page 288.
- For Copper tests, see page 300.

ARGUS switches directly to the access 
mode settings.

Selection of  access mode (here VDSL 
VTU-R terminal) device).
- For xTU-R TE, see page 49.
- For xTU-R bridge, see page 74.
- For xTU-R router, see page 76.
- For STU-C, see page 78.
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Continued on 
next page

You can now link your configured
access settings with one of 20 profiles. 
These profiles link the access settings 
with the access and test parameters. You 
can define service, virtual line and other 
parameters.
The selected profile is highlighted in the 
display in blue. The default profile is 
indicated with a  in the display.

Once you have selected the profile, 
ARGUS suggests an access name, based 
on the settings you made previously (here 
VDSL). You can enter up to 24 characters 
(in this example 04/24 characters). 

<Delete> Deletes access name.


Clears mark and returns cursor 
keys to the start.


Clears mark and returns cursor 
keys to the end.

<Ab>AB> Entry begins with upper-case 
letters and continues in lower-
case.

<AB>12> Entry of upper-case letters.

<12>ab> Entry of numbers.

<ab>AB> Entry of lower-case letters.

Entry of special characters, 
e.g. @, /, -, ., *, ?, %, =, &, ! 
etc.

Entry of special characters 
e.g. _, :, +, # etc.
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Continued on 
next page

1x

ARGUS displays a summary of the 
configuration.

ARGUS returns to the editing overview of 
the selected access (here VDSL).
To configure the services or test para-
meters, select "Profile"; see also page 31.
You need to exit the access wizard before 

ARGUS can use the configured access.

Press OK to confirm the selected access, 
here VDSL.

<Phys. 
param.>

Edits the physical 
parameters, see page 39.

<Notice> Entry of notices, see 
page 33.

Save and exit the wizard.

Go back one level.

Exit the access wizard.
26 ARGUS 155



5 Configuring accesses
ARGUS switches to the ARGUS status 
display.  

ARGUS access wizard
The access wizard prompts for different information depending on the access/interface. 
Each parameter queried depends on the respective previous parameters (from left to right).

Access/
interface

Line Mode Access mode L2 mode Profile

ADSL - Annex A
Annex B

...

ATU-R TE,
ATU-R bridge,
ATU-R router

- Profile

VDSL - - VTU-R TE,
VTU-R bridge,
VTU-R router

- Profile

SHDSL 2-, 4-, 
6-, 8-wire

ATM,EFM,
TDM, ITC,

HDLC, ATM/
EFM automatic

STU-R, STU-C,
STU-R bridge,
STU-R router,

STU-C bridge*2

- Profile

Ethernet - - IP based,
cable test

- Profile

BRI - - TE, NT, 
leased line,

monitor

Auto.*1,
P-P, 

P-MP

-

U-interface - - TE, 
leased line

Auto.*1,
P-P, 

P-MP

-

PRI - - TE, NT, 
leased line, 

monitor

- -

POTS - - Terminal,
monitor

- -

Copper tests - - - - -

*1 =only for BRI-TE, U-interface-TE     *2 = only EFM

 

<Status> Switches to status screen.

<Menu> Switches to main menu.

<Start> Starts the VDSL connection.
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ADSL mode

For ADSL access, you are prompted for ADSL mode:

A TC sublayer is queried for the SHDSL access. ARGUS supports the following TC (trans-
mission convergence) sublayers:

Description

Different ADSL modes can be set depending on the variant. The set 
ADSL mode must be compatible with the ATU-C (network side). When 
ADSL auto-modes "Annex A/M auto, Annex B/J auto, Annex A auto, 
Annex B auto and Annex M auto" are selected, ARGUS automatically 
detects and matches the configuration on DSLAM.  
Default: Annex A/M auto

Description

ATM Like ADSL, asynchronous transfer mode (ATM) is based on asynchronous time 
multiplexing. The sender and receiver can run at different clock rates so as to 
serve both packet-switched (IP) and circuit-switched data traffic with a single 
transmission technology. ATM enables this by means of an intermediate layer 
with cells of a fixed size (precisely 53 bytes) between the network and data link 
layers. These ATM cells are filled with the incoming data and prioritised with the 
help of the ATM adaptation layer (AAL). Data are transported in AAL5 and speech 
in AAL1 or 2. This ensures that speech is not delayed. Type, duration and other 
transmission information are stored in a 5-byte header, which reduces the 
payload of a cell to 48 bytes. This technology offers a range of advantages thanks 
to its various OAM management functions and AAL adaptation capabilities. 
However, this consumes an overhead. Still, this technology, which enables a 
bandwidth of up to 2.304 Mbit/s via a twisted pair, remains in wide use, though no 
longer rolled out as frequently. It is mainly used for speech and data transmission.

EFM Ethernet first mile (EFM) helps to reduce the ATM overhead and results in a 
higher net data rate. EFM allows Ethernet frames to be transmitted directly 
without being bundled in ATM cells, and is specified in IEEE 802.3ah. This 
process exploits the fact that the IP packets received from the network are simply 
passed through along the last mile and distributed to the terminal devices at the 
local loop. EFM forwards the Ethernet frames directly from DSLAM, without 
packing them in smaller ATM cells. This reduces the overhead entailed in 
additionally transmitting headers and in packing and unpacking the frames in ATM 
cells for every data exchange. As the packet-switched data portion is becoming 
ever greater and IP-based speech transmission (VoIP) has reached a high quality 
level, EFM is being increasingly expanded. The main area of application is thus in 
transmission of IP packages and therefore primarily data.
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TDM Time division multiplex (TDM) 
If only a single digital permanent circuit, such as an E1 access, must be replaced, 
TDM technology is a natural choice. This time division multiplex process enables 
the available bandwidth to be divided into 64 kbit timeslots, thus providing up to 
36 B-channels simultaneously for telephony. This results from the maximum 
bandwidth of 2.304 Mbit/s that SHDSL can provide. It thus offers four B-channels 
more than a conventional E1 access, without the need for a complete twisted pair. 
The telephony quality via the B-channels is equivalent to that of ISDN. Its main 
area of application is thus speech transmission. TDM is still widely used.

ITC Independent transmission convergence (ITC) is the name of a special ARGUS 
mode. In this mode, ARGUS attempts to establish a synchronisation – if only 
briefly – independently of the TC sublayer used (ATM, EFM or TDM) by means of 
special commands. Its main purpose is to test whether a specific access is an 
SHDSL access. This mode is not intended for permanent connections or data 
transmission.

HDLC High-level data link control (HDLC) is a unique ARGUS mode that enables 
synchronisation with remote stations (e.g. net-to-net type) of specific 
manufacturers. This mode is not intended for permanent connections or data 
transmission.

ATM/

EFM 

auto-

matic

When ATM/EFM automatic is selected, ARGUS first establishes a 2-wire 
connection and then determines the TC sublayer used with the aid of the received 
signals. Once the TC sublayer is identified, the remaining configured wire pairs 
are connected.
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Sorting the accesses in the access overview

In order to keep frequently used accesses 
readily available, ARGUS allows you to 
arrange the configured accesses in any 
order. 

Switches to softkey assignment.

<Delete>

5.2 Phys. parameters

Edits the physical parameters of the 
selected access (here VDSL, see 
page 39).

The physical parameters can also be 
opened and edited directly when the 
access wizard is finished (see page 26 
Fig. 1).

<> The selected access is 
moved down one place in 
the list.

<> The selected access is 
moved up one place in the 
list.

Deletes the highlighted 
access.
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5.3 Profile

Continued on 
next page


The preconfigured accesses can be linked 
to up to 20 profiles.
These profiles link the access settings 
with the access and test parameters. You 
can set various parameters here including 
those for service and virtual line.

Select a profile.

ARGUS enables configuration of up to 20 

profiles.

Services page 106 et seq.
Bridge/router, see page 74.
Profile name: Enter the name of the 
access, see page 25.

Select the profile you wish to edit. 
The selected profile appears in the 
display in blue. The default profile 
is indicated with a  in the display.


Select e.g. Services or Test 
parameters.
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Test parameter settings are 
described starting on page 112.
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5.4 Notices

In the preview, ARGUS shows not only the 
selected access, the xDSL mode and the 
access mode but also a freely editable 
notice (see Fig. 1 page 26).
This note can be up to 28 characters long.

In this example, the note "Using VLAN" is 

selected.

Press OK to save the entered notice.

You can subsequently edit the access 
name as described for the access 
assistant, see page 25.

<Delete> Deletes notice.


Clears mark and returns cursor 
keys to the start.


Clears mark and returns cursor 
keys to the end.

<Ab>AB> Entry begins with upper-case 
letters and continues in lower-
case.

<AB>12> Entry of upper-case letters.

<12>ab> Entry of numbers.

<ab>AB> Entry of lower-case letters.

Entry of special characters, e.g.
@, /, -, ., *, ?, %, =, &, ! etc.

Entry of special characters 
such as _, :, +, # etc.
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The saved notice is linked with the access 
and is displayed in the preview.
The preview appears approx. 2 seconds 
after the access is selected.

<Filter>

<New>

<Edit>

Selects access
Switches to ARGUS status, see page 27.

<Status>

<Menu>

<Start>

ARGUS switches to the Filter 
menu, see page 23.

Creates a new access.

Edits access.

Switches to status screen.

Switches to main menu.

Starts the VDSL connection.
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6 Physical layer

The physical layer (layer 1) is shown in the status screen (Fig. 2) with its own graphical 
element (here VDSL). The other elements in the status screen are initially only named. This 
is explained in more detail on page 84 (Virtual Lines) and page 106 (Services). The phys-
ical layers for the ADSL, SHDSL and Ethernet interfaces are presented in the same way as 
for VDSL. The selection of the VDSL access and the access mode VTU-R are directly 
adopted in the status screen. If the defaults are correct, layer 1 (synchronisation on VDSL) 
can be established directly on <Start>. The most important information such as voltage (U) 
and modem states (power down) are displayed in the layer-1 box (blue). To change the 
VDSL configuration directly, press <Edit>. To change the access type directly in the status 

screen (Fig. 2), press the softkey <Access> or the key combination  plus .



























See page 108 for tests that can be run via layer 1.

Services, 
see 
page 106

Layer 1

Router/bridge 
(only for xTU-R bridge 
and xTU-R router)

Virtual lines 
see 
page 84.

Profile name

Current 
access and 
softkey 
assignment

Press Level key or <Status>

See page 39 See page 23 See page 50

Fig. 2 (example VTU-R router):

Fig. 1

<Edit> Modify VDSL 
configuration

<Access> Access selection
<Start> Synchronise
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7 Operation on xDSL accesses

ARGUS supports the following DSL interfaces: ADSL, VDSL, SHDSL

ARGUS supports the following access modes on xDSL accesses: 

The individual DSL tests record and store data (e.g. traces of IP data). It is the 
user's responsibility to comply with the applicable legal requirements.

The line may not carry a DC voltage greater than 200 V DC and should be free of 
AC voltage components.

In principle, the operating temperature range set out in "Technical data" (see 
page 15) applies for SHDSL operation. For ambient temperatures just below 
+50 °C, extended operation in high-performance modes can trigger the 
temperature dependent ARGUS protection functions described in the safety 
information (see page 11).

xTU-R Terminal device mode (xDSL transceiver unit) see page 49.
ARGUS is connected to the xDSL access (in front of or behind the 
splitter). ARGUS replaces the modem and PC.

xTU-R bridge Bridge mode (xDSL transceiver unit bridge) see page 74.
ARGUS is connected to the xDSL access and the PC. 
ARGUS replaces the xDSL modem (for SHDSL only ATM and EFM).

xTU-R router Router mode (xDSL transceiver unit router) see page 76.
ARGUS is connected to the xDSL access and the PC.
ARGUS replaces the xDSL modem and router (for SHDSL only ATM 
and EFM).

STU-C (STU-C: SHDSL Transceiver Unit-Central Office).
ARGUS simulates the central office side (DSLAM).
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7.1 Configuring the xDSL interface

ARGUS status screen:
Layer-1 box (blue in display) selected.

<Edit> Opens settings

Status screen

Status screen:

Display (from top to bottom)

- Access mode (in this example: VTU-R)

- Previous profile (in this example: profile 1)

- Modem state (in this example: power down)

- DC voltage on the interface

VDSL test not yet started:

Meaning of LED image in display:

Red LED: No test started

Yellow LED: Test started

Green LED: Connected

<Menu> Switches to main menu, see 
menu tree

<Status> Switches to status screen

see page 50

Main menu, see menu tree

Note: accessing functions via number keys/key combinations
You can call important functions/tests directly using the keys of the ARGUS keypad. You 
can find an overview of these key combinations on page 108.
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7.2 xDSL settings
ARGUS stores all relevant settings (e.g. set and limit values) for a test with the accesses. 
Only the relevant settings are applied, depending on the test situation. You can restore the 
default settings at any time (see page 357): 

Setting Description
Phys. parameters:

ADSL:

Rated / 

treshold 

value

Setting 
Bitrate

Entry of the comparison value for the upstream and 
downstream ATM bitrate [kbit/s] using the number keys. 
ARGUS displays a large green "OK" in the ARGUS status 
screen if the current bitrate is above the set value for an 
active DSL connection and an "OK" for connection 
parameters below the target, otherwise "NOK". 
Default: d: 0 and u: 0

CRC limit 
value

Sets the max. CRC (cyclic redundancy check) value.  
ARGUS displays a large green "OK" in the ARGUS status 
screen if the current value is below the set limit value for 
an active DSL connection and an "OK" for connection 
parameters below the target, otherwise "NOK".
Range: 0 to 999,999,999
Default: far: * and near: * (*=off)

FEC limit value Determines the maximum FEC (forward error correction) 
value.  
ARGUS displays a large green "OK" in the ARGUS status 
screen if the current value is below the set limit value for 
an active DSL connection and an "OK" for connection 
parameters below the target, otherwise "NOK".
Range: 0 to 999,999,999
Default: far: * and near: * (*=off)

HEC limit value Determines the maximum HEC (header error correction) 
value. 
ARGUS displays a large green "OK" in the ARGUS status 
screen if the current value is below the set limit value for 
an active DSL connection and an "OK" for connection 
parameters below the target, otherwise "NOK".
Range: 0 to 999,999,999
Default: far: * and near: * (*=off)
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INP/SNRM Determines whether preference is to be given to INP (inpulse noise 
protection) or SNRM (signal-to-noise- ratio margin) when an ADSL 
connection is established.
Default: Favour DS SNRM

MAC address (line) 
(not available using the access wizard)

Display and selection of the line MAC addresses. 
The first two MAC addresses cannot be manually edited.

1. When the standard MAC address is selected, ARGUS uses its own 
MAC address. 

    Default: Standard MAC address
2. When you select the dynamic MAC address, a different MAC address 

is used each time the device synchronises.
3. You can enter a third MAC address: 

Mark the line and then press <Edit>. 
<Edit> Entry of new MAC address.

The address is entered in hexadecimal form using the 
number keys and key combinations: *1=A, *2=B,*3=C, 

*4=D, *5=E, *6=F and confirmed with . 

No group MAC addresses may be used.
Default: 00:00:00:00:00:00
Accepting the address.
The new address is temporarily saved, and is no longer 
available after powering down.

Press one after 
another

 and 

Display of ARGUS MAC addresses:
Line, LAN, ETH, see also page 110 and following.

VDSL:

Rated / 

treshold 

value

Setting bitrate Entry of the comparison value for the upstream and 
downstream bitrate [kbit/s] using the number keys. 
ARGUS displays a large green "OK" in the ARGUS status 
screen if the current bitrate is above the set value for an 
active DSL connection and an "OK" for connection 
parameters below the target, otherwise "NOK".
Default: d: 0 and u: 0
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CRC limit 
value

Sets the max. CRC (cyclic redundancy check) value.  
ARGUS displays a large green "OK" in the ARGUS status 
screen if the current value is below the set limit value for 
an active DSL connection and an "OK" for connection 
parameters below the target, otherwise "NOK".
Range: 0 to 999,999,999
Default: far: * and near: * (*=off)

FEC limit value Determines the maximum FEC (forward error correction) 
value.  
ARGUS displays a large green "OK" in the ARGUS status 
screen if the current value is below the set limit value for 
an active DSL connection and an "OK" for connection 
parameters below the target, otherwise "NOK".
Range: 0 to 999,999,999
Default: far: * and near: * (*=off)

Firmware Selects the firmware (FW) in the VDSL chipset.
You can choose between version A and version B.
Further information is available on request.
Default: A

Carrier set The carrier set determines the carrier frequencies that ARGUS uses to 
signal to DSLAM that it is ready to synchronise (ITU G.997.1). 
The carrier generally specifies which sets are to be used. 
You can select the following sets with corresponding upstream tones (inter-
val between tones 4.3125 kHz) in ARGUS: 

- A43, tones: 9, 17, 25 
- B43, tones: 37, 45, 53 
- V43, tones: 944, 972, 999 
Default: A43, B43, V43

When multiple sets are selected, ARGUS cyclically transmits the tones of 
the selected sets in parallel.
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Vectoring 

mode

Vectoring mode defines how ARGUS behaves when synchronising with 
DSLAM: 
- Non-vectoring (off) 
This is standard VDSL2 with non-vectoring-capable DSL access 
multiplexers (DSLAMs) and modems. However, it can also be used for 
mixed operation with non-vectoring-capable modems on vectoring-capable 
DSLAMs. In such a case, the simulated modem is throttled to the ADSL2+ 
bandwidth (max. 16 Mbit/s).
- Full vectoring
Full vectoring operation requires vectoring-capable DSLAMs and modems. 
VDSL2 vectoring is supported when this technology is present at both ends 
of the bundle.
Default: Full vectoring

Retrans-

mission 

(G.INP)

When retransmission (G.INP, G.998.4) is used, the downstream of VDSL2 
links is protected against pulse noise on layer 1. Delays and packet losses 
are minimised; however, this increases the interleave delay for 
downstream.
Default: Down- & Upstream




When VDSL Vectoring or Retransmission (G.INP) are active, ARGUS 
shows in the status line a blue highlighted „V“ for Vectoring or „R“ for 
Retransmission.




When VDSL Vectoring or Retransmission (G.INP=) are unlocked but not 
active, ARGUS shows in the status line a grey highlighted „V“ for Vectoring 
and „R“ for Retransmission.

MAC address, see page 40.

SHDSL:

Spectrum For region 1 (e.g. North America):
Annex A/F Auto, Annex A SHDSL, Annex F SHDSL.bis (5.7 Mbit/s)
For region 2 (e.g. Europe):
Annex B/G Auto, Annex B SHDSL, Annex G SHDSL.bis (5.7 Mbit/s) 
Automatic selection of modulation modes: 
- TC-PAM 16 (SHDSL) 
- TC-PAM 32 (SHDSL.bis)
Default: Annex B/G auto
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Clock/ 

framing 

(not for 

ATM + EFM)

The timing relates to the receiving and transmitting directions of a 
connection. The reception and transmission timing are identical for 
synchronous timing and different for plesiochronous timing. Timing 
differences are compensated by means of bit stuffing. 
 - Synchronous 
 - Plesiochronous (for TDM only)
 - Plesiochronous (NTR) (for TDM only)
   (the SHDSL timing is derived from the network timing reference)
Default: synchronous

Channel
selection 

(not for 

ATM + EFM)

Selection of the B and Z channels via the number keys. You can select up 
to 36 B channels and up to 7 Z channels. When you enter * (for the B and Z 
channels), ARGUS automatically detects the channel allocation.
Maximum selection:
36 B channels and 1 Z channel
35 B channels and 7 Z channels
Minimum selection:
- 3 B channels
- 0 Z channels
Default: * (automatic)
If an auto mode is selected under Spectrum (see page 42), channel 
selection is also automatic regardless of the settings made here.

Data rate 

(only for 

ATM + EFM)

Sets the data rate in kbit/s
For SHDSL
- Range: 192 kbit/s to 2.3 Mbit/s
- Default: * (automatic)
For SHDSL.bis (ESHDSL):
- Range: 768 kbit/s to 5.7 Mbit/s
- Default: * (automatic)
If an auto mode is selected under Spectrum (see page 42), data rate 
selection is also automatic regardless of the settings made here.

Power 
back off

Reduces the transmitting power of the remote station. The set value 
corresponds to the maximum transmitting power.
Range: 0 dB to 30 dB
Default: 0 dB
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EOC usage The embedded operations channel (EOC) is used to exchange connection-
related and other information.
off: No queries or responses are sent to the remote station.
on (passive): No parameters are displayed at the remote station, as 

only queries are responded to.
on (active): The own performance parameters and those of the 

remote station are displayed, provided that the remote 
station also supports own queries.

Default: on (passive) 
Sync word The sync word identifies the SHDSL frame. 

(cf. ITU-T G.991.2 Chapter: PMS-TC layer functional characteristics).
To enter the sync word, use the number keys and key combinations *1=A, 

*2=B,*3=C, *4=D, *5=E, *6=F and then confirm with .

Default: 3F 16 1F 03 3C 0C
Message 

mode

Selects the message mode. The message mode determines initiation of 
the handshake on the STU-R side resp. the response on the part of the 
STU-C (cf. ITU-T G.994.1 Chapter: Transactions, entry in the capability 
list).
Range: GHS Mode A to GHS Mode D
Default: GHS mode C

Vendor info 

field

Entry of vendor information in the corresponding transmission field. This 
information is entered in hexadecimal form, see "Sync word".
Default: 15 35

Wire pairs


For 2-wire SHDSL, ARGUS always uses the wire pair 4/5 (line 1); for 
SHDSL n-wire, ARGUS always uses the wire pair 4/5 (line 1) plus a further 
wire pair (line) from the list. 
You can change the order of the wire pairs.
- 2nd wire pair (line 2) for 4-wire 
- 3rd wire pair (line 3) for 6-wire
- 4th wire pair (line 4) for 8-wire 
Wire pair 4/5 (line 1) is always reserved as the master.


You can mark the 2nd, 3rd and 4th wire pairs (lines 2-4) and move them 
down one slot the list using the left softkey <> or up one slot in the list 

using the right softkey <>. Confirm your entry with . 

The following default is common: 
Line 1: wire pair 4-5 (fixed)
Line 2: wire pair 3-6
Line 3: wire pair 1-2
Line 4: wire pair 7-8
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Line 
probing 

(PMMS)

When a connection is being established, line probing (power measurement 
modulation session) can occur; this is standardised according to ITU-T 
G.991.2. This function enables determination of a variety of line parameters 
to identify the possible data rate before the actual synchronisation process 
with the remote station.
Rate-adaptive
mode

This determines what interference is taken into account in 
the PMM session. 
 - Current SNR DS: current line interference in down
   stream is taken into account. 
 - Worst case G.991.2 SNR DS: reference line interfer-
   ence from G.991.2 in downstream is taken into account. 
 - Current SNR US: current line interference in upstream 
   is taken into account. 
 - Worst case G.991.2 SNR US: reference line inter-
   ference from G.991.2in upstream is taken into account. 
Default: none

<Add> A display with the available modes opens. Any mode 

marked with  in this window is inserted in the list 
(above the mode marked in the list).

<Delete> Deletes the marked mode from the list

Adopts the mode priorities.

Targets SNRm 
in dB 

Destination SNR margins can be set for the above line 
interference.
 - Current up: 0 
 - Current down: 0 
 - Worst-case up: 0 
 - Worst-case down: 0 
Range: -10 dB to 21 dB
Default: zero for all

Interop 

bits

Line probing The PMM session supports the following remote stations:
- G.991.2
- Globespan
Default: G.991.2

Multiwire 
(only for ATM + 
TDM)

The synchronisation behaviour is matched to the following 
remote stations:
 - Auto (automatic)
 - Globespan 
 - G.991.2
Default: auto
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EFM Aggre-
gation

Select this setting when ARGUS in 
STU-C mode and the modem in STU-R 
mode do not support the discovery 
operation of the expanded G.hs 
according to IEEE 802.3ah section 4.

Discovery and 
agg.

Select this setting when the discovery 
operation of the expanded G.hs 
according to IEEE 802.3ah section 4 is 
supported.

Default: Discovery and agg.
SRU
(EFM and 
Independent  
ITC only)

Supports the regeneration unit (SRU) functions of the 
following remote stations:
 - Off
 - Elcon Coco10M (only EFM)
 - Elcon International (only EFM)
 - Albis BSRU (only for 4-wire Independent TC)
Default: Off

EOC
error counter

Depending on the setting here, errors are transmitted 
using the EOC, summed by ARGUS ("absolute") and 
displayed or determined over the corresponding request 
interval ("delta") and displayed.
Default: Delta

QD2Lite Determines wheter the protocol uses QD2Lite in EO 
channel or not.
Default: off

MAC address, see page 40.

Profiles (<Edit> edit profiles)

Router

IP version Determines which IP version is to be used.
IPv4:
IPv6:
Dual Stack 
IPv4/IPv6: 

Internet Protocol version 4 acc. to RFC 791 
Internet Protocol version 6 acc. to RFC 2460
If IPv6 is available, this protocol is preferred; if not, 
ARGUS switches to IPv4.
Default: IPv4
46 ARGUS 155



7 Operation on xDSL accesses
IPv4 Definition of IP address assignment 
 IP mode: Static IP: 

DHCP server:
Fixed IP address
Assignment of IP address by ARGUS
Default: DHCP server 

Own IP 
Address:

Range: Range 0.0.0.0. to 255.255.255.255
Default: 192.168.10.1 (assignment see RFC 3330)

IP netmask: Range: Range 0.0.0.0. to 255.255.255.255
Default: 255.255.255.0 (assignment see RFC 3330)  

DHCP server: Settings for the DHCP server:
- Starting and ending IP address
  Range: Range 0.0.0.0. to 255.255.255.255
  Default: (assignment see RFC 3330)
  Start: 192.168.10.30
  End: 192.168.10.40
Domain name
- Duration of reservation for IP addresses
  Range: 1 - 99999 seconds
  Default: 240

NAT NAT (network address translation) on or off.
The NAT service automatically and transparently replaces 
address information (e.g. IP addresses of the LAN) with 
other address information (e.g. IP addresses of the WAN).
Default: NAT on

SIP port Port used for incoming SIP signalling. 
Range: 0 to 65535 
Default: 5060

IPv6 Firewall Determines whether ARGUS uses a firewall in router 
mode.
Default: on

Discard prefix Determines whether ARGUS rejects or uses the prefix.
Default: on

Data log See page 48.
Bridge:

IP version Determines which IP version is to be used.
IPv4:
IPv6:
Dual Stack 
IPv4/IPv6: 

Internet Protocol version 4 acc. to RFC 791 
Internet Protocol version 6 acc. to RFC 2460
If IPv6 is available, this protocol is preferred; if not, 
ARGUS switches to IPv4.
Default: IPv4
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See chapter „9.4 Virtual line settings“ (see page 94) for further configurations.

IPv4 Definition of IP address assignment 
 IP mode: Static IP: 

DHCP server:
Fixed IP address
Assignment of IP address by ARGUS
Default: DHCP server 

Own IP 
Address:

Range: Range 0.0.0.0. to 255.255.255.255
Default: 192.168.10.1 (assignment see RFC 3330)

IP netmask: Range: Range 0.0.0.0. to 255.255.255.255
Default: 255.255.255.0 (assignment see RFC 3330)  

DHCP server: Settings for the DHCP server:
- Starting and ending IP address
  Range: Range 0.0.0.0. to 255.255.255.255
  Default: (assignment see RFC 3330)
  Start: 192.168.10.30
  End: 192.168.10.40
Domain name
- Duration of reservation for IP addresses
  Range: 1 - 99999 seconds
  Default: 240

VLAN 
handling

When VLAN tagging is used, a VLAN tag is attached to every outgoing 
Ethernet frame (from the WAN). The tag is removed from every incoming 
Ethernet frame. In transparent VLAN, the Ethernet frames are passed on 
unchanged. 
Default: Transparent

VLAN ID Identifier for the VLAN to which the frame belongs. Every VLAN is 
assigned a unique number, the VLAN ID. A device that belongs to the 
VLAN with ID = 2 can communicate with every other device in the same 
VLAN but not with devices in other VLANs.
Range: from 0 to 4095
Default: 2

Data log Data log on or off 
This function must be set to "on" so that a trace file can be sent to the PC; 
see page 71. After terminating a virtual line (VL) via the corresponding 
service or the physical layer, ARGUS queries whether the trace file should 
be sent to the PC. The mini-USB port must also be connected to the PC. 
For example, when the data log is activated for VL 1, only VL 1 is recorded. 
When one VL is configured for multiple services and the data log is active, 
all data of this VL are recorded.
Default: off
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7.3 ARGUS in access mode xTU-R

Determining the xDSL connection parameters using VDSL as an example
(procedures also apply for ADSL and SHDSL connections)
ARGUS is connected directly to the VDSL access via the supplied xDSL lead and the 
ARGUS socket line (either in front of or behind the splitter). In this case, ARGUS replaces 
the modem and PC. ARGUS establishes a VDSL connection and determines all relevant 
VDSL connection parameters. ARGUS displays the VDSL connection parameters and, if 
desired, saves them when the link is disconnected.

Use only the patch cable supplied with the device.

In this example, VDSL VTU-R mode is configured and selected as described in chapter „5 
Configuring accesses“ (see page 23).



socket
Line

VDSL access
VTU-C (DSLAM)

xDSL cable or patch cable 

The VDSL test has not yet been 
started: red LED in the display!

Meaning of LED image in display:
Red LED: no test started

Yellow LED: test started

Green LED: connected

All further functions and 
procedures are explained using 
this status screen.
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Establishing the xDSL connection using VDSL as an example
Profile configuration:
ARGUS uses the settings (see page 28) and limit values (see page 39) stored in the 
respective profile for establishing a VDSL connection.

ARGUS in status screen.



ARGUS uses the default profile (profile 1 
in the example) to establish the VDSL 
connection.

Establishing a VDSL connection

ARGUS synchronises with DSLAM (LED 
"Sync/L1" flashes, display shows element 
on yellow background).
ARGUS displays the current connection 
status (in this example "Initialize") in the 
layer-1 box (blue).


While connecting:
Display:

<Edit> Edits the VDSL settings and 
MAC address.

<Access> Selects a new access.

- Current connection status

- Time elapsed since start of 
synchronisation in h:min:s.

Continued on next 
page

or
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R

y)

R)

y)

Display of commands






Display timestamp




ARGUS shows the time (internal clock, 
see page 350) at which the commands 
are received.




Display the graphical xDSL trace.

Display:

See page 52 for an explanation of the 
colour code.

< = Command sent by ARGUS

> = Command sent by DSLAM

- = Connection status

Switches to the previous 
display and the status screen.

- Synchronising 

- CRC error in downstream (SHDSL STU-

- CRC error in upstream (ADSL/VDSL onl

- SNR error in downstream (SHDSL STU-

- SNR error in upstream (ADSL/VDSL onl

- Bitswap events (ADSL/VDSL only)
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The colour code in the xDSL trace can be 
interpreted as follows (see SHDSL, 
page 70).

Meaning of the modem states:

See page 70 for an explanation of SHDSL.

You can show and hide the label for 
the xDSL trace using the number 
key. 

The function of the cursor is 
described on page 56.

Colour Short form Explanation

red No-load

light 

blue

ARGUS transmits handshake tones (silence 
on the DSLAM side).

yellow A handshake (G.hs) signal from the remote 
station was detected.

orange Start of the training phase following 
successful handshake.

green Showtime achieved. The TC sublayer is estab-
lished. ARGUS is ready for 
operation.
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)

.

. 
Connected

As soon as the connection is established, (LED "Sync/L1" continuously illuminated and 
green tick mark in layer 1 box), ARGUS determines the VDSL connection parameters. After 
synchronising, ARGUS must remain connected to the VDSL access for at least 20 
seconds. Only then can ARGUS save all VDSL connection parameters.

ARGUS in status screen.
Display (layer-1 box)

Display of VDSL connection parameters in  
overview: 
- d/n: downstream/near
- u/f: upstream/far

- Access and access mode
- VDSL profile (ITU profiles: 8,12,17 or 30
- d: Downstreamdata rate

u: Upstream data rate
- Number of CRC errors in 

downstream/upstream
- DC voltage at interface

<Info> Displays the VDSL connection 
parameters.

<Stop> Disconnects the VDSL connection

CRC:


FEC:

No CRC errors occurred in the 
final second.
In the final second, FEC errors 
occurred in both upstream and 
downstream. See page 53 for 
more information.

CRC:




FEC:

No upstream CRC errors 
occurred in the final second.
In the final second, FEC errors 
occurred in in downstream only
See page 53 for more 
information.


Browse connection 
parameters

<Trace> Displays trace data, see 
page 51.

<Graph> Displays the graph, see 
page 55.

Continued on next page

or
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Displays the connection parameters in 
long form for downstream (d) and
upstream (u), see table page 62.



Display of xDSL parameters as QR code.


Display Ethernet statistics (VDSL):
ARGUS displays the received (Rx) and 
transmitted (Tx) Ethernet frames and 
bytes.

For ADSL, the following ATM statistics are 
displayed:
- Number of OAM cells
- Number of user-side VCCs
- Number of AAL5 PDUs
- Unmapped cells received (Rx)
- Unmapped VPI received (Rx)
- Unmapped VCI received (Rx)

n/a not available 

n/u not used 

n/r not received 

Browse parameter display

<Reset> Resets the error counters: 
FEC, CRC.

Continued on 
next page
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Displays the bit distribution 
i.e. transported bits per tone (channel)
Y-axis: bits
X-axis: tones (channels)
Line interference sources can be identified 
on the basis of the bit distribution 
(e.g. due to HDSL, RF, DPBO etc.). 

Graph functions:
The graph functions such as zoom, cursor 
and setting of the x-axis enable detailed 
analysis of the graphs:

The following graphs and graph 
functions are only available for 
ADSL and VDSL.

ARGUS switches to the 
previous display.

<Continue> Switches to next graph.

Exits the menu without changing.

You can also use this number key to
toggle the zoom function within a gr
The function of the cursor is describ
on page 57.
Toggles the x-axis from tone to 
frequency is described on page 58.
Toggles the min/max is described on
page 58.
Switches automatically to the next g
with the view and adopts all settings
this graph. 

 
and 

 


Saves the result without disconnect
the connection.

Continued on 
next page

See page 60
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The magnifying glass shown in the display 
rests on a white background. 
It has not yet been zoomed.

The magnifying glass shown in the display 
rests on a dark background, indicating that 
it has been zoomed.



 toggles the softkey assignment. 
ARGUS switches from x-axis zoom to 
y-axis zoom

<Zoom(x)++> Magnifies the middle section of 
the graph (100%).

<Zoom(x)--> Reverses <Zoom(x)++> and 
resets magnification.

Use the cursor keys to 
horizontally scroll through 
the zoomed range.

<Zoom(x)++> Magnifies the middle section of
the graph (100%).

<Zoom(y)--> Reverses <Zoom(y)++> and 
resets magnification.

Continued on 
next page
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The magnifying glass shown in the display 
rests on a dark background, indicating that 
it has been zoomed.



The cursor functions enables precise 
determinations on the graphs.

When the Cursor function is started, a 
green cursor line appears in the middle of 
the graph.

The values of the graph for the position 
under the cursor are displayed in the graph 
as follows:


You can use the cursor keys to 
scroll vertically through the 
zoomed range.

<Cursor> You can toggle the cursor on and 
off as needed using the Cursor 
softkey after activating it in the 
menu.

x:  2168. Tone

y:  7 bits

Use the left and right cursor keys
move the cursor to any point on t
graph to measure it. Briefly press
a cursor key causes the cursor to
jump to by one position in the gra
When the cursor key is held dow
the steps the cursor covers in the
graph become progressively larg

Continued on next 
page
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By toggling the x-axis you can change its 
labelling from tone to frequency.

Available options:











The zoom function and the cursor function 
can also be combined. 
However, the starting position of the cursor 
can vary. The graph functions can be used 
for all graphs.

Tone: Displays the values of the
x-axis as tones.

Frequency: Displays the values of the 
x-axis as frequencies.

Direct setting of x-axis.

You can use the left and right 
cursor to scroll through the 
range (in this example 
frequency).

Continued on 
next page

Graphic functions
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.

With the Min/Max setting, the bits/tone 
and SNR/tone graphs display the 
minimum and maximum values. 



Displays the maximum value (pink)


Displays the minimum value (blue).

<Min/Max aus> Hide min/max values.
<Min/Max Rst.> Reset min/max values.

Continued on next page
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Display of signal-to-noise ratio (SNR) for 
each tone
y-axis: SNR in dB
x-axis: tones (channels)

This enables interference sources for 
individual tones (channels) to be detected, 
in this example downstream power backoff 
(DPBO).



Display of quiet line noise (QLN) for each 
tone. The QLN represents the quiet line 
noise of the twisted pair as a function of 
the frequency.
y-axis: QLN in dBm/Hz
x-axis: tones (channels)

The QLN enables detection of narrow-
band interference sources due to e.g. 
coupling of medium-wave emission 
sources or defective switching 
components. These interference sources 
are represented as narrow peaks. This 
example shows a line with interference 
from a power supply.

<Menu> Opens the graph functions (see 
page 56).

<Menu> Opens the graph functions (see 
page 56).

Continued on next 
page

Additional result graphs
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Displays the amplitude component of the 
transmission function (HLOG) for each 
tone. HLOG shows the attenuation of a 
connection as a function of the frequency.
Y-axis: Hlog in dB
X-axis: tones (channels)

On a nominally functioning line, the values 
drop off as the frequency increases; this 
function is virtually horizontal on short 
lines. This example shows a short line. 

In the HLOG graphs, a shift can occur in 
calculating the upstream and downstream 
values from DSLAM compared to the 
downstream values from ARGUS. It can 
also happen that DSLAMs do not transmit 
the HLOG upstream values or send 
falsified values.

DSL connections are often possible even 
though one of the two cores is high-ohm 
or even interrupted (only capacitive 
coupling). This results in dropped 
connections and data losses. Such 
problems can be due to oxidized lines, 
poor contacts in the telephone sockets, 
loose terminals or improperly insulated 
lines. In connections like this, lower 
frequencies are attenuated much more 
than higher frequencies. This is 
recognisable as an atypical relationship 
between upstream and downstream 
attenuation, as well as in the HLOG curve. 
In the event of a problem on one of the 
wires, the values for the low frequencies 
are often less than for the higher 
frequencies.

<Menu> Opens the graph functions, see
page 56. 

<Continue> ARGUS returns to the bits/tone
graph.

Example: Mismatch + poor contact 
on ADSL
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The example at left shows a sink. It can 
indicate a stub line (bridge tap).
With the rule of thumb:
L[m] = 50 / f [MHz], 
you can estimate the length of a stub line 
if you know the frequency in MHz (in this 
example 0.535 MHz):

L [m] = 50 / 0,535 MHz = 93 m 

There is a stub line approx. 93 m long.

In this example, given a frequency of 
approx. 3.85 MHz, the stub line is approx. 
13 m long.  

ARGUS determines the following ADSL connection parameters:

ADSL connection parameters:
Net data rate Actually usable ATM bitrate in kbit/s.
Attainable data rate Theoretically attainable ATM bitrate in kbit/s.
Relative capacity Line capacity utilisation in percent.
Latency mode ARGUS shows "interleaved" or "fast", depending on the 

DSLAM configuration.
Attenuation Attenuation on a line over the entire length and bandwidth in 

dB. From a specific attenuation on, certain access types are no 
longer recommended. However, it is better to compare 
individually calculated attenuation values that are 
recommended for specific access types with the dB value in the 
HLOG graph, at 300 kHz (cursor).

Output power Output power in dBm with reference to 1 mW.

Example: Bridge tap on ADSL

Example: Bridge tap on VDSL
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SNR margin Signal-to-noise ratio margin in dB. The SNR margin is a 
measure of how much additional noise the transmission can 

stand and still maintain a bit error rate (BER) of 10-7. This value 
is considered a reserve against interference signals. 
Rule of thumb: The SNR margin in downstream should - 
doubled - be at least equal to or greater than the SNR margin in 
upstream.

Inpulse noise prot. INP describes the quality of the protection against pulse 
interference. The number of consecutive DMT symbols that can 
be completely distorted without causing errors in higher layers.

Interleave delay The delay (in ms) due to interleaving of data blocks.
FEC Forward error correction

Number of transmission errors corrected using the checkbytes 
of a codeword.
f (far): Errors that the DSLAM detects and passes to 

ARGUS.
n (near): Errors that ARGUS detects in the transmitted 

blocks. 
CRC Cyclic redundancy check

The checksum of the superframes transmitted by the remote 
station does not agree with the locally calculated figure. 
Possible cause: line interference.
f (far): Errors that the DSLAM detects and passes to 

ARGUS.
n (near): Errors that ARGUS detects in the transmitted 

blocks.
HEC Header error checksum

Number of ATM cells with incorrect header checksums.
f (far): Errors that DSLAM detects and passes to ARGUS.
n (near): Errors that ARGUS detects in the transmitted 

blocks.
ES Errored seconds

Number of seconds containing one or more erroneous sync 
words and/or one or more CRC anomalies.

SES Severely errored seconds
Number of seconds containing one or more erroneous sync 
words or at least 50 CRC anomalies. 

LOSS Loss of signal seconds
Shows the number of LOS errors in one second. 
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ARGUS determines the following VDSL connection parameters

UAS Unavailable seconds
Number of seconds in which the ADSL link was unavailable. 
The connection is considered unavailable at 10 consecutive 
SESs at the latest. The 10 SESs are added to the time that the 
connection is unavailable. Once the connection is unavailable, 
it only becomes available when no SESs occur in 10 
consecutive seconds. The 10 SES-free seconds are added to 
the time that the connection is unavailable.

Reset Indicates how often the user resets the error counters using the 
<Reset> softkey.

Resync Number of resyncs by ARGUS.
Bitswap events Shows how much data is diverted from a faulty transmission 

channel (up- and downstream) to other channels.
Retranmission 
(G.INP)

This parameter shows whether retransmission is activated for 
down- and/or upstream in DSLAM. When retransmission is 
activated, faulty data transmission units (DTUs) caused by 
transmission problems are requested and transmitted again. 
The following additional parameters are shown when 
retransmission is activated:

The blue  in the ARGUS status line signals that 

retransmission is activated in DSLAM.

 = Retransmission configured or not active

 = Retransmission active

 = Retransmission working

Vendor far ATU-C vendor.
Version Vendor-specific information, contains the software version of 

the ATU-C side (DSLAM).
Vendor near Manufacturer of the ARGUS chipset (ATU-R).
Version Vendor-specific information, contains the software version of 

ARGUS.

VDSL connection parameters:
Net data rate Actually usable ATM bitrate in kbit/s.
Attainable data 
rate

Theoretically attainable ATM bitrate in kbit/s.

Relative capacity Line capacity utilisation in percent.
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SNR margin Signal-to-noise ratio in the bands used in dB.
The SNR margin is a measure of how much additional noise the 
transmission can stand and still maintain a bit error rate (BER) 
of 10-7. The value is considered a reserve against interference 
signals.
Bands not used are indicated with n/u.

Loop attenuation Attenuation on a line over the entire length and bandwidth in 
dB. From a specific attenuation on, certain access types are no 
longer recommended. However, it is better to compare 
individually calculated attenuation values that are 
recommended for specific access types with the dB value in the 
HLOG graph, at 1 MHz (cursor).
Bands not used are indicated with n/u.

Signal attenuation Attenuation of the signal in dB in the corresponding bands.
Bands not used are indicated with n/u.

Output power Output power in dBm with reference to 1 mW.
Interleave delay The delay (in ms) due to interleaving of data blocks.
Inpulse noise prot. INP describes the quality of the protection against pulse 

interference. The number of consecutive DMT symbols that can 
be completely distorted without causing errors in higher layers.

FEC Forward error correction
Number of transmission errors corrected using the checkbytes 
of a codeword.
f (far): Errors that the DSLAM detects and passes to 

ARGUS.
n (near): Errors that ARGUS detects in the transmitted 

blocks. 
CRC Cyclic Redundancy Check

The checksum of the superframes transmitted by the remote 
station does not agree with the locally calculated figure. 
Possible causes: line interference.
f (far): Errors that DSLAM detects and passes to ARGUS.
n (near): Errors that ARGUS detects in the transmitted 

blocks. 
ES Errored seconds

Number of seconds containing one or more erroneous sync 
words and/or one or more CRC anomalies.

SES Severely errored seconds
Number of seconds containing one or more erroneous sync 
words or at least 50 CRC anomalies. 

LOSS Loss of signal seconds
Shows the number of LOS errors in one second. 
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UAS Unavailable seconds
Number of seconds in which the VDSL link was unavailable. 
The connection is considered unavailable at 10 consecutive 
SESs at the latest. The 10 SESs are added to the time that the 
connection is unavailable. Once the connection is unavailable, 
it only becomes available when no SESs occur in 10 
consecutive seconds. The 10 SES-free seconds are added to 
the time that the connection is unavailable.

Reset Indicates how often the user resets the error counters using the 
<Reset> softkey.

Resync Number of resyncs by ARGUS.
Showtime no sync Shows how often the connection status "showtime" was 

achieved without a long-term stable connection.
Bitswap events Shows how much data is diverted from a faulty transmission 

channel (up- and downstream) to other channels.
Vectoring The vectoring mode shows whether this remote station 

supports VDSL2 vectoring (ITU-T G.993.5).
- Display shows "off" for non-vectoring.
- ARGUS displays "Vectoring friendly" or "Full Vectoring" when 
vectoring is supported. 
See page 42 for more information.

SRA (Seamless 
rate adaption)

This parameter shows whether SRA is activated for down- and/
or upstream in DSLAM. Seamless rate adaption (SRA) is a 
seamless adaption of the data rate during a DSL connection. In 
SRA, the data rate is adapted depending on the SNR margin 
during a connection.

Retranmission 
(G.INP)

This parameter shows whether retransmission is activated for 
down- and/or upstream in DSLAM. When retransmission is 
activated, faulty data transmission units (DTUs) caused by 
transmission problems are requested and transmitted again. 
The following additional parameters are shown when 
retransmission is activated:

The blue  in the ARGUS status line signals that 
retransmission is activated in DSLAM.

 = Retransmission configured or not active

 = Retransmission active

 = Retransmission working
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Data transmission 
units (DTU) 

Retransmission is performed before the CRC mechanism. As 
long as the retransmission mechanism requests and and 
transmits the erroneous DTUs in corrected form, no CRC errors 
(data losses) occur.If the retransmission mechanism cannot 
correct faulty transmissions, e.g. due to sustained interference, 
CRC errors (data losses) occur. 
- Retransmi. Multiple retransmitted DTUs due to a transmission
  problem. Is also displayed in the overview page 53 as
  "Retransmi".
- Corrected Successful retransmission of a DTU
- Uncorret. Unsuccessful retransmission of a DTU 

INP REIN In ARGUS, interference immunity (DSLAM setting) is displayed 
with respect to REIN INP. This describes the quality of the 
protection against pulse interference. REIN (Repetitive 
electrical impulse noise) describes periodic interference pulses, 
usually caused by 230 V AC voltage from the supply mains. The 
value indicates the number of consecutive DMT symbols that 
can be completely distorted without causing errors in higher 
layers (1 DMT symbol = ~250 µs). 

INP SHINE In ARGUS, interference immunity (DSLAM setting) is displayed 
with respect to SHINE INP. This describes the quality of the 
protection against pulse interference.SHINE (single high 
impulse noise event) describes random, unpredictable, 
non-periodic interference pulses. The value indicates the 
number of consecutive DMT symbols that can be completely 
distorted without causing errors in higher layers (1 DMT symbol 
= ~250 µs)). 

ETR The expected throughput rate (ETR) in kBit/s is the minimum 
data rate that can be provided through complete error 
correction through retransmission.

Elec.length@1MHz Indication of the electrical length for a frequency of 1 MHz in dB.
R: VTU-R side
C: VTU-C side

Vendor far VTU-C vendor.
Version Vendor-specific information, contains the software version of 

the VTU-C side (DSLAM).
Vendor near Manufacturer of the ARGUS chipset (VTU-R).
Version Vendor-specific information, contains the software version of 

ARGUS.
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System information for transmission to the ADSL/VDSL remote station
When a modem is synchronised with a DSLAM, the vendor and device type of the 
modem is generally displayed in the control system of the DSLAM. For ADSL and 
VDSL, this occurs according to ITU-T G.997.1. When an ARGUS device 
synchronises with a DSLAM, the latter reports to the control system the following 
information, depending on the DSLAM.

ARGUS determines the following SHDSL connection parameters:

Information Display in DSLAM Meaning
System vendor ID 0x04, 0x00 (hex) Country code: Germany

INGE or
0x49, 0x4E, 0x47, 0x45 (hex)

Provider code:
intec Germany

0x20, 2x20 (hex) System FW version: 2.20.0
Version number R2.20.00 U_ Device FW version: 2.20.0
Serial number ARGUS155-9999-R2.20.0U_ Device type:

ARGUS 155 / device serial 
number 9999

SHDSL connection parameters:

SNR margin Signal-to-noise ratio margin in dB. The SNR margin is a measure of 
how much additional noise the transmission can stand and still 

maintain a bit error rate (BER) of 10-7. This value is considered a 
reserve against interference signals.

SNR Signal-to-noise ratio in dB.

Attenuation (dB) Attenuation on a line over the entire length in dB.

Output Power Output power in dBm with reference to 1 mW.

CRC Cyclic Redundancy Check
Number of CRC anomalies (CRC6 checksum errors), also known as 
code violations (CV). The sums of the one-second periods are 
totalled by ARGUS.

LOSWS Loss of sync word seconds
Number of seconds containing one or more erroneous sync words.

ES Errored seconds
Number of seconds containing one or more erroneous sync words 
and/or one or more CRC anomalies.

SES Severely errored seconds
Number of seconds containing one or more erroneous sync words 
or at least 50 CRC anomalies.
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US Unavailable seconds
Number of seconds in which the SHDSL link was unavailable. The 
connection is considered unavailable at 10 consecutive SESs at the 
latest. The 10 SESs are added to the time that the connection is 
unavailable. If the connection is unavailable, it only becomes 
available when no SESs occur in 10 consecutive seconds. The 10 
SES-free seconds are added to the time that the connection is 
unavailable.
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System information for transmission to the SHDSL remote station 
When a modem synchronises with DSLAM, the vendor and device type of this 
modem are generally displayed in the DSLAM's control system. In SHDSL, this is 
carried out according to “ITU-T G.991.2 table 9-10". When an ARGUS device 
synchronises with a DSLAM, the latter reports to the control system the following:

Info: Entry: Example ARGUS:

Vendor ID intec-Name "intec"

Version model Device type "Argus155"

Vendor serial Serial number "9999"

Other vendor information Device SW "R2.20.00 U_"

Meaning of the running EFM states (from the STU-R perspective)

Power down STU-R / STU-C in idle state.

Initialization red Initialisation - "power on".

GHS startup light 
blue

Handshake according to ITU-T 
G.994.1, G.hs is started.

GHS transfer yellow Replacement of the capability list 
completed.

Discovery Start of the discovery phase.

Discovery 
accepted

Discovery probe accepted.

Discovery 
finished

Discovery phase finished.

Aggregation 
accepted

Aggregation probe accepted.

Aggregation 
finished

Aggregation phase finished.

GHS finished orange Handshake (G.hs) successfully 
completed.

Data green Data mode achieved, showtime.

Data Error An error, e.g. loss of sync. has 
occurred.
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Disconnecting the xDSL connection and saving the results 


ARGUS in status screen.









Disconnecting the VDSL connection.













ARGUS saves the VDSL connection 
parameters together with the trace data 
in the first free slot. You can enter a user-
definable name when saving (see 
page 342).
Default: New result.

If all slots are occupied, you need to 
manually select a slot to overwrite.

<No> Results are rejected.
<Back> Results are not saved. ARGUS 

returns to the status display.
<Yes> Saving the result.

Continued on 
next page

Saving the 
result
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After saving, ARGUS returns to the status 
display or ARGUS status.
You can initialise a new sync attempt 
directly using <Start>.

Saving the results without disconnecting the xDSL connection

ARGUS in status screen.

ARGUS automatically suggests a save 
name.

 and  Saves the result without 
disconnecting the 
connections.

<Last name> The last name used is 
suggested.

<Delete> Deletes the suggestion.
<Ab>AB> Entry of upper- and lower-

case letters and @, /, -, .
Results accepted with 
the storage name shown.
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Displaying stored test results

ARGUS in Main Menu

In ARGUS status, press <Menu>.

When ARGUS is in the selection list for 
preconfigured accesses, you can switch to 

the abbreviated main menu with .



Marked the stored test result.











Displays the test results:
ARGUS shows whether the downstream 
and upstream values are within the limits. 





Browse VDSL connection 
parameters.

<Continue> Displays the signal-to-noise 
ratio per tone (SNR/tone), 
QLN/tone, HLOG/tone and 
the trace data. 

Exits results.

View

Test results
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7.4 ARGUS in access mode xTU-R bridge

Connect ARGUS to the PC using the patch cable and to the VDSL access using the xDSL 
cable. In bridge mode, ARGUS acts as a VDSL modem, i.e. ARGUS passively hands on all 
packets from the Ethernet to VDSL (and vice versa). In this case, the PC is responsible for 
establishing the connection.

Patch cablexDSL cable

Socket LANSocket Line

Ethernet VDSL 

VDSL
access

PCProtocol, e.g. PPP



ARGUS in access mode xTU-R bridge
In this example, VDSL VTU-R bridge mode is configured and selected as described in 
chapter „5 Configuring accesses“ (see page 23).


Test not yet started: 
red LED in display
Meaning of LED image in display:

Display:

Red LED: no test started

Yellow LED: test started

Green LED: connected

- Access mode

- Default profile, see page 39

- Current status

- DC voltage at interface

<Edit> VDSL settings.
<Access> Edits an access.
<Start> Starts VDSL.

Switch to bridge mode using 
the cursor keys, see 
page 85.

Establishing a VDSL connection
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The VDSL connection is established 
(green tick mark in layer-1 box).

The bridge can also be activated directly. If 
layer 1 has not yet been established, this is 
automatically started as well.




Switches to the layer-1 box and other 
elements, see page 85 for explanation.

<Edit> Bridge/router parameter settings.

<Stop> Deactivates bridge mode.

<Info> Displays the activity of bridge 
mode.

When the ADSL physical layer is active, 
you can run the following tests using the 
softkey <Test>, see page 108.

No tests are available when 
bridge mode is active.

Displays the connection 
parameters.

<Info> 
 or 

Displays the VDSL 
connection parameters, 
see page 53.

<Stop> Disconnects the VDSL 
connection and automatically 
deactivates the bridge.

Establishing the VDSL bridge
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7.5 ARGUS in access mode xTU-R router

Connect ARGUS to the PC using the patch cable and to the VDSL access using the xDSL 
cable.
In router mode, ARGUS replaces both the modem and the router, so that multiple PCs can 
access a network connection (via a hub/switch). The IP addresses of the network are either 
issued statically or ARGUS is designated the DHCP server and assigns IP addresses to 
the connected PCs.

Bridge/router settings, see page 46.

xDSL settings, see page 39 and following.

Settings in access mode xTU-R bridge
In this example, VDSL VTU-R router mode is configured and selected as described in 
chapter „5 Configuring accesses“ (see page 23).

Test not yet started: 
red LED in display
Meaning of LED image in display:

Display:

Red LED: no test started

Yellow LED: test started

Green LED: connected

- Access mode

- Default profile (profile 1)

- Current status

- DC voltage at interface

Ethernet 

VDSL 

Ethernet 

Hub/switch

Ethernet
LANVDSL

access


ARGUS does not have a 
firewall!

PC 

PC 

e.g. PPP IP
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Establishing the VDSL connection

Virtual line selected.





Router selected.




The router can also be activated directly. If 
layer 1 has not yet been established, this 
is automatically started as well.




<Edit> VDSL settings.
<Access> Edits an access.
<Start> Starts VDSL.

Switch to router mode using 
the cursor keys, see 
page 85.

When the ADSL physical layer is active, 
you can run the following tests using the 
softkey <Test>, see page 108.

No tests are available when 
router mode is active.

<Edit> Edits the parameters, see 
chapter „9 Virtual lines (VL)“ 
(see page 84).

<Edit> Bridge/router parameter 
settings, see page 46.

Establishing the VDSL router.
The VDSL connection is active.

See page 74 for bridge mode display and 
operation.

Switch to Router using 
the cursor keys, see 
page 85.
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7.6 ARGUS in access mode xTU-C

Determining the SHDSL connection parameters
ARGUS is connected to the SHDSL modem directly using the supplied xDSL, patch, 
SHDSL 4-wire or SHDSL 8-wire banana cable. In this case, ARGUS replaces the DSLAM 
(STU-C). ARGUS establishes an SHDSL connection and determines all relevant SHDSL 
connection parameters. ARGUS displays the SHDSL connection parameters and, if 
desired, saves them when the link is disconnected.
The procedure is the same for SHDSL 2-wire ATM, SHDSL 4, 6 and 8-wire connections 
and for EFM.


Use only the patch cable supplied with the device.




Configuring access mode STU-C:
SHDSL STU-C mode is explained in chapter „5 Configuring accesses“ (see page 23), 
including configuration and selection.

Connecting SHDSL on the STU-C side:

Connect STU-C and display the connection parameters (see page 68) via <Info> as for 
VTU-R, see page 50.

When the SHDSL physical layer is active, you can run the following tests using the softkey 
<Test>, see page 108.

SHDSL modem or another 
ARGUS (STU-R) 

Socket
Line

e.g. xDSL cable or patch cable 
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8 Operation with Ethernet accesses

ARGUS supports the following access modes in Ethernet operation: 

The individual tests acquire and store data. It is the user's responsibility to comply 
with the applicable legal requirements.


 

Patch cable

Socket LAN

Ethernet e.g. xDSL 

Connecting to a modem:

Modem

e.g. xDSL
access





Patch cable

Socket LAN

Ethernet e.g. xDSL 

Connecting to a router modem:

Router
modem

e.g. xDSL
Access

Patch cable

Socket LAN

Ethernet e.g. xDSL 

Connecting to a PPTP router modem:

PPTP
(router)
modem

e.g. xDSL
Access
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8.1 Configuring the Ethernet interface

Please refer to chapter „5 Configuring accesses“ (see page 23) for instructions on 
configuring the Ethernet interface.

Note: accessing functions via number keys/key combinations
You can call important functions/tests directly using the keys of the ARGUS keypad. You 
can find an overview of these key combinations on page 108.

Note: 
The Ethernet cable tests (including Ethernet-TDR) are described in chapter „23 Ethernet 
cable tests“ (see page 333).

Socket LAN 

Ethernet 

Connecting to a PC via IP

PC
Patch cable

Socket LAN

Connecting to an IP network:

Ethernet 

Hub/switch

Patch cable PC

PC
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8.2 Ethernet settings
You can modify the Ethernet settings as described for VDSL, see page 39.

Autonego-

tiation



See chapter „9.4 Virtual line settings“ (see page 94) for further configurations.

Autonegotiation/Ethernet link parameters
Ethernet link autonegotiation is supported by default!
Setting: autonegotiation "on"
When negotiating the link parameters, ARGUS informs the remote station that the following 
is supported (these settings are fixed and cannot be configured):
- 10, 100 or 1000 Mbit/s
- Half or full duplex
- Flow control on/off (for on: symmetric and asymmetric pause) 

Manually configuring the Ethernet link parameters
Setting: autonegotiation "off"
When autonegotiation is deactivated, the speed, duplex and flow control ("pause" method) 
can be configured in the profile (see page 81). 
- 10, 100 or 1000 Mbit/s, default: 100 Mbit/s
- Half or full duplex, default: full
- Flow control on/off ("Flow control off" is only useful in full duplex mode)

Default: on

Unilateral autonegotiation
When a terminal device with autonegotiation "on" encounters a device without 
autonegotiation, no information is transmitted by the remote station. Even without 

autonegotiation, the speed is determined using the pulse method/idle pattern (parallel 
detection). In this case, the terminal device with autodetection generally drops back to half 
duplex (duplex mismatch possible), which can result in a duplex mode conflict with "poor 
throughput".

Setting Description
Preconfigured accesses

Phys. parameters:

Ethernet:

Switches on or off
When autonegotiation is switched on, network cards can automatically 
detect the correct transmission speed and duplex method of the Ethernet 
port to which they are connected and configure themselves accordingly. In 
Ethernet, autonegotiation is based on layer 1 of the OSI model (according 
to IEEE standard 802.3u). 
Default: on
To set this to off, see the following section, page 81.

MAC address, see page 40.
ARGUS 155 81



8 Operation with Ethernet accesses

.

8.3 Establishing an Ethernet connection

Establishing an Ethernet 
connection

or

ARGUS in the status screen.

ARGUS uses the default profile (profile 1 
in the example) to establish an Ethernet 
connection.

Meaning of the arrow in the layer-1 box

Gray arrow

Yellow arrow

Green check 
mark

The test has not yet started!

no test started

test started

connected








<Info> Displays Ethernet connection 
parameters.

<Stop> Stops the Ethernet connection




Display:

- Autonegotiation setting 

- Autoneg. at remote station 

- Negotiated speed 

- Type of duplex mode 

- Flow control setting

<Statistic> Opens Ethernet statistics
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s. <Statistic> page 82

Displays polling and offset between wires

Statistic display

Disconnecting from the Ethernet connection and saving the results
You can disconnect and save the results from an Ethernet connection as described for 
VDSL, see page 71.

Saving the results without disconnecting from the Ethernet connection
You can save your results for an Ethernet connection without disconnecting in the same 
way as for VDSL, see page 72.

- Wire allocation

Left column ARGUS wire allocation

Right column ARGUS wire allocation after 
autonegotiation with remote 
terminal. When the display 
shows "OK", the remote 
station has inverted the wire 
allocation.

- Polling

- Skew in ns

- Received (Rx) and transmitted (Tx) 
internet frames

- Received (Rx) and transmitted (Tx) 
bytes

- Number of errors on the receiver (Rx) 
and transmitter (Tx) side

- Number of collisions
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9 Virtual lines (VL)

Virtual lines (VL) compile the configurations of  layer 2 and  layer 3 into profiles, called the 
VL profiles. These profiles contain e.g. information on protocols, VPI/VCIs, VLANs and 
PPP data (stored in their own subordinate PPP profiles). Virtual lines can be used to 
conduct tests across multiple VPI/VCIs or VLANs and across different protocols. 
ARGUS allows you to define up to 20 such VL profiles. In a VL profile, you can edit e.g. the 
protocol configuration. The VL profiles can be assigned to one or more services independ-
ently of the state of the physical layer (layer 1). 
Thus, a data test (e.g. IP ping and a VoIP test (e.g. VoIP call) can be performed on a single 
active access without having to re-establish layer 1 (DSL, Ethernet) in spite of differing 
protocols.

9.1 Virtual lines in the status screen

The virtual lines in the status screen are explained using the access VDSL VTU-R 
router:

Services
see page 106

Layer 1

Router/bridge 
(only for xTU-R bridge 
and xTU-R router)

Virtual lines

Profile name

Current access

Virtual line for 
bridge/router, 
configuration 
see page 46.

Softkey assign-
ment, see 
page 110.
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The status screen is divided into three levels that can be individually selected using the 
cursor keys of the ARGUS keypad.
The status screen is described in greater detail using three display examples.

Cursor up

Cursor up

<Edit>

<Access>

<Start>

Level 1: physical layer (see page 36)







Level 2: virtual lines

<Edit>

The following configuration options are 
shown:
 - Protocol (IP, PPP, PPTP)
 - ATM, see page 94
 - VLAN, see page 95
 - PPP (PPP profiles)
 - PPTP, see page 97
 - IP version (IPv4, IPv6, dual)
 - IPv4, see page 97
 - IPv6, see page 99
 - Data log (for this VL)
 - Profile name, see page 100

<Profile>



Level 3: services (see page 106)

<Edit>

<Profile>

<Start>



The virtual line and the physical layer start 
automatically when you press the softkey  
<Start>.

Configures physical layer.

Selects access.

Establishes physical layer of 
the selected access.

Configures virtual line, see 
page 89.

Configures the profile.

Assigns a VL to a service 
and configures it.

Configures the profile.

Starts the service.
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Depending on the state of the physical layer, the virtual lines or the services, ARGUS 
displays a variety of symbols in the status screen.


This service has not yet been assigned to a virtual line.

This service, VL or physical layer is idle.

This service is not available (bridge mode only).

Preparing activation of physical layer, VL or service.

Activating the physical layer, VL or service.

Physical layer, VL or service deactivated due to an unexpected occurrence.

Deactivating.

Synchronisation achieved (physical layer) or a VL or service was activated 
successfully without errors.

A test is currently running in this service.

An error occurred here. Reset with <Reset> to continue with the VL/service.

9.2 Virtual line profiles (VL profiles)
The various profile types are explained below:

Profiles (1 - 20), see page 31:

-

-

-

VL profiles (virtual lines 1 - 20 )

-

-

-

-

PPP profiles (1 - 20)

-

-

-

Under the services, these contain the assignments for the services Data, VoIP, IPTV 
and VoD.

In addition to the services, the settings for the bridge/router and the test parameters can 
be found here as well.

Every profile can be assigned an individual profile name.

These contain the layer 2/3 settings.

VL profiles are assigned to services.

One VL can be assigned to multiple services.

The VL profiles can be assigned to PPP profiles.

These contain all relevant data for dialling.

PPP profiles are assigned to VL profiles.

One PPP profile can be assigned to multiple VL profiles.
86 ARGUS 155



9 Virtual lines (VL)

0

Relationships between profile types
When all configurations are reset (see page 357), a VL profile (1-20) is only assigned to the 
service data in each profile (1-20). One PPP profile is assigned to each VL profile (1-20).
All other services (such as VoIP, IPTV and VoD) are initially not assigned a VL profile or a 
PPP profile. 
The assignment further VL and PPP profiles to services is described starting on page 89.

Default configuration:

Profile 1

Service Data => VL profile 1 => PPP 
profile 1

Service VoIP ... ...

Service IPTV ... ...

Service VoD ... ...






Profile 20

Service data => VL profile 20 => PPP
profile 2

Service VoIP ... ...

Service IPTV ... ...

Service VoD ... ...
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9.3 Activating a virtual line
A service or test must be started in order to activate a virtual line. To enable a test to be 
started, a service must be configured, and a virtual line assigned to it. In this example, the 
service Data is configured and assigned ot a virtual line.

9.3.1 Starting a service

Continued on 
next page

The VDSL access is active.













<Start>



The physical layer (VDSL), the virtual line 
and the service Data are now active. This 
is indicated by a green check mark.

<Info>

<Stop>



See page 106 for explanations of the 
services.



Use the cursor keys to switch from 
the layer-1 box over the virtual line to 
the service Data.

If the physical layer is not yet 
active, this is started automatically 
with the service or test.

Starts the service.

Displays information on the 
service Data (e.g. duration 
of activity).

Stops the service Data.
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The tests that can be run using the service 
Data are displayed.

<Setting>

9.3.2 Assigning additional virtual lines

ARGUS can use multiple services concurrently (e.g. Data and VoIP) via a single virtual line. 
In this example, VDSL is active. The service Data is selected. The following explains how 
multiple services can be connected via a single virtual line.

Continued on next page









<Edit>

Configures the respective 
test (in this example IP ping).
A detailed description is 
provided in the chapter Test, 
see page 124. 

To configure a virtual line (in this 
example for the service Data) for 
other services, you must first 
stop the service.
The physical layer remains 
active.


The service VoIP is greyed out 
when the VoIP option is not set. 



Using the cursor keys, 
select the service VoIP.

Opens the configuration of the 
selected service (in this 
example VoIP).
ARGUS 155 89



9 Virtual lines (VL)
Continued on 
next page

Select "Virtual line"













<Edit>



Edit the selected VL profile.



The configuration options are described 
starting on page 96.

Opens PPP profile selection

Select the virtual profile you wish 
to edit. The selected profile is 
highlighted in blue in the display. 

Elements not available are 
grayed out, for instance when 
they are currently active.

The configuration options are 
described starting on page 94.


e.g. select PPP
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3x

Continued on 
next page






Up to 20 PPP profiles can be 

configured.

<Edit>

The configuration options are described 
starting on page 96.




e.g. select PPP profile 1

Edits the selected PPP 
profile, see page 96.


The desired profile has not yet 
been selected.
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Select Data using the 
cursor keys and press 
<Start> to activate the 
service.


ARGUS switches to the status screen or 
the Settings menu (depending on whether 
you accessed the profiles using the main 
menu or the status screen).

The services Data and VoIP are now 
connected to the physical layer (VDSL 
access) via a virtual line.

<Start>





The service VoIP is now active. 
You can now run a variety of tests via the 
service VoIP.


In the next step, you can now activate a 
further service.

Starts the service VoIP.
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The services Data and VoIP are active. 
You can now run a variety of tests via the 
services Data and VoIP.










The display and operation for IPTV and VoD (video on demand) are the same as for VoIP.

Further examples of different virtual line assignments:

Example 1:

Example 2:



One virtual line is connected with the 
service Data and another with the service 
VoIP.
The virtual line for VoIP can thus be used 
for different protocol data than the virtual 
line for Data.









One virtual line was configured for the 
services Data, VoIP, IPTV und VoD. 
In this example, the services IPTV and 
VoD are active. 


Up to four virtual lines can be 
established for the service IPTV.
However, ARGUS only displays 
these as a single composite virtual 
line.
A detailed description is provided in 
the chapter IPTV, see page 174.
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Example 3: 



In this example, each service was 
assigned a virtual line. 
As ARGUS is in bridge mode, these 
services cannot be executed.


9.4 Virtual line settings

Setting Description

Virt. profile 1 to 20

Protocol Selection of transmission profile that ARGUS uses for the test (e.g.
for the IP tests).
Default: PPP

Protocol ATM: Interfaces:

ATM with 
ETH

ADSL VDSL SHDSL 
ATM

SHDSL EFM ETH

IP no EoA
IP

EoA
IP

IP no IPoA    -

PPP yes PPPoE
PPPoE

PPPoE
PPPoE

PPP no PPPoA    -

PPTP    -    -    -    -    - PPTP

You can choose between the protocol "ATM with Ethernet" or "ATM without Ethernet" using 
the ATM menu option.

ATM: Settings for asynchronous transfer mode

VPI/VCI VPI:
VCI:

Enter the virtual path identifier
Enter the virtual channel identifier
Ranges VPI: 0 to 255, VCI: 32 to 65535
Default: VPI: 1 and VCI: 32
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Encapsulation Encapsulation of the transmitted packets: LLC or VC-MUX
Default: LLC

ATM with 
Ethernet

Determines whether Ethernet is used via ATM or not, see table 
above.
Options: 
 - No (PPPoA, IPoA)
 - Yes (PPPoE, EoA)
Default: yes (PPPoE, EoA)

VLAN: VLAN (Virtual Local Area Network)

VLAN VLAN mode Determines whether VLAN may be used. Up 
to two VLANs can be used concurrently (2 
VLAN tags (Q in Q)).
Default: no VLAN

1. VLAN tag (C-VLAN), 2. VLAN tag (S-VLAN) (Q in Q)

ID: Identifier for the VLAN to which the frame 
belongs. Every VLAN is assigned a unique 
number, the VLAN ID. A device that belongs 
to the VLAN with ID = 2 can communicate 
with every other device in the same VLAN 
but not with devices in other VLANs.
Range: from 0 to 4095
Default:
1. VLAN: 7
2. VLAN: 2

The IDs 0, 1 and 4095 are reserved for 
management purposes and should 
preferably not be used.

Priority: User priority information:
One of eight (3-bit) priorities can be 
specified for each frame. This makes it 
possible e.g. to give priority to transmitting 
speech data while treating HTTP data with 
lower priority.
Range: 0 to 7
Default (1. and 2. VLAN): 0
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TPID: Tag Protocol Identifier
The TPID is a 16-bit sub-field within the 4-
byte VLAN data field. This field contains the 
tag information defined by IEEE 802.1q.
Default:
VLAN 1: 8100 hexadecimal
VLAN 2: 88A8 hexadecimal

Note: When using two VLANS with layer 3 (IP) or 
layer 4, both are to be set to 8100.

PPP profile:

User name           

Entry of the user name assigned by the 
carrier:

The user name is entered using the number 
keys. Pressing the right softkey changes the 
meaning and thus influences the input via 
the number keys (letters (upper and lower 
case) and numbers).

Password                                          Entry of a password (max. 55 characters) assigned by the carrier; 
see "User name" for an explanation.
During entry, the characters of the password are visible until Enter 
is pressed once. The characters are subsequently only displayed 
encrypted with "*".

Set IP When "yes" is set, the IP address defined under IP/own IP address 
(see below) is used for connecting.
Default: no

Current delay Once a PPP connection has been established, the test is only 
started after the preset delay time has elapsed.
Range: 2 - 10 seconds
Default: 2

Profile name Enter the name of the PPP profile.
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PPTP PPP settings (Point-to-Point Tunnelling Protocol)

Own server IP address
Range 0.0.0.0. to 255.255.255.255
Default: 0.0.0.0

IP version: Internet Protocol version

Determines which IP version is to be used.

nur IPv4:
nur IPv6:
Dual Stack IPv4/
IPv6: 

Dual Stack Lite:

Internet Protocol version 4 acc. to RFC 791 
Internet Protocol version 6 acc. to RFC 2460
If IPv6 is available, this protocol is preferred 
for a test.If not, ARGUS switches 
automatically to IPv4.
Assigning a globally routable IPv6 address.
Default: IPv4

IPv4: Internet Protocol version 4 configuration

IP mode Definition of IP address assignment 

Static IP: 
DHCP client: 

DHCP server: 
DHCP auto: 

Fixed IP address
Assignment of IP address by server (remote 
side)
Assignment of IP address by ARGUS
ARGUS checks for the presence of a DHCP 
server in the network. If a server is present, 
it assigns the IP address; if not, ARGUS 
does this.
Default: DHCP client 

Own IP address Own ARGUS IP address
Range: Range 0.0.0.0. to 255.255.255.255
Default: 0.0.0.0 (assignment see RFC 3330)

IP netmask IP netmask 
Range: Range 0.0.0.0. to 255.255.255.255
Default: 255.255.255.0 (assignment see RFC 3330)  

Gateway IP Gateway IP address
Range: Range 0.0.0.0. to 255.255.255.255
Default: 0.0.0.0 (assignment see RFC 3330)
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DNS Server DNS server 1 
DNS server 2
Entry of DNS server IP address
(DNS = Domain Name System)
Range: Range 0.0.0.0. to 255.255.255.255
Default: 0.0.0.0 (assignment see RFC 3330)

DHCP client DHCP timeout:
Range: 1 - 9999 seconds
Default: 20 

DHCP Vendor ID:
- Format: choose format: ASCII or hexadecimal
ASCII data: Entry of DHCP vendor ID in ASCII format
  Default: ARGUS, for details see "User name", page 96
- HEX data: entry of DHCP vendor ID in hexadecimal format, see 
  MAC address page 81

DHCP vendor info:
- Format: choose format: ASCII or hexadecimal
- ASCII data: Entry of DHCP vendor information in ASCII format,
  default: ARGUS, for details see "User name", page 96
- HEX data: entry of DHCP vendor information in hexadecimal
  format, see MAC address page 81

DHCP user class information
- Format: choose format: ASCII or hexadecimal
- ASCII data: entry of DHCP user class info in ASCII format
  Default: ARGUS, for details see "User name", page 96
- HEX data: entry of DHCP user class information in hexadecimal 
  format, see MAC address page 81

DHCP user-defined option (generate a custom DHCP option)
- Option number
  Range: 0 to 255
  Default: 255 = off
- Format: choose format: ASCII or hexadecimal
- ASCII data: entry of DHCP user-defined option in ASCII format
  Default: ARGUS, for details see "User name", page 96
- HEX data Entry of DHCP user-defined option in hexadecimal 
  format, see MAC address page 81
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DHCP server Settings for the DHCP server:
- Starting and ending IP address
  Range: Range 0.0.0.0. to 255.255.255.255
  Default: (assignment see RFC 3330)
  Start: 192.168.10.30
  End: 192.168.10.40
- Domain name, see "User name" page 96 for details
- Duration of reservation for IP addresses
  Range: 1 - 99999 seconds
  Default: 240

IPv6: Internet Protocol Version 6 settings

AFTR AFTR mode Determines whether Address Family 
Transition Router (AFTR) mode is set 
automatically or statically.
Default: Automatic

AFTR address Entry of the AFTR address. 

DHCP client DHCP mode Determines whether DHCPv6 is selected 
automatically or whether the Router 
Advertisement (RA) server is ignored.
Default: Automatic

DHCP options Determines whether the DHCPv6 options 
are automatically selected or all options 
requested. 
Default: Automatic

Enterprise Number 
(PEN)

Entry of PEN (Private Enterprise Number).
Range: 0 to 65535
Default: 46443
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Data log Data log on or off 
This function must be set to "on" so that a trace file can be sent to 
the PC; see page 71. 
After terminating a VL via the corresponding service or the physical 
layer, ARGUS queries whether the trace file should be sent to the 
PC.
For example, when the data log is activated for VL 1, only VL 1 is 
recorded. When one VL is configured for multiple services and the 
data log is active, all data of this VL are recorded.
Default: off

Profile name Enter the name of the VL profile. Enter the name as for the access 
name, see page 25.
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9.5 Displaying protocol statistics

Continued on 
next page

Depending on the access mode and the protocol, ARGUS displays BRAS, IP, PPP, ATM or 
Ethernet statistics.



The physical layer, virtual line and 
service data are active. 










BRAS information:
For PPP protocol only, ARGUS displays 
the Broadband Access Server (BRAS) 
information:
- AC (access server): name of server 
- Service name name of service

<Info> Displays DSL results.

<Stop> Deactivates physical layer, VL 
and Data service.

Switch to the virtual line (VL) using 
the cursor keys.

Press one after 
another

 and 

Display of ARGUS MAC 
addresses:
Line, LAN, ETH, see also 
page 110 and following.

<IPv4> Displays the configuration 
assigned by the server.
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PPP information:
ARGUS displays the received (Rx) and 
transmitted (Tx) PPP packets and the 
bytes.












Ethernet:
ARGUS displays the received (Rx) and 
transmitted (Tx) Ethernet frames, bytes 
and errors.








Command display






<PPP> The softkey <PPP> opens a PPP 
trace, which displays the PPP login 
process.

< = Command sent by ARGUS

> = Command sent by DSLAM

<Time> The <Time> softkey assigns the 
individual messages to times 
according to the ARGUS system 
clock.

Continued on 
next page
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- PADI:
PPPoE Active Discovery Initiation

- PADO:
PPPoE Active Discovery Offer

- PADR:
PPPoE Active Discovery Request

- PADS:
PPPoE Active Discovery Session 
Confirmation

- PADT:
PPPoE Active Discovery Termination

- IPv6 CP:
IPv6 Control Protocol

- LCP:
Link Control Protocol

- IPCP:
Internet Protocol Control Protocol

- PAP:
Password Authentication Protocol

Table:

ack. = acknowledge

auth. = authentication

conf. = configuration

nak. = not acknowledge

prot. = protocol

rec. = received

rep. = reply

req. = request

rej. = rejected

2x
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In this example IPv6:

Assigned configuration:
ARGUS displays the IP configuration 
assigned by the server:
- Global Unicast Address
- Link Local Address





Assigned configuration:
ARGUS displays the IP configuration 
assigned by the server:
- Received IP address
- Gateway IP address
- Available DNS servers

<IPv6> IPv6 information is displayed.

<IPv4> IPv4 information is displayed.

Use the cursor keys to display 
further information.

Exits results.

Exits results.

IP version-dependent

<IPv4>
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10 Services

The status screen (see explanation page 84) shows four services.
Each service can be used to conduct an entire suite of IP tests (see list below). It is also 
possible to start and stop each service independently of the others.

Example screen with the possible services



The meaning of the symbols, s. page 86.

Once a service is activated, a variety of tests can be started using <Test>. 

Possible tests that can be executed using the various services.

<Edit> Assigns the service a VL 
profile and configures the 
service.

<Profile> Configures the profile.
<Start> Activates the service. If 

virtual lines and the physical 
layer are not active, they are 
also automatically started as 
well.

Services:

- IP ping - IP ping - IP ping - IP ping

- Traceroute - Traceroute - Traceroute - Traceroute

- HTTP download - VoIP call - IPTV - Video on demand

- FTP download - VoIP wait - IPTV scan

- FTP upload - VoIP PESQ test - IPTV passive

- FTP server
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10.1 Displaying service statistics


ARGUS in the status screen.
The physical layer, VL and service are 
active.





















Switch to a service (in this example 
Data) using the cursor keys.

<Info> Displays the duration of activity 
of the selected service.

In the service VoIP, the VoIP 
call parameters are displayed 
here, see page 167.

Exit the display and return to the 
status screen.
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11 Overview of tests andhotkey assignment
Overview of tests

Interface
Test 

ATU-R
VTU-R

STU-R 
(only 
ATM + 
EMF)

STU-C
(only 
ATM + 
EMF)

AUT-R BR
VTU-R BR
STU-R BR
STU-C BR*1

ATU-R RT
VTU-R RT
STU-R RT

Eth

Loop s. page 112 - x x - x*4 x

VPI/VCI scan s. page 118 x*3 x*2 x x*3 x*3 -

ATM-OAM ping s. page 121 x*3 x*2 x x*3 x*3 -

IP ping s. page 124 x x x - x x

Traceroute s. page 130 x x - - x x

HTTP download s. page 134 x x - - x x

FTP download s. page 139 x x - - x x

FTP upload s. page 143 x x - - x x

FTP server s. page 147 x x x*1 - x x

VoIP call/wait s. page 154 x x - - x x

IPTV s. page 174 x x - - x x

IPTV scan s. page 189 x x - - x x

IPTV passive s. page 196 - - - x*1 x x

VoD s. page 200 x x - x x*3 x

PESQ s. page 294 x x - - x x

*1 = EFM only  *2 = ATM only  *3 = not for VDSL   *4 = only for SHDSL

Display of possible tests at the xDSL and Ethernet interface:

A virtual line must be configured first before ARGUS can execute these texts (exceptions: 
VPI/VCI scan, ATM-OAM ping, loop). Configuration is described in the chapter "Virtual 
line", see page 84.
108 ARGUS 155



11 Overview of tests andhotkey assignment
Graphic functions:
After running the xDSL interface or a test, you can use the following graphic functions in the 

result displays:

Hotkey xDSL trace ADSL/
VDSL Line Scope TDR

Legend - - -

- Zoom Zoom Zoom

Cursor Cursor Cursor Cursor

- - Measuring range Measuring range

- - Total power Pulse width/
height

- - - Wire type/VoP

- - Probe -

- - Symmetry -

- Setting of 
x-axis

Time/FFT -

- Min/Max Peak hold -

- - 100 Ohm input 
resistance

-

- Continue - -

- - Run/Hold Run/Hold

- - Reference curve Reference curve

- Store Store Store

Number key 1

Number key 2

Number key 3

Number key 4

Number key 5

Number key 6

Number key 7

Number key 8

Number key 9

Number key 0

Number key #

Press one after 
another

 and 

Press one after 
another

 and 
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Hotkey assignment
You can call important functions/tests directly using the keys of the ARGUS keypad. 
Depending on the selected access type (xDSL and Ethernet in this example), different 
hotkeys can be used:

Hotkey Service ADSL VDSL SHDSL ETH
ARGUS status x x x x
Hotkey help x x x x

VPI/VCI scan x - ATM -

IP ping x x x x
Traceroute x x x x

HTTP download x x x x

Test status x x x x
FTP download x x x x

Copper Box x x x -

IPTV x x x x


Status screen
x x x x



VoIP call
x x x x

x x x x

x x x x

x x x x

x x x x

x x x x

Number key 0
Number key 1

Number key 2

Number key 3
Number key 4

Number key 5

Number key 6
Number key 7

Number key 8

Number key 9

Press one after 
another

 and  

Shortcut to access selection 
menu.

Press one after 
another

 and 

Displays ARGUS-specific 
information such as ARGUS type, 
SW version, S/N, own MAC 
addresses, SW options and 
more.

Press one after 
another

 and 

Restores the saved test settings, 
see page 356.

Press one after 
another

 and 

Resets all settings to the factory 
default, see page 357.

Press one after 
another

 and 

ARGUS saves the current 
measurement without stopping it. 
ARGUS automatically suggests a 
name.
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Depending on the selected access type (ISDN, POTS and Copper tests in this example), 
different hotkeys can be used:

Hotkey Service BRI
S/T

BRI 
U

PRI POTS Cu tests
Status

x x x x x
x x x x x
x x x - -

x x x - -

x x x - -
x x x x x
x x x - -
x x x x -
x x x - -
x x L1

Status
x -

x x x x -

x x x x x

x x x x x

x x x x x

x x x x x

Opens Test Manager.

x x x - -



ARGUS saves the current measure-
ment without stopping it. ARGUS 
automatically suggests a name.

x x x x x

Number key 0 ARGUS status
Number key 1 Hotkey help
Number key 2 Start services test 

(not for fixed lines)
Number key 3 Test service features 

(not for fixed lines)
Number key 4 Starts an automatic test.
Number key 5 Sends test results to PC
Number key 6 Opens Test Manager
Number key 7 Opens saved numbers
Number key 9 Starts BERT

Level measurement

Connect

Press one after 
another

 and  

Shortcut to access selection menu.

Press one after 
another

 and 

Displays ARGUS-specific information, 
see page 110.

Press one after 
another

 and 

Restores the saved test settings, see 
page 356.

Press one after 
another

 and 

Resets all settings to the factory 
default, see page 357.

Press one after 
another

 and 
Press one after 
another

 and 
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12 Loop

A loop can be created on both an SHDSL line (in EFM or ATM mode) and on Ethernet.
In a loop, all incoming Ethernet frames on layer 1 (L1) are returned to the sender 
unchanged. 
In a loop on layer 2 (L2) of the OSI model, ARGUS swaps the source MAC address for the 
destination MAC address and then returns all Ethernet frames.

The loop requires the following parameters:

Protocol-independent parameters
The opening of test parameters is described in the chapter "Configuring accesses", see 
page 31.

Setting Description

Test parameter:

Loop

Layer This setting determines what layer of the OSI model the loop runs on. 
 - L1: all incoming Ethernet frames on a loop on layer 1 (L1) are returned to 
   the sender unaltered.
 - L2: on a loop on layer 2 of the OSI model, ARGUS exchanges the source 
   MAC address with the destination MAC address and returns all incoming 
   Ethernet frames.
- L3: on a loop on layer 3 (L3) of the OSI model, ARGUS exchanges the 
  destination and own IP address as well as the MAC addresses and then 
  returns all incoming Ethernet frames.
Default: L2
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12 Loop
Layer 2 MAC mode You can use the loop MAC mode to determine what gets looped.
 - For own MAC only (promiscuous mode off)
  L1: only packets for the own MAC address and broadcast
  packets are looped. 
  L2: only packets for the own MAC address are looped. 
  Broadcasts are rejected.
  L3: only packets for the own MAC address and own IP address
  are looped. Broadcasts are rejected. 
 - Loop everything (promiscuous mode on)
  L1: all packets (including broadcast) are looped.
  L2: all packets - except broadcasts - are looped. Broadcasts
  are rejected.
  L3: all packets for which the IP address has been recognised 
are looped.
Default: for own MAC only

VLAN VLAN (Virtual Local Area Network)

VLAN 
mode

Determines whether VLAN may be used. Up to two VLANs can 
be used concurrently.
Default: no VLAN

1. VLAN 
(C-VLAN)

ID Identifier for the VLAN to which the frame belongs. 
Every VLAN is assigned a unique number, the VLAN 
ID. A device that belongs to the VLAN with ID = 2 can 
communicate with every other device in the same 
VLAN but not with devices in other VLANs.
Range: from 0 to 4095
Default: 2

The IDs 0, 1 and 4095 are reserved for management 
purposes and should preferably not be used.

Priority User priority information:
One of eight (3-bit) priorities can be specified for each 
frame. This makes it possible e.g. to give priority to 
transmitting speech data while treating HTTP data with 
lower priority.
Range: 0 to 7
Default: 0
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TPID 8100 Hex The VLAN TPID 8100 hex is a 16-bit field 
that identifies frames according to IEEE 
802.1Q (VLAN-tagged frame). It also 
makes it possible to use all network paths 
actively according to IEEE 802.aq (shortest 
path bridging, SPB).

88A8 Hex VLAN TPID 88A8 supports provider bridg-
ing according to IEEE 802.ad. It also 
makes it possible to use all network paths 
actively according to IEEE 802.aq (shortest 
path bridging, SPB).

Default: 8100 Hex

2. VLAN 
(S-VLAN)

ID Identifier for the VLAN to which the frame belongs. 
Every VLAN is assigned a unique number, the VLAN 
ID. A device that belongs to the VLAN with ID = 2 can 
communicate with every other device in the same 
VLAN but not with devices in other VLANs.
Range: from 0 to 4095
Default: 2

The IDs 0, 1 and 4095 are reserved for management 
purposes and should preferably not be used.

Priority User priority information:
One of eight (3-bit) priorities can be specified for each 
frame. This makes it possible e.g. to give priority to 
transmitting speech data while treating HTTP data with 
lower priority.
Range: 0 to 7
Default: 0

TPID 8100 Hex The VLAN TPID 8100 hex is a 16-bit field 
that identifies frames according to IEEE 
802.1Q (VLAN-tagged frame). It also 
makes it possible to use all network paths 
actively according to IEEE 802.aq (shortest 
path bridging, SPB).
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Notes for the use of VLANs

88A8 Hex VLAN TPID 88A8 supports provider bridg-
ing according to IEEE 802.ad. It also 
makes it possible to use all network paths 
actively according to IEEE 802.aq (shortest 
path bridging, SPB).

Default: 88A8 Hex

Layer 3

Contains received Ethernet packets 

Loop - VLAN 

mode

no VLAN one VLAN two VLANs

No VLAN x x x

1. VLAN tag 

(C-VLAN)

- ARGUS loops when the 
VLAN IDs and TPIDs 
contained in Ethernet 
packets agree with the 
VLAN 1 settings.

ARGUS loops when the first VLAN ID 
(also called outer or service ID) and 
TPID contained in Ethernet packets 
agree with the VLAN 1 settings.

1. VLAN tag 

(C-VLAN) 

and 2. VLAN 

tag 

(S-VLAN)

- - ARGUS loops when the first VLAN ID 
(also called outer or service ID) and 
TPID contained in Ethernet packets 
agree with the VLAN 2 settings and 
the second VLAN ID (also called the 
inner or customer ID) and TPID agree 
with the VLAN 1 settings.

- = ARGUS does not loop.

x = ARGUS loops regardless of whether the received Ethernet packets contain VLANs.

IP-mode For IP address assignment, this determines whether a static IP 
address is to be used or whether a server (remote station) 
issues the IP address (DHCP client).
Default: Static IP

Own IP 
address

Own ARGUS IP address
Range: Range 0.0.0.0. to 255.255.255.255
Default: 0.0.0.0 (assignment see RFC 3330)
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12 Loop
Starting the loop (access mode: SHDSL STU-R ATM)
ARGUS in status screen.


Continued on 
next page

Establishing the SHDSL connection

The profile shown in the display (profile 1 
in this example) is used for the loop.




















<Setting>



<Start> Activates SHDSL.

<Info> Displays SHDSL connection 
parameters.

<Test> Displays the available tests.

<Stop> Stops SHDSL connection.

Changes loop parameters, 
see page 112.
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12 Loop

The loop is started:


Saving the results
You can save the results for the loop test in the same way as for VDSL, see page 71.



Duration Current duration of test

Looped Number of packets looped 
so far

Looped 

in 1s

Number of packets looped 
in the current second

Loop 

rate

Displays the current data 
rate per second.

MAC 

address

Own MAC address of 
looping device (e.g. for entry 
in the traffic generator).

<Status> Displays status screen without 
ending the test.

Duration Overall duration of test.

Looped Number of looped packets.

avg. Number of looped packets per 
second.

<Status> Display of status screen.

Connection statistics are not recorded during the loop tests (in SHDSL access). 
ARGUS resumes saving of these statistics when the test is ended.
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13 ATM tests 

The following ATM tests can only be performed on an ADSL or an SHDSL-ATM interface. 
Other interfaces such as VDSL, Ethernet or SHDSL-EFM are not based on ATM.

13.1 VPI/VCI scan

In VPI/VCI scan, ARGUS checks which VPI/VCI combinations are active on the test 
access. ARGUS transmits a test packet for all possible VPI/VCI and waits for a response 
packet.

The following parameters must be saved in the profile for the VPI/VCI scan (when the xDSL 
connection is already established, the connection parameters, e.g. ADSL mode and target 
value, are locked).

Protocol-independent parameters:
The opening of test parameters is described in the chapter "Configuring accesses", see 
page 31.

Setting Description

Test parameters:

VPI/VCI scan:

VPI Virtual path identifier:
VPI range that the ARGUS VPI/VCI scan tests.
Range: 0 to 255
Default: 0 to 8

VCI Virtual channel identifier: 
VCI range that the ARGUS VPI/VCI scan tests.
Range: 32 to 65535
Default: 32 to 48

Number of 

scans

Number of scans. 
Range: 0 to 99
Default: 2

Timeout Maximum wait time for the response from the ATM network node to the test 
packet sent by ARGUS.
Range: 0.1 - 9.9 seconds
Default: 0.5 seconds
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13 ATM tests
Start VPI/VCI scan 

ARGUS in the status screen.

The ADSL ATU-R example shown in this 
example is active.
















The VPI/VCI scan starts automatically.




ARGUS displays the VPI/VCI combination 
currently being tested and the most 
recently detected active VPI/VCI 
combination (in this example: 1/32).

<Info> Displays ADSL connection 
parameters.

<Test> Displays the available tests.

<Stop> Stops the ADSL connection.

<Setting> ARGUS displays the test 
parameters for the VPI/VCI 
scan, see page 118.

<Status> Displays status screen without 
ending the test; see above.

Cancels test.

Initialisation

VPI/VCI scan
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13 ATM tests



When the VPI/VCI is finished, ARGUS 
displays the VPI/VCI combinations active 
on the test connection.
 












Exits results.

For saving results, see IP ping on 
page 129.

<Status> Display of status screen.
<New> Start new VPI/VCI scan.

VPI/VCI scan result

Save result?
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13.2 ATM-OAM ping

With an ATM-OAM ping, ARGUS checks the availability of individual ATM nodes or the 
availability of an ATM partial network. OAM stands for Operation, Administration and 
Maintenance and is used to monitor ATM data transmission.
The following parameters must be saved in the profile for the ATM-OAM ping (when the 
ADSL connection is already established, the connection parameters, e.g. ADSL mode and 
target value, are locked):

Protocol-independent parameters:
The opening of test parameters is described in the chapter "Configuring accesses", see 
page 31.

Setting Description

Test parameters:

ATM-OAM ping

VPI/VCI Entry of the VPI and VCI for the ATM-OAM ping.
Range: VPI: 0 to 255, VCI: 32 to 65535
Default: VPI: 1, VCI: 32

Number of 

pings 

Number of test packets sent by ARGUS. 
When 0 is set ARGUS sends continuously until the ATM-OAM ping 
is halted manually.
Range: 1 to 99999
Default: 3 

Timeout Maximum wait time for the response from the ATM network node to 
the test packet sent by ARGUS.
Range: 0.1 - 9.9 seconds
Default: 1 second

OAM cell type F5 loopback segm.: the first ATM node of the virtual channel 
responds to the loopback cell. 
F5 loopback ete: the end point of the virtual channel responds to the 
loopback cell.
Default: F5 loopback ete
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Start ATM-OAM ping

ARGUS in the status screen.

The ADSL ATU-R example set in this 
example is active.










The ATM-OAM ping starts automatically.


ARGUS displays the current number of 
sent test packets, the current number of 
response packets and the VPI/VCI on 
which the ping was executed.


<Info> Displays ADSL connection 
parameters.

<Test> Displays the available tests.

<Stop> Stops the ADSL connection.

<Setting> ARGUS displays the test 
parameters for the ATM-OAM 
ping, see page 121.

<Status> Displays status screen without 
ending the test; see above.

Cancels test.

Initialisation

ATM-OAM ping
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At the end of the ATM-OAM ping, ARGUS 
automatically displays the result; for the 
setting "infinite" the test must be cancelled 
manually.
 











For saving results, see IP ping on 
page 129.

- Number of packets sent

- Number of packets received

- Number of packets lost

- Minimum packet response time

- Maximum packet response time

- Average packet response time

<Status> Display of status screen.
<New> Start new ATM-OAM ping.

ATM-OAM ping result

Save result?
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14 IP tests

14.1 IP ping

In IP ping, ARGUS tests whether a connection exists via Ethernet or xDSL using a DSLAM 
and whether the ATM/IP network to the internet service provider (ISP) or another computer 
or server address is possible. ARGUS sends a test packet to a specified IP address 
(remote station) and waits for a response packet. On the basis of the received response 
packet, is it possible to draw conclusions as to the availability and delay of the ATM/IP 
network. It is also possible to measure the maximum data packet size of the path.

The IP ping the following parameters:

Protocol-independent parameters
The opening of test parameters is described in the chapter "Configuring accesses", see 
page 31.

Setting Description
Test parameters:

IP ping:

IP address Address of remote station. ARGUS can store up to 10 IP addresses. 
The stored IP addresses are available in all profiles.


ARGUS displays the ten available slots for 
IP addresses. Mark the line with the IP 
address you wish to edit using the cursor 
keys (in this example the first slot is marked 
(1/10)).

as name, IPv4 or IPv6 
number

Continued on next 
page





The address can be saved in the form of 
an IPv4 number, IPv6 number or a 
name.
Default: www.argus.info

<Edit> Edits the selected IP 
address.
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Enter the IPv4 or IPv6 address as a 
number. The editable area is highlighted in 
blue. Enter the address using the number 
keys.

<Delete> Deletes the place in front of 
the cursor.

 

to  

When entering an IPv6 
address, the letters A-F are 
available using these key 
combinations.

Adopts the marked IP 
address as the default.

Toggle entry using the softkey (right 
softkey changes the meaning when 
pressed). Enters the address as name, 
see user name page 96.

<Ab>AB> Entry begins with upper-
case letters and continues 
in lower-case.

<AB>12> Entry of upper-case letters.
<12>ab> Numerical entry.
<ab>AB> Entry of lower-case letters.

or


Entry of special characters, 
e.g. @, /, -, . or
_, :, ~, +, ...

Moves the cursor in the 
display line

Number of pings Enter the number of pings that ARGUS sends to the IP address. 
When 0 is set ARGUS sends continuously until the test is cancelled 
manually. Range: 1 to 99999
Default: 10 

Pause Defines a pause between two test packets.
Range: 0.1 - 9.9 seconds
Default: 1 second  

Packet size Sets the size of the test packet.
You can determine the maximum packet size and the response time 
as as function of size by varying the packet size.
Range: 36 to 55,555 bytes
Default: 84 bytes

IP address as IPv4 number

IP address as IPv6 number

You can use square brackets to 
include port information with IPv6 
addresses in "IP address as 
name".
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Starting IP ping (example access mode VTU-R, already active):
Establishing the service

The profile shown in the display 
(profile 1 in this example) is used for the 
IP ping.

If no xDSL or Ethernet connection is 
established, ARGUS automatically 
connects at this point using the default 
profile (see page 50).

The service Data and the VDSL 
connection are active.


Continued on next page

Fragmentation Sets the fragmentation
Default: on

on Test packets may be fragmented into multiple packets 
depending on the network (or router).

off Fragmentation prohibited, i.e. the test packets may be 
rejected by the network (or routers) (ARGUS does not 
receive a response packet).

auto ARGUS determines the maximum packet size of the 
path to the destination address (path MTU) and 
fragments the test packets so that the packets are 
transmitted with minimum delay (no fragmentation by 
the network/router necessary).

<Edit> A virtual line is allocated to the 
service Data. 

<Info> Duration of activation.

<Test> Opens test selection.

<Stop> Deactivates the service.
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ARGUS displays the addresses stored in 
the protocol.



The IP ping starts automatically.

Display during the IP ping test: 


e.g. select IP ping

<Setting> Changes IP ping 
parameters, see page 124.

Select the address for the ping; 
the default is indicated with .

<Edit> Edits the address, see 
page 124.

In this example a ping test is 
conducted with IP version IPv4. 
Use with IPv6 is analogous.

- Number of test packets sent

- Number of response packets

- Minimum time in ms

- Maximum time in ms

- Average time in ms

<Desti-
nation 
address>

Display of URL and IP address.

<Test 
status>

Displays test status without endin
the test or starting a new test, see
page 208.

Cancels test
ARGUS displays the test results 
acquired up to this point and offe
you the option of saving them 
(automatic prompt); see page 129

Initialisation

IP ping
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ARGUS displays the results when the test 
is finished:



Display of test status:
You can observe the running test or start a 
new test here, see page 208.

- Number of packets sent

- Number of packets received

- Number of packets repeated

- Checksum errors

- Number of packets received with error

- Minimum packet response time in ms

- Maximum packet response time in ms

- Average packet response time in ms

<Desti-
nation 
address>

Displays the URL and the IP 
address.

<Test 
status>

Displays test status without 
ending the test or starting a new 
test, see page 208.

<New> Starts a new IP ping test.

<New> Selects a new single test.
<Start> Starts a new IP ping test.

Continued on 
next page

IP ping result

2x 
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Sends trace file to PC, see page 100



A new test can be started as needed. The 
xDSL link and the service are still 
connected (the connection can be 
disconnected in the status screen with 
<Stop>).

Error messages in IP ping
ARGUS displays an error message as 
soon as an error occurs.




For a description of error messages, see 
the Appendix, page 376 ff.

<Yes> ARGUS saves the result of the 
IP ping test to the first free 
storage slot in internal memory 
(see page 342).

<Back> ARGUS returns to the test result 
without saving results.

<No> ARGUS returns to the last 
selection menu without saving 
results.

<Test status> Display of status screen.
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14.2 Traceroute

In IP traceroute, ARGUS sends test packets and displays all hops and their response times 
on the way to the destination address. This data enables precise localisation of possible 
delays in the network.
The following parameters must be saved in the profile for the IP traceroute:

Protocol-independent parameters:
The opening of test parameters is described in the chapter "Configuring accesses", see 
page 31.

Setting Description

Test parameters:

Traceroute:

IP address The IP address of a destination node can be entered as either an IP 
number or a name (URL), see IP ping/IP address for instructions, 
page 125.
Default: www.argus.info

Maximum hops Maximum number of hops over which the path to the destination 
address node is tracked.
Range: 1 to 25
Default: 25

Probes Number of attempts to address a network node.
Range: 1 to 10
Default: 3 

Timeout Maximum wait time for the response of a network node.
Range: 0.05 - 9.9 seconds
Default: 3 seconds
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Starting traceroute 

(Example: access mode VTU-R, already active)

Connecting the service.



The profile shown in the display 
(profile 1 in this example) is used for the 
traceroute test.


If no xDSL or Ethernet connection is 
established, ARGUS automatically 
connects at this point using the default 
profile (see page 50).

The service Data and the VDSL 
connection are active.
 







<Edit> A virtual line is assigned to the 
service Data.

<Info> Duration of activation.
<Test> Opens test selection.
<Stop> Deactivates the service.


e.g. select Trace route

<Setting> Changes traceroute 
parameters, see 
page 130.

Continued on next 
page
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ARGUS displays the IP addresses or 
URLs saved in the protocol.

The traceroute test starts automatically.

Display during the traceroute test: 

Display of test status:
You can observe the running test or start a 
new test here, see page 208.

Select the address for the tracerout
test; the default is indicated with 

<Edit> Edits the address, 
see page 124 for instructions.

In this example a traceroute test is 
conducted with IP version IPv4. 
Use with IPv6 is analogous.

- Current hop and attempt ("probe"), in this
example:
3 - 3: i.e. 3 hops and 3rd attempt.

- Response time of hop for current attemp
(0.015 seconds).

- IP address of current hop, in this 
example 192.168.111.1 with name where
applicable.

<Desti-
nat.>

Display of URL and IP address.

<Test 
status>

Displays test status without ending
the test or starting a new test, see
page 208.

Cancels test
Displays the test results up to this
point, with possibility of saving 
(automatic prompt).

<New> Selects a new single test.
<Stop> Stops the traceroute test.

Initialisation

Traceroute
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f 


Display after end of traceroute:
 



Exits results.


Saves the traceroute results (see also IP ping, page 129). 
Sends trace file to PC, see page 100.

- All hops and their response times are 
displayed.

<Detail> Displays the name of the IP 
address of the hop (if possible).
The details of the hop at the top o
the list are displayed (in this 
example hop 1).

<> Switches to next hop, in this 
example hop 2.

<> Switches to previous hop.

Save result?

Traceroute result
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14.3 HTTP download

In HTTP download, ARGUS downloads the data of a website or file. ARGUS displays the 
current "net download rate", the usable data of the IP packets, and following conclusion of 
HTTP download the average speed (for multiple download attempts).
The following parameters must be saved in the profile for the HTTP download:

It is not possible to obtain meaningful speed values for download tests with a 
duration of less than 10 seconds; therefore you should download as large a file as 
you can (depending on the access speed). If the duration of the test is less than 
10 seconds, ARGUS does not display any data rate or time.

Protocol-independent parameters:
The opening of test parameters is described in the chapter "Configuring accesses", see 
page 31. 

Setting Description

Test parameters:

HTTP download:

Server
profile:

You can create up to 15 user-defined server profiles that can be used for 
HTTP and FTP download and FTP upload. The profiles contain all 
parameters for HTTP and FTP download and FTP upload.

Server 

address

Entry of server address or URL of the server from which ARGUS 
downloads the file. For upload test: entry of upload destination address 
(server address) to which ARGUS sends the file.
See page 124 for information on using the softkeys.

Download
file name

Name of the file with the data that ARGUS downloads for tests (HTTP 
download and FTP download). 
Observe the notes for www alias addresses! (see page 135).
If a specific port is required please enter it into the server address.
See page 124 for information on using the softkeys.

Upload
file name

Entry of the file name under which the file sent to the server in the FTP 
upload test is stored.
Default: file

Upload
file size

Sets the size of the file that ARGUS sends in FTP upload.
Range: 0 to 1000 Mbyte
Default: 100 MByte
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If a www alias address is entered as the "Source/destination address", ARGUS 
downloads "only" the HTML page in HTML download. ARGUS does not evaluate 
the HTML code, so that any link to a "real" www address is not considered. In this 
case, ARGUS does not indicate an error, as the HTML page of the specified 
"Source/destination address" was loaded without error.

When entering the "Source" address (server address and download file name), 
be sure to observe the correct capitalisation; otherwise ARGUS will return error 
301 (Moved Permanently) or 404 (Not Found).

When requesting multiple download components, ARGUS may reduce the 
number of downloads depending on the server support, which can cause 
deviations from the set parameters. This can occur e.g. as soon as the size of the 
requested file is unknown.  

If the download file name exceeds the maximum permissible length, you can 
work around this limit by fragmenting the address and additionally using the 
"Server" field.
The server name may be up to 80 characters long, the file name 60 characters 
long.




User
name

Name of the user for the (FTTP, HTTP) file server.
See page 124 for instructions

Password Password entry for the (FTTP, HTTP) file server (max. 40 characters).
See page 124 for instructions

Number Number of times ARGUS downloads the file in the download test. For 
upload test: number of times ARGUS uploads the file in the upload test. 
"Zero" means infinite: the test continues until stopped manually.
Range: 0 to 9,999 bytes (0=infinite)
Default: 3

No. parall.
down.

Number of packets into which the requested download is fragmented 
and simultaneously downloaded (see page 135). 
Range: 1 to 10 
Default: 3

Profile name Enters a name for the profile.
ARGUS 155 135



14 IP tests
Starting HTTP download (example: access mode VTU-R, already active)
Connecting the service.


The profile shown in the display 
(profile 1 in this example) is used for HTTP 
download.



If no connection is established, ARGUS 
automatically connects at this point using 
the default profile (see page 50).










<Edit> A virtual line is added to the 
service Data.

<Info> Duration of activation.
<Test> Opens test selection.
<Stop> Deactivates the service.


e.g. select HTTP download

<Profile> Displays the available 
HTTP download profiles.

Continued on 
next page
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Mark the server profile: 
(default is indicated with ).

The server profiles are also used for FTP 
download and FTP upload.








HTTP download starts automatically.

Display during HTTP download: 

<Edit> Edits the marked profile,
see page 134 for changes to 
the individual settings.

- Current download/total number of 
downloads, in this example the first 
download attempt out of three (1/3) is 
displayed.

- Data already transferred 
(in this example 6 %).

- Current net average download rate 
(in this example 72,106 Mbit/s).

- Bytes transferred so far 
(in this example 164,673 MB).

- Size of file to be downloaded 
(in this example 953,674 MB).

- Transfer time so far in h:min:s.

- Remaining transfer time in h:min:s.

- Number of parallel downloads.

<Test 
status>

Displays test status without 
ending the test or starting a new 
test, see page 208.

Cancels test.

Initialisation

HTTP download
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s 
Display of test status:
You can observe the running test or start a 
new test here, see page 208.




Display of results:








Exits results.

Saves HTTP download result, see 
page 128.
Sends trace file to PC, see page 100

<New> Selects a new single test.
<Stop> Stops HTTP download test.

<Test 
status>

Displays test status without 
ending the test or starting a 
new test, see page 208.

<New> Starts a new HTTP download.

- Calculated average speed of all download
(in this example 72,691 Mbit/s). 

- Transferred file size 
(in this example 485,750 MB).

- Average time required for a download in 
h:min:s.

- Maximum parallel downloads.

- Configured parallel downloads.

HTTP download result

Save result?
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14.4 FTP download 

In FTP download, ARGUS downloads data in the form of a file. ARGUS displays the 
current net download rate, the usable data of the IP packets, and following conclusion of 
test the average speed (for multiple download attempts).

No meaningful evaluations are possible for download tests with a duration of less 
than 10 seconds. Therefore, the download file should be as large as possible 
(depending on the access speed). If the duration of the test is less than 10 
seconds, ARGUS does not display any data rate or time.

Protocol-independent parameters:
The opening of test parameters is described in the chapter "Configuring accesses", see 
page 31. See page 134 HTTP download for an explanation of the test parameters.

Starting FTP download (example: access mode VTU-R, already active)
Connecting the service.

The profile shown in the display 
(profile 1 in this example) is used for FTP 
download.



If no connection is established, ARGUS 
automatically connects at this point using 
the default profile (see page 50).







<Edit> A virtual line is added to the 
service Data.

<Info> Duration of activation.
<Test> Opens test selection.
<Stop> Deactivates the service.

Continued on 
next page
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Mark the server profile 
(default is indicated with ).

The server profiles are also used for 
HTTP download and FTP upload.






FTP download starts automatically.


e.g. FTP download

<Profile> Displays the available 
FTP download profiles.

<Edit> Edits the marked profile,
see page 134 for changes to 
the individual parameters.

Initialisation
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Display during FTP download: 

Display of test status:
You can observe the running test or start a 
new test here, see page 208.

- Current download/total number of 
downloads, in this example the first 
download out of three (1/3) is displayed.

- Data transferred so far 
(in this example 5 %).

- Current net average download rate 
(in this example 71,171 Mbit/s).

- Bytes transferred so far 
(in this example 199,327 MB).

- Total download file size 
(in this example 952,153 MB).

- Duration of test so far
(in h:min:s).

- Remaining transfer time.

- Number of parallel downloads.

<Test 
status>

Displays test status without 
ending the test or starting a 
new test, see page 208.

Cancels test.

<New> Selects a new single test.
<Stop> Stops FTP download test.

FTP download
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Display after end of FTP download:











Exits results.


For saving results, see IP ping page 128.
Sends trace file to PC, see page 100.

<Test 
status>

Display of test status.

<New> Starts a new FTP download.

- Calculated average speed of all down-
loads (in this example 72,655 Mbit/s).

- Transferred file size
(in this example 754,525 MB).

- Average time required for a download in 
h:min:s.

- Maximum parallel downloads.

- Configured parallel downloads.

FTP download result

Save result?
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14.5 FTP upload

In FTP upload, ARGUS sends the data of a file to a server. Among other information, 
ARGUS displays the current net upload rate, the usable data of the IP packets, and 
following conclusion of test the average net speed (for multiple download attempts).

No meaningful evaluations are possible for upload tests with a duration of less 
than 10 seconds. Therefore, the upload file should be as large as possible 
(depending on the access speed). If the duration of the test is less than 10 
seconds, ARGUS does not display any data rate or time.

Protocol-independent parameters:
The opening of test parameters is described in the chapter "Configuring accesses", see 
page 31. See page 134 HTTP download for an explanation of the test parameters.

Starting FTP upload (example: access mode VTU-R, already active)
Connecting the service.


The profile shown in the display (in this 
example profile 1) is used for FTP upload.

If no connection is established, ARGUS 
automatically connects at this point using 
the default profile (see page 50).





<Edit> A virtual line is assigned to the 
service Data.

<Info> Duration of activation.
<Test> Opens test selection.
<Stop> Deactivates the service.

Continued on 
next page
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Mark the server profile 
(default is indicated with ).


The server profiles are also used for HTTP 
download and FTP download.






FTP upload starts automatically.


e.g. FTP upload

<Profile> Displays the available FTP 
upload profiles.

<Edit> Edits the marked profile,
see page 134 for changes to 
the individual parameters.

Initialisation
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Display during FTP upload:

Display of test status:
You can observe the running test or start a 
new test here, see page 208.

- Current upload/total number of uploads, 
in this example the first upload out of 
three (1/3) is displayed.

- Data already transferred
(in this example 11 %).

- Current net upload rate
(in this example 14,899 Mbit/s).

- Bytes transferred so far
(in this example 30,344 MB).

- Overall file size
(in this example 90,367 MB).

- Current upload time in h:min:s.

- Remaining transfer time.

<Test 
status>

Displays test status without 
ending the test or starting a 
new test, see page 208.

Cancels test.

<New> Selects a new single test.
<Stop> Stops FTP upload test.

FTP upload
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Display of results










For information on saving results, see IP 
ping page 128.
Sends trace file to PC, see page 100.

<Test 
status>

Display of test status.

<New> Starts a new FTP upload test.

FTP upload result

Save result?
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14.6 FTP server

In FTP server mode, ARGUS behaves like a server for FTP requests. In this mode, 
ARGUS serves FTP download and FTP upload requests. 
These requests can be sent from a second terminal device (e.g. another ARGUS unit) via 
an xDSL or Ethernet access.
This makes it possible to test end-to-end throughput and determine the maximum possible 
data rate for this access.

In the following, the throughput test is explained using the Ethernet interface as an 
example. This example uses two ARGUS units. One serves as the FTP server while 
another requests the FTP download.

ARGUS 1 - FTP server

No settings need to be configured on the ARGUS used as the FTP server. The FTP server 
test just needs to be started on the selected interface. 

Starting FTP server (example: Ethernet, already active)

Continued on next 
page

Connecting the service.

The profile shown in the display 
(profile 1 in this example) is used for the 
FTP server.





If no connection is established, ARGUS 
automatically connects at this point using 
the default profile (see page 50). 

<Edit> A virtual line is assigned to the 
service Data.
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Initialisation





















ARGUS uses the IP address configured 
under "own IP address" as the destination 
address (server) for the second ARGUS 
unit.

<Test 
status>



ARGUS 1 now waits for an FTP request from a second terminal device (in this example the 
second) ARGUS).
The IP mode in this example is "static", the default IP netmask configuration is used.


e.g. FTP server

Displays test status without 
ending the test or starting a 
new test, see page 208.
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ARGUS 2 - FTP down/upload

In principle, you can adopt the same configuration for the ARGUS unit sending the FTP 
request (FTP download in this example) as in an FTP download test.
The netmask and IP address (IP mode: static) should match the settings on ARGUS 1.

Starting FTP download:

Connecting the service.

The profile shown in the display 
(profile 1 in this example) is used for the 
FTP server.






Continued on 
next page


If no connection is established, ARGUS 
automatically connects at this point using 
the default profile (see page 50). 



<Info>

<Test>

<Stop>

<Edit> A virtual line is assigned to the 
service Data.

Duration of activation.

Opens test selection.

Deactivates the service.
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Continued on 
next page

Test selection





<Profile>





Mark the server profile 
(default is indicated with ).






<Edit>






See page 134 HTTP download for an 
explanation of the test parameters.


e.g. FTP download

Edits FTP parameters, 
see page 134.

Edits the marked profile,
see page 134 for changes to 
the individual parameters.
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Download file name





Enter the address of ARGUS 1 in the 
server profile of ARGUS 2 as the server IP 
address, see page 148.

<Delete>

<12>AB>











In this case too the download file name is 
the size of file to be downloaded. The file 
size is specified in bytes.
Download file name: 1,000,000,000
results in a file size of: 1 GB.







No meaningful evaluations are possible for download tests with a duration of less 
than 10 seconds. Therefore, the upload file should be as large as possible 
(depending on the access speed). If the duration of the test is less than 10 
seconds, ARGUS does not display any data rate or time.







Deletes the place in front of 
the cursor.

see page 96.
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FTP download

Server profile

Initialisation













<Edit>




FTP download starts automatically.


Display during FTP download:

<Test 
status>



Edits the marked profile,
see page 134 for changes to 
the individual parameters.

- Current download/total number of 
downloads, in this example the first 
download out of three (1/3) is displayed.

- Data already transferred
(in this example 5 %).

- Current net average download rate 
(in this example 71,171 Mbit/s).

- Bytes transferred so far
(in this example 199,327 MB).

- Total download file size
(in this example 952,153 GB).

- Current upload time in h:min:s.

- Remaining transfer time.

- Number of parallel downloads.

Displays the test status without 
ending the test.

Cancels test.
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Display after end of FTP download:












Exits results display.



For saving results, see IP ping page 128.
Sends trace file to PC, see page 100.

<Test 
status>

Display of test status.

<New> Starts a new FTP download.

- Calculated average speed of all 
downloads
(in this example 72,655 Mbit/s).

- Transferred file size
(in this example 754,525 MB).

- Average time required for a download in 
h:min:s.

- Maximum parallel downloads.

- Configured parallel downloads.

Save result?

FTP download result
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15 VoIP tests

ARGUS operates as a VoIP terminal device with active acoustics, enabling voice links.  
Session Initiation Protocol (SIP) is available as a VoIP signalling protocol. Calls can be 
established both with and without registrar/proxy. ARGUS can be used to establish VoIP 
connections (DSL telephony) via xDSL and Ethernet. To assess voice quality, ARGUS 
determines and displays the MOS/R-factor and the RTP datastream.
You can configure threeVoIP "accounts" (profiles):

Protocol-independent parameters:
ARGUS in status screen.













<Edit> A virtual line is assigned to 
the service VoIP.

<Profile> See page 31 for profile 
settings.

<Start> Starts the service.

Select the profile you wish to edit. 
The selected profile appears in the 
display in blue. The default profile 
is indicated with a  in the display. 
ARGUS adopts the parameters 
from the default profiles for 
establishing the Ethernet or xDSL 
connection and conducting the 
VoIP test.

ARGUS uses the marked profile as 
the default profile and switches to 
the menu Settings.

Continued on 
next page

Services

Service VoIP
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A total of three user-defined VoIP profiles 
are available.







Edits the marked profile.






<Edit> Edits the VoIP profile.

VoIP account

Edit the marked 
parameters.
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Setting Description

VoIP account settings:

VoIP: You can create a total of three VoIP profiles.
<Edit> Activates the profile you wish to edit.

SIP User name User name for registrar, see page 96 for instructions.

Password Password for the registrar, see page 96 for instructions.

Authentication Additional xTU-R password for legitimate authentica-
tion.
See page 96 for instructions

Caller ID Optional entry of a user-definable text which then 
appears in the display of the called party in place of the 
caller's originating number.
See page 96 for information on using the softkeys.

Registrar
Server

Use registrar: select yes or no
If an internet telephony service provider (ITSP) is used 
(in this case you dial a normal telephone number), a 
registrar must be used as well. If a VoIP telephone is 
dialled directly, e.g. via the IP address or SIP URL, no 
registrar is needed. You can edit and use an IPv4 or 
IPv6 address as well as a name for the registrar server. 
The address is edited in the same way as for the IP 
ping test, see page 124.
Default: no

Outbound proxy/
SBC

Use proxy  (SBC = session border controller)
Determines whether an outbound proxy is to be used. 
Default: no

Outbound proxy/SBC: address of proxy server. The out-
bound proxy/SBC is configured in the same way as for 
the IP ping test, see page 124.

Outbound proxy/SBC port: port of proxy server.
Range: 0 to 65535
Default: 5060
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SIP trunking Use trunking SIP trunk makes it possible to manage 
multiple different numbers, each with its 
own extensions, using a single access 
account.
Default: no

CLIR The setting CLIR (calling line 
identification restriction) can be used to 
suppress the originating caller ID.
Default: no

Own basic 
number 

The trunk number is a telephone 
number with no extension.
Default: 4923519070 

Own exten-
sion (DDI)

DDI enables the desired access to be 
dialled directly. You can edit the 
extension using <Edit> (up to 4 
characters).
Default: 0 

SIP domain Configuration of the domain name for the "from" field in 
the SIP message (when using an ITSP). 

Listen port Port used for incoming SIP signalling. 
Range: 0 to 65535 
Default: 5060

Remote port Port used at the remote station: 
When a registrar is used (see "registrar server" setting 
on page 156), entry of the port number of the registrar/
proxy server, otherwise entry of the port number at the 
remote station. Range: 0 to 65535 
Default: 5060

User agent ID string/terminal device type is transmitted to the 
called party.
Default: Argus155

Qualify Determines whether the availability of the proxy service 
is to be continuously verified. 
Default: no

Reg. expire Determines the period of validity of registration with the 
registrar. 
Range: 10 - 6000 seconds
Default: 3600 seconds
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Retry-after Following a failed registration, the standard calls for a 
100 second delay before attempting to register again 
(standard). When "ignore" is set, registration is 
repeated in increasing intervals (1 second several 
times, then 2 s, 4s, etc.).
Default: standard

Delete exist. 
registrar

The current registration is cancelled at the registrar. If 
this is set to "yes", exclusive registration of ARGUS at 
the registrar server. Otherwise inclusion in the list of 
existing registration. 
Default: yes

Phone

settings

RTP port range SIP signalling and RTP data are transmitted via differ-
ent ports. The port range used can be adjusted for RTP, 
e.g. to match a router. 
Range: 0 to 65535
Default: 
Start: 10000 
End: 20000 

Silence
detection

When this setting is "on", ARGUS does not transmit 
voice packets during pauses in speech. However, this 
can cause problems in port assignment behind a NAT 
router. When the setting "not used" is selected, the
feature "silence detection" is not communicated to the 
remote station. However, it remains set.
Default: off

Jitter buffer Determines whether the size of the jitter buffer is static 
or adaptive. Default: static

static: Entry of a static jitter buffer size.
Range: 20 to 200 ms
nominal: 60 ms

adaptive: Entry of the minimum (min) and 
maximum (max) jitter buffer size and the 
initial value (init). 
Range: 20 to 600 ms
Default:
min: 60 ms 
init: 60 ms 
max: 120 ms
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Phone 

settings

(continued)

Codecs Prepares a list of the speech codecs to be used. For 
multiple codecs, the order determines the priority.

Switches to softkey assignment.

<> The selected codec is moved down one 
place in the list.

<> The selected codec is moved up one 
place in the list.

<Insert> A display with the available voice 
codecs opens. A voice codec marked 

with  in this selection menu is 

inserted in the voice codec list (via the 
voice codec marked in the list).

<Delete> Deletes the marked codec from the list.

Adopts the codec priorities.

Supported 
Codecs

G.729 A/B, G.726-40, G.726-32, 
G.726-24, G.726-16, G.722, G.711 A law, 
G.711 μ law, G.723.1

DTMF
settings

Dual-tone multi-frequency (DTMF) is a multifrequency 
dialling method.
Mode: Sets DTMF mode
You can choose between "Automatic", "SIP info", "RFC 
2833" and "Inband".
Default: Automatic
Duration: Sets the VoIP DTMF timer
Range: 40 to 1000 ms.
Up to 200 ms in steps of 10, up to 300 ms in steps of 
20, up to 1000 ms in steps of 100. 
Default: 80 ms

  Increases or decreases the VoIP DTMF duration.
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STUN server Use
STUN

Use STUN: select yes or no
If a NAT router is located between ARGUS and the 
nearest remote station (gateway), STUN must be used 
so that ARGUS can determine under which IP address 
the remote station sees ARGUS. Default: no

STUN server STUN server: address of a STUN server, which must be 
in the same network (on the same level) as the remote 
station.

Rated/tre-

shold value

MOS rates value Entry of MOS setting:
The mean opinion score (MOS) assesses the quality of 
voice data. The MOS quality scale ranges from 5 
(excellent) to 1 (bad). On the basis of the set MOS 
value, ARGUS rates the current VoIP voice link as "OK" 
(current MOS value achieves MOS setting) or "FAIL".
Range: 1.0 to 5.0
Default: 4.0

The MOS value here is stated as MOSCQE 
(conversational quality estimated). The use of a specific 
codec has a significant influence on this.

Jitter treshold Determines the treshold for the jitter.
Range: 0 to 200 ms
Default: * (off)

RTP loss 
treshold

Determines the treshold for the RTP loss treshold.
Range: 0 to 100 %
Default: * (off)

Profile 

name

Enter/modify name of edited VoIP profile.

value 5 4 3 2 1

Voice quality excellent good fair poor bad
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VoIP QoS (Quality of Service)

Layer 3 

DiffServ

Differentiated services: Classification/prioritisation of IP packets (L3)

RTP 

(ToS/DSCP)

ToS Type of service
Field for setting the priority in the IP header of the usa-
ble data (RTP), see page 125 for further details.
Range: 0 to 0xFF
Default: 18

DSCP Differentiated services codepoint
Field for setting the priority in the DS field (6 bits) of the 
usable data (RTP), see page 125 for further details.
Range: 0 to 0x3F
Default: 00

SIP 

(ToS/DSCP)

ToS Type of service
Field for setting the priority in the IP header of SIP data 
(signalling), see page 125 for further details.
Range: 0 to 0xFF
Default: 18

DCSP Differentiated services codepoint
Field for setting the priority in the DS field (6 bits) of the 
SIP data (signalling), see page 125 for further details.
Range: 0 to 0x3F
Default: 00

Layer 2 

VLAN Prio

The VLAN prioritisation on layer 2 is an extension of the Ethernet header.

RTP VLAN 

Prio

VLAN prioritisation of usable data (RTP)
Range: 0 to 7
Default: 0

SIP VLAN 

Prio

VLAN prioritisation of SIP data (signalling)
Range: 0 to 7
Default: 0
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15.1 Starting VoIP telephony

(Example: VDSL access, already active)
Connecting the service.


The profile selected for xDSL connection 
(in this example profile 1) is also used for 
VoIP telephony.




If no xDSL or Ethernet connection is 
established, ARGUS automatically 
connects at this point using the default 
profile (see page 50).















<Edit> Edits the default virtual line 
profile.

<Info> Duration of activation, seee 
page 167.

<Test> Opens test selection.
<Stop> Deactivates the service.


e.g. select VoIP call

Continued on 
next page
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Mark the VoIP destination
(default is indicated with ).

Scroll down with the cursor, mark a blank 
line and add a new VoIP destination using 
<Edit>.




Connecting

ARGUS displays "own number" (from:  
7087) and the number of the called 
subscriber (to: 87). The called subscriber 
has not yet accepted the call: display 
shows "Connecting!" and yellow CALL 
symbol.




The called subscriber has taken the call 
("Connected!"): ARGUS determines the 
MOS value and displays whether the set 
MOS voice quality value (see page 160) is 
reached ("OK" or "FAIL"). ARGUS also 
displays the classification of the MOS 
value according to ITU-T P.800 (in this 
example "good"), the duration of the 
connection and the currently used voice 
codec (in this example G.711 A law, see 
page 159) are also displayed.

<Edit> Edits the VoIP destination 
number.

<Detail> Displays the VoIP parameters.
<Test 
status>

Displays test status without 
ending the test or starting a new 
test, see page 208.

<Volume> Opens volume control.
Continued on 
next page

Initialisation

Continued on next page, 
second screenshot
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Volume control settings:






VoIP overview display (for transmitted and 
received packets including assessment) 




<External> Headset mode
<Internal> Earpiece mode
<OK> Adopts settings

-
-
-
-
-

Status of MOS value (FAR-MOS/MOS)
Jitter in ms 
RTP loss rate 
VLAN (prio) in hexadecimal 
TOS (hex) in hexadecimal

Displays MOS information:

-
-
-
-

-

Current MOS
Average MOS
Min./max. MOS value
Ideal MOS (possible MOS without 
interference, codec-dependent)
Current and average 
R-factor according to ITU-T G.107

Back to previous display.

<Detail>

Continued on 
next page
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Display of further VoIP results:

RTCP content
Displays the statistics returned by the 
remote station.
- Current jitter of remote station Rx (far)
- Average jitter at remote station
- Maximum and minimum jitter of
  remote station
- Lost RTP packets at remote station
   Rx (far): total, current, average, min. 
   and max.
- Delay calculated from transmission time 
  of RTCP packets (network delay): 
  current, average, min., max.

ARGUS displays the available codecs of 
the remote station.

Packet statistics:

-
-
-


-




-

Received packets (Rx)
Transmitted packets (Tx)
Error counter:
RTP drop
RTP error
RTP jitter Rx:
Current jitter
Average jitter
Minimum jitter
Maximum jitter
Lost RTP packets (Rx) 
Total, current, average, min. and max.

Back to display "Outgoing call"

If the message "no data" appears, 
that means that the remote station 
does not support RTCP.

Continue to display "Outgoing call"

<MOS> Back to display "MOS info", ring 
navigation

Return to status screen without 
ending the test.Continued on 

next page
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VoIP overview display (for transmitted and 
received packets including assessment) 

VoIP overview display (for transmitted and 
received packets including assessment) 

Back to the status screen without 
stopping the test.

ARGUS in status screen. 
Another test is still running using the 
service VoIP (indicated by the green 
hammer symbol).


-
-
-
-
-

Status of MOS value (FAR-MOS/MOS)
Jitter in ms 
RTP loss rate 
VLAN (prio) in hexadecimal 
TOS (hex) in hexadecimal

-
-
-
-
-

VLAN ID
VLAN prio RIP
VLAN prio SIP
RTP TOS in hexadecimal 
RTP TOS in hexadecimal


Using the cursor keys, select the 
service VoIP.

Continued on 
next page
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ARGUS displays the duration of the active 
VoIP service, the protocol used and the 
user name.








Before, during and after the connection, 
ARGUS displays the registration details. 
The setting "Use register" must be set to 
"yes".






<Test> Displays the overview of 
results.

<Info> or

 

Displays the VoIP calling 
parameters.

<SIP> Display of registration details: 
status codes, registrar IP, 
registrar used, outbound proxy/
SBC and URI used and more.

<Log.> Displays the VoIP service SIP 
commands, see page 168.

Continued on 
next page
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ARGUS displays the SIP commands in 
the service VoIP.

For more information ((s. chapter I) VoIP 
SIP status codes page 383).























ARGUS can be called while the service 
VoIP is active. An incoming call is 
indicated by the yellow CALL symbol. The 
call can be accepted or refused.
For automatic call acceptance, you need 
to start the specific test "VoIP wait", see 
page 172.


<Time> Puts a timestamp on all events.

The timestamp uses the ARGUS-
internal system time, see page 350.

<Reject> Refuses the call.
Switches to status screen.

<Accept> Accepts the call.
Switches to ARGUS status.

Incoming call:
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Display /description
SIP log Log showing the exchanged SIP methods

and status codes.
Register status In the "Register status" result screen, ARGUS 

displays all important registration and registrar 
information.

Overview of VoIP results

During/after registration:

During call/connection:

Display/ Description
MOS value, voice codec Current MOS value, currently used voice codec.
SIP log: Log showing the exchanged SIP methods and status 

codes.
INFO: MOS results: Threshold: indicates whether the preconfigured 

MOS threshold is complied with.
P.800: Evaluation according to ITU-T P.800
MOS value: current/average/min./max.
R-factor: current/average/min./max.

INFO: RTP results RTP packets: received/sent
RTP drop: received packets rejected by the jitter 
buffer.
RTP error: received but defective RTP packets.
RTP jitter Rx:current/average/min./max. 
(Calculated according to RFC 3550 per sec.)
RTP packet loss Rx:current/average/minimum/
maximum in percent
RTP packet loss total:
(RTP packets not received)

INFO: RTCP results:
 

IP jitter remote side: current/average/mini-
mum/maximum

(The contents of the RTCP pack-
ets are displayed, provided this is 
supported by the remote side!)

RTP packet loss remote side: current/average/
minimum/maximum in percent
RTP packet loss remote side Total

Network delay:current/average/maximum/mini-
mum (calculated on the basis or RTCP packets)
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15.1.1 VoIP back-to-back

ARGUS permits a VoIP call to a second terminal device, e.g. another ARGUS unit. To 
enable calling, both ARGUS instruments must be configured as follows:

Now enter the IP address of ARGUS 2 in ARGUS 1 as the target telephone number to 
initiate a VoIP call. The IP address of ARGUS 1 must be entered as the target telephone 
number in ARGUS 2. The call is connected just as for VoIP-call/VoIP-wait, see page 162.

ARGUS 1 ARGUS 2

Access, s. page 23 Ethernet IP based

Protocol, s. page 94 IP

IP version, s. page 97 IPv4

IP mode, s. page 97 Static

Own IP address, s. page 97 In example 10.0.0.1 In example 10.0.0.2

ARGUS 1 ARGUS 2
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15.2 VoIP wait

In the test "VoIP wait", ARGUS behaves like a VoIP telephone.
The VoIP call (see page 156) and the VoIP wait parameters must be configured for the 
VoIP wait test.

Continued on 
next page

Connecting the service.


The profile selected for xDSL connection 
(in this example profile 1) is also used for 
VoIP wait.




<Edit>



If no xDSL or Ethernet connection is 
established, ARGUS automatically 
connects at this point using the default 
profile (see page 50).
















<Setting>

Edits the default virtual line 
profile.

Opens call acceptance mode 
for VoIP wait.
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The test VoIP wait offers the following 
configuration options:

 - Automatic
 - Echo test
Default: Automatic


Start VoIP wait

Continued on 
next page

Initialisation

The service VoIP and the VDSL
access are active.

















ARGUS uses the user name 
entered under SIP parameters 
(see page 156) as its own 
number.


Select VoIP wait
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ARGUS waits for a VoIP call.










<Test 
status>




ARGUS accepts the call automatically 
(see setting page 172).


The connection parameters are the same 
as for VoIP call and are explained on 
page 163 and following.








Connecting: 

The connection is established as for IP ping. However, pressing "Cancel" initially 
only disconnects (if a connection existed). ARGUS remains registered with the 
registrar (service VoIP active) and remains available for the caller (an incoming 
call can be refused or accepted). Deactivate the service VoIP to terminate regis-
tration. However, the established access remains active.

Switches to test status, see 
page 163.
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16 IPTV tests 

16.1 IPTV

ARGUS requests a datastream from a server (depending on the access type, ARGUS 
replaces the set-top box ( STB) or modem plus STB) and checks the regularity of the 
incoming packets, packet loss and the switch-on/switch-over time of the program. You can 
configure three user-defined IPTV profiles (where the xDSL or Ethernet connection is 
already established, the connection parameters, e.g. the target value, are locked):

Protocol-independent parameters
ARGUS in status screen.

The IPTV-STB emulation is realised using 
the service IPTV. 
The following example illustrates the 
procedure and its special features.







<Edit> Assign virtual lines to the 
service IPTV. 

<Profile> See page 31 for profile 
settings.

<Start> Starts the service.

Select the profile you wish to edit. 
The selected profile appears in the 
display in blue. The default profile 
is indicated with a  in the display. 
ARGUS adopts the parameters 
from the preset profiles for 
establishing the Ethernet or xDSL 
connection and conducting the 
IPTV test.

ARGUS uses the marked profile as 
the preset profile and switches to 
the menu Settings.

Continued on 
next page

Test parameters

IPTV
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A total of three user-defined IPTV profiles 
are available.











Edits the marked IPTV profile.















Setting Description

Test parameters:

IPTV: You can create a total of three IPTV profiles.
<Edit> Activates the profile you wish to edit.

Channel 
selection

The channel list can be used and edited in all profiles. You can store 
up to 250 channels. Using the software WINplus/WINanalyse you 
can also create a configuration conveniently using the PC and load it 
to ARGUS.
Selecting the TV channels for the IPTV test.
<Edit> Edits channel

Multicast IP Specifies the multicast IP.
Range: Range 0.0.0.0. to 255.255.255.255
Default: 224.0.0.0

Edits and modifies 
the marked 
parameters
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Port Specification of port.
Range: 0 to 65535
Default: 0

TV station Enters a TV station name for the IPTV channel.

IGMP version Version of the management protocol for joining/quitting a multicast 
group.
Range: 2 to 3
Default: 3

Tresholds Establishes the limit values for the IPTV test. 
When these values are exceeded during the IPTV test, the display 
shows the test result "FAIL", otherwise "OK".
Specifying "*" deactivates the respective limit value check.

IGMP latency Sets the limit values for the latency (switch-on delay of the program).
Range: 0 to 25,000 ms
Default: 500 ms

Sync error Establishes the limit values for the sync error.
Range: 0 to 10,000 
Default: 0

PCR jitter Establishes the limit values for PCR jitter.
0 to 2000 ms
Default: 100 ms

Error 
indication

Establishes the limit values for error indication.
Range: 0 to 10,000
Default: 0

CC error Establishes the limit values for CC errors.
Range: 0 to 10,000
Default: 0

CC error rate Establishes the limit values for the CC error rate.
Range: 0.00 % to 100.00 %
Default: 0.00 %

Audio bytes Sets the target value for audio bytes. When the measurement falls 
below this threshold during the IPTV test, the display shows the test 
result "FAIL", otherwise "OK".
Range: 0 to 6,553,600
Default: 0
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Video bytes Sets the target value for video bytes. When the measurement falls 
below this threshold during the IPTV test, the display shows the test 
result "FAIL", otherwise "OK".
Range: 0 to 6,553,600
Default: 0

RTP jitter Establishes the limit values for RTP jitter.
Range: 0 to 2000 ms
Default: 100 ms

RTP sequence 

errors

Establishes the limit values for sequence errors.
Range: 0 to 10,000
Default: 0

Current RTP
loss rate

Establishes the limit values for the current RTP loss rate.
Range: 0.00 % to 100.00 %
Default: 0.00 %

Total RTP
loss rate

Sets the limit values for the RTP loss rate for the entire test.
Range: 0.00 % to 100.00 %
Default: 5.00 %

Profile name Enters a name for the IPTV profile.
See page 25 for details.
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16.1.1 Multiple virtual lines

ARGUS can use up to 4 virtual lines for the service IPTV. The IGMP virtual lines are used 
for transmission of the IGMP protocol and virtual lines 1-3 for receiving the video/audio 
streams.

Overview: selected virtual line profiles 

Adds selected VL profile for the service 
IPTV.

<Edit> Edits the selected virt. profile 
(in this example virt. profile 2), 
see page 90.

<More VLs> Opens virtual line selection for 
the service IPTV.

<Insert> Inserts further virtual profiles.
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Switches to softkey assignment.


<Delete> Deletes the selected virt. profile 
(in this example profile 3) from 
the selection list.

<Insert> Inserts a further virtual profile.
<Edit> Deletes the selected virt. profile 

(in this example profile 3), see 
page 90.

<> The marked profile is moved down 
one place in the list.

<> The marked profile is moved up one 
place in the list.
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Starting IPTV

Connecting the service.

The profile selected for xDSL connection 
(in this example profile 1) is also used for 
IPTV.




Activating the service IPTV.




If no xDSL connection is established, 
ARGUS automatically connects at this 
point using the default profile (see 
page 50).
















<Edit> Assigns a virtual line is assigned 
to the service IPTV or edits it.

<Info> Duration of activation.
<Test> Opens test selection.
<Stop> Deactivates the service.

<Profile> Displays the IPTV profiles, see 
page 175.

Continued on 
next page
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g 
e 

Marks the IPTV profile 
(default is indicated with ).









The IPTV test starts automatically.








During the test, ARGUS displays the 
selected IPTV channel, the duration of the 
test and the current bitrate. If the set limits 
are exceeded, the IPTV test shows "FAIL" 
in the display, otherwise "OK".
ARGUS displays "FAIL" until the values 
fall below the threshold again.

<Edit> Edits the marked profile, see 
page 175 for changes to the 
individual parameters.

<Channel> Selects a new channel.
<Test 
status>

Displays test status without endin
the test or starting a new test, se
page 208.

<Total> Displays all IPTV statistics.

Cancels test.

Initialisation

IPTV test

Continued on 
next page
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Display:









Display (MDI according to  RFC 4445):




Display:

- Current bitrate
- Number of packets lost during the test
- Display of packet loss rate in percent

<Detail> Switches to the IPTV details.

- Displays the current delay factor in ms
- Displays the minimum delay factor in ms
- Displays the maximum delay factor in ms
- Displays the average delay factor in ms
- Displays the media loss rate (MLR) in 

percent

- Duration of test
- Displays the name of the selected 

broadcaster
- Display of broadcaster's IP address
- Display of broadcaster's port
- Display of IGMP latency (switch-on time 

of program) in ms

<RTP/UDP> Switches to RTP/UDP details, 
see page 183.

Continued on 
next page
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Display








Display:





Display:

- Display the IGMP latency 
- Display the selected IPTV protocol
- Display of DSL-CRC error counter (not 

for Ethernet), see page 62

- Display of current packet losses
- Display of minimum packet losses
- Display of maximum packet losses
- Display of average packet losses
- Number of packets lost during the test

<MPEG2> Switches to MPEG2 details, see 
page 184.

- Display of current packet loss rate
- Display of minimum packet loss rate
- Display of maximum packet loss rate
- Display of average packet loss rate

Continued on 
next page
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Display:









Display:

Display:



- Display of RTP errors
- Display of RTP sequence errors
- Display of DSL CRC error (n/f)

- Display of current MPEG bitrate 
- Display of minimum MPEG bitrate
- Display of maximum MPEG bitrate
- Display of average MPEG bitrate

<PID> Switches to PID details, see 
page 186.

<Info> Switches to IPTV info, see 
page 182.

- Display of current MPEG packets
- Display of minimum MPEG packets
- Display of maximum MPEG packets
- Display of average MPEG packets
- Display of total MPEG packets

Continued on 
next page
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Display:








Display:

The PCR jitter describes the variation of 
the deviation between the internal clock 
and the time stamps contained in the 
MPEG transport stream (PCR) and is 
used to maintain the correct playing 
speed. 



Display:

- Display of current bytes
- Display of minimum bytes
- Display of maximum bytes
- Display of average bytes
- Display of total bytes

- Current PCR jitter in ms 
- Minimum PCR jitter in ms 
- Maximum PCR jitter in ms
- Average PCR jitter in ms

- Number of current CC errors
- Number of minimum CC errors
- Number of maximum CC errors
- Number of average CC errors
- Sum of CC errors
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Display:


The CC error rate is the CC loss rate 
across all PIDs, i.e. the CC errors of all 
PIDs are summed and displayed as the 
error rate. 




Display:













Display of codecs and PIDs
Packet identifiers (PIDs) identify the audio, 
video and PCR components of each 
program.

- Number of current CC error rate
- Number of maximum CC error rate

- Display of error sync
- Display of error indication
- Display of DSL CRC error (n/f)

<Previous> Switches to previous 
overview.

<Next> Switches to next overview.

3x
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Display:

<Channel> Selects a new channel.
<Test 
status>

Displays test status without 
ending the test or starting a new 
test, see page 208.

Cancels test.

Toggles softkey assignment.

<Channel> Selects a new channel.

The IPTV test runs until a new 
channel is selected. 

<Test 
status>

Displays test status without 
ending the test or starting a 
new test, see page 208.

<OK/FAIL> OK/FAIL overview of the IPTV 
test.

- Current loss rate in %
- Total loss rate in %
- Sequence errors
- Latency (in ms)
- Audio bytes (in Byte)
- Video bytes (in Byte)
- Sync error
- Error indication
- PCR jitter (in ms)
- CC error
- CC error rate (in %)
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Stop IPTV test.

Displays how many packets were lost 
during the IPTV test and how high the loss 
rate is. 
Display of further information: 

Exits results.

For saving results, see IP ping on 
page 129.
Sends trace file to PC, see page 100.

- Minimum delay factor
- Maximum delay factor
- Average delay factor
- Media loss rate (MLR) during the test

<Detail> Displays IPTV test detail 
information, see page 182 
and following.

Stop IPTV

IPTV result

Save result?
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16.2 IPTV scan

ARGUS checks the availability of TV channels. Additionally, ARGUS displays the 
switchover time between TV channels.
You can create three user-defined scan profiles. The following settings must be saved in 
the profile for the IPTV scan (when the xDSL or Ethernet connection is already established, 
the connection parameters, e.g. target value, are locked):

Protocol-independent parameters:
ARGUS in status screen.












<Edit> Assign virtual lines to the 
service IPTV.

<Profile> See page 31 for profile 
settings.

<Start> Starts the service.

Select the profile you wish to edit. 
The selected profile appears in the 
display in blue. The default profile 
is indicated with a  in the display. 
ARGUS adopts the parameters 
from the default profiles for 
establishing the Ethernet or xDSL 
connection and conducting the 
IPTV scan.

ARGUS uses the marked profile as 
the default profile and switches to 
the menu Settings.

Continued on 
next page

Test parameters

IPTV scan
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A total of three user-defined scan profiles 
are available.









Edits the scan marked profile.





















Edits and modifies the marked 
parameters
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IPTV scan settings

Setting Description

Test parameters:

IPTV scan You can create a total of three scan profiles. 
<Edit>Activates the profile you wish to edit.

Channel selec-

tion

The channels list can be used and edited in all profiles. You can store 
up to 250 channels. Using the software WINplus/WINanalyse you can 
also create a configuration conveniently using the PC and load it to 
ARGUS. 
Selecting the TV channels for the IPTV scan:

ARGUS initially displays the TV channels 
already selected in the set order that was 
tested for the IPTV scan. If no channels 
have been selected yet, the list is empty. 
The list slots can be filled one after 
another. You can select up to 250 
channels. 
<Insert> Opens the list with the
                available channels.





<Edit>

Marks the channel
Channels already selected 
do not appear in the 
channel list (see channel 
selection display).

Edits the marked channel, 
see page 175 and following.
- Enter (multicast IP and
  port number) of TV
  channel.
- Enter any alias name for
  the TV channel (e.g. 
  name of broadcaster). 

Continued on 
next page
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Add the marked TV channel (in this 
example IPTV channel 4), then add the 
next channel (in this example IPTV 
channel 5).
Once at least two channels have been 
added to the list, you can change their 
position in the list using the following 
softkeys.

<Delete> Deletes the marked TV 
channel from the list.

<Insert> Opens the channel list with 
the available channels.



Toggles softkey assignment.

<> The selected channel is 
moved down one place in 
the list.

<> The selected channel is 
moved up one place in the 
list.

IGMP version Version of the management protocol for joining/quitting a multicast 
group (for broadcast TV only).
Range: 2 to 3
Default: 3

Continued on 
next page

Accepts the channel 
selection in the order shown.
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Max. switch-

over time

Entry of max. switchover time (IPTV timeout):
This is the time between the request and receipt of an IPTV channel. 
If the measured timeout exceeds the value set here, ARGUS rates 
this test as "FAIL". 
Range: 1 - 25 seconds
Default: 5 seconds

Profile name Entry of a name for the IPTV scan profile, see page 25 for details.
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Starting the IPTV scan

Connecting the service.


The profile selected for xDSL connection 
(in this example profile 1) is also used for 
IPTV.



Activating the service IPTV.




If no xDSL connection is established, 
ARGUS automatically connects at this 
point using the default profile (see 
page 50).













<Edit> Assigns a virtual line to the 
service IPTV or edits it.

<Info> Duration of activation.
<Test> Opens test selection.
<Stop> Deactivates the service.

<Profile> Displays the IPTV scan 
profiles, see page 190.

Initialisation
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The IPTV scan starts automatically.

Displays the time needed to switch 
between channels. If a TV channel cannot 
be received within the set interval, 
ARGUS displays "FAIL".




Exits results display.





For saving results, see IP ping on 
page 129.
Sends trace file to PC, see page 100.




<Test 
status>

Displays test status without 
ending the test or starting a new 
test, see page 208.

IPTV scan

Save result?
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16.3 IPTV passive

ARGUS listens for transmitted TV channels without requesting a channel. ARGUS lists the 
TV channels it detects in a list of multicast IPs and/or channel names.


A second ARGUS in STB mode can be connected in place of a PC or STB.

See page 174 and following for protocol-independent parameters and test 
parameters for IPTV passive.










Patch cablexDSL line

Socket LANSocket Line

Ethernet xDSL 

  xDSL
access

PC with VLC
(video LAN 
client)

Set-top box 
(STB)

alternatively

Passive 

Passive 

Active 

Ethernet 
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Starting IPTV passive
Connecting the service.

The profile selected for xDSL connection 
(in this example profile 1) is also used for 
IPTV passive.








Router mode is started.












The service IPTV and the router mode are 
active and the VDSL access is 
synchronous.

IPTV passive can also be run in 
bridge mode. However, the bridge 
must be activated first.

<Info> The duration of router activity 
is displayed.

<Stop> Stops router mode.

To access the softkey <Test> in 
bridge mode, switch to the bridge 
box and activate it. 
The services are not available in 
bridge mode.

Continued on 
next page

Select the service IPTV 
using the cursor and 
activate it.

Select the router using 
the cursor and start the 
test.
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Marks the IPTV profile 
(default is indicated with ).








ARGUS automatically checks whether 
IPTV streams are available and displays 
these.


In this example, one possible stream is 
displayed.

<Profile> Displays the IPTV passive 
settings, see page 175.

<Edit> Edits the marked profile,
see page 175 for changes to 
the individual parameters.

<Refresh> Updates the channel list.
<Test 
status>

Displays test status without 
ending the test or starting a 
new test, see page 208.

<IP> Displays the multicast IP of the 
selected channel.

Initialisation

Continued on 
next page

InitialisationInitialisation

Waiting for stream
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st, 
During the test, ARGUS displays the 
selected IPTV channel, the duration of the 
test and the current bitrate. If the set limits 
are exceeded, the IPTV test shows "FAIL" 
in the display, otherwise "OK". 
ARGUS displays "FAIL" until the values 
fall below the threshold again.


The IPTV result statistics are explained starting on page 182.



<New> Starts a new IPTV test or selects 
another available channel, see 
page 198.

<Test 
status>

Displays test status without ending
the test or starting a new test, see
page 208.

Toggles softkey assignment.

<OK/FAIL> OK/FAIL overview of the IPTV te
see page 187.

Cancels test.
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16.4 Video on demand (VoD)

In VoD mode, ARGUS requests a datastream from a VoD server. Depending on the access 
type, ARGUS replaces the STB or the modem and the STB. 
VoD services are often provided using RTSP, as this control protocol additionally supports 
control functions. However, ARGUS also supports the protocols FTP, HTTP and MMS 
where needed. During the test, ARGUS monitors the regularity of the incoming packets, the 
loss of packets, packet and PCR jitter and other possible errors. 
Depending on the preset limit values, ARGUS performs an OK/FAIL assessment and 
shows important metadata regarding the received VoD stream. 
You can configure three user-defined VoD profiles (where the xDSL connection is already 
established, the connection parameters, e.g. the target value, are locked): 

Protocol-independent parameters:
ARGUS in status screen.

The VoD test is performed using the 
service of that name. 
The following example illustrates the 
procedure and its special features. 


<Edit> A virtual line is assigned to 

the service VoD. 
<Profile> See page 31 for profile 

settings.
<Start> Starts the service.

Select the profile you wish to edit. 
The selected profile appears in the 
display in blue. The default profile 
is indicated with a  in the display. 
ARGUS adopts the parameters 
from the default profiles for 
establishing the Ethernet or xDSL 
connection and conducting the VoD 
test.

ARGUS uses the marked profile as 
the default profile and switches to 
the menu Settings.Continued on 

next page

Test parameters
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A total of three user-defined VoD profiles 
are available.









Edits the scan marked VoD profile.











Edits and modifies the marked 
parameters.



Setting Description

Test parameters:

VoD: You can create a total of three VoD profiles.
<Edit>Activates the profile you wish to edit.

Type of stream Select the type of stream. You can select one of the following types: 
RTSP, HTTP, FTP, MMS
Default: RTSP

Server address Enter the server address from which the stream is to be downloaded. 
Enter the address using the number keys. Toggle entry using the 
softkey (meaning of right softkey changes when pressed), see 
page 125.

Video on demand
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Port Specification of port.
Range: 0 to 65535
Default: 0

File name Name of the file to be downloaded from the server, see page 125 for 
information on using the softkeys.

RTSP type Type of control protocol: TCP or UDP.
Default: TCP

RTSP server 

type

If the remote station is a standard-compliant VoD server, always set 
the field "RTSP server type" to "standard". If the remote station uses 
proprietary features, you can use a different setting (e.g. Kasenna).
Default: Standard

Jitter buffer Size of jitter buffer. Ideally, enter the value from the upstream STB.
Range: 0 to 5000 ms
Default: 300 ms

Treshold
values

Sets the limit values for PCR jitter and continuity error (assessment 
of picture quality).
When these values are exceeded during the IPTV test, the display 
shows the test result "FAIL", otherwise "OK".
PCR jitter:
- Range: 0 to 10,000 ms
- Default: 8 ms
Continuity error:
- Range: 0.0 - 100 percent.
- Default: 0.1 %

Profile name Enter a name for the VoD profile.
See page 25 for details.
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Starting VoD

Connecting the service.

The profile selected for xDSL connection 
(in this example profile 1) is also used for 
VoD.



Start the service VoD.





If no xDSL connection is established, 
ARGUS automatically connects at this 
point using the default profile (see 
page 50).
















<Edit> Assigns a virtual line to the 
service VoD or edits it.

<Info> Duration of activation.
<Test> Opens test selection.
<Stop> Deactivates the service.

<Profile> Displays the VoD profiles, see 
page 201.

Continued on 
next page
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t 

Marks the VoD profile 
(default is indicated with ).









The VoD test starts automatically.








During the test, ARGUS displays the 
current PCR jitter and the continuity 
errors. If the set limits are exceeded, the 
VoD test shows "FAIL" in the display, 
otherwise "OK".
ARGUS displays "FAIL" until the values 
fall below the threshold again.

<Edit> Edits the marked profile, see 
page 175 for changes to the 
individual parameters.

<Test 
status>

Displays test status without ending
the test or starting a new test, see
page 208.

<Info> Displays the video on demand tes
statistics.

Cancels test.

Initialisation

VoD test

Continued on 
next page
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Display:



Display:



Display:

- Displays the current error status
- Displays the current and maximum 

PCR jitter 

<UDP> Switches to UDP information, see 
page 206.

- Displays the current and maximum 
continuity error in %

- Display of container type

- Display of stream packets
- Display of stream bytes
- Display of stream cont. errors

Continued on 
next page
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Display:

Display:

Display:

- Current stream bitrate
- Average stream bitrate
- Minimum stream bitrate
- Maximum stream bitrate

- Received packets
- Maximum packet jitter
- Current packet jitter

<Stream> Switches to stream information, 
see page 207.

- Lost RTP packets
- OSS RTP packets
- Number of errored RTP packets

Continued on 
next page
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Display:

Displays the duration of the test, the result 
OK or FAIL, and the error status. 

The further test results are described 
starting on page 205.

Exits results.

For saving results, see IP ping on 
page 129.
Sends trace file to PC, see page 100.

- Video codec
- Video resolution
- Video codec name
- Audio codec
- Audio channels
- Audio sampling rate
- Audio bits/sample
- Audio bitrate
- Audio codec name
- Audio codec desc.
- Total runtime
- Author (general)
- Title
- Author (meta)
- Copyright

Stop VoD test

VoD result

Save result?
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17 Parallel tests

ARGUS permits parallel testing of different IP-based services (Data, VoIP, IPTV and VoD) 
running on xDSL or Ethernet interfaces.
The settings for each test are described in the respective chapters. 

The following tests can be run in parallel. Any combination of the tests listed here is 
possible.

Service Test Remark

Data

IP ping*1, see page 124

For theses tests, up to 10 tests can be 
conducted concurrently (incl. tests 
using the other services). 

Traceroute*1, see page 130

HTTP download, see page 134

FTP download, see page 141

FTP upload, see page 143

FTP server, see page 147 See remark for VoIP.

VoIP

VoIP call, see page 154 These tests can be combined with 
any other test. Note that only one 
VoIP test can be active at any time.VoIP wait, page 172.

VoIP PESQ test, see page 294

IPTV

IPTV, see page 174 These tests can be combined with 
any other test. Note that only one 
IPTV test can be active at any time.IPTV scan, see page 189

IPTV passive, see page 196

VoD VoD, see page 200 See remark for IPTV

*1 Also possible via the services VoIP, IPTV and VoD.
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The possibility of parallel testing is illustrated using HTTP download and VoIP via the 
services Data and VoIP. Display and operation for further parallel tests, e.g. IPTV, is 
performed in the same way as for Data and VoIP.


ARGUS status screen.

The VDSL VTU-R access shown in the 
example and the services Data and VoIP 
are active.





Mark the server profile: 
(default is indicated with ).

HTTP download starts automatically.

<Info> Duration of activation

<Test> Opens test selection.

<Stop> Deactivates the service.


e.g. select HTTP download

<Profile> Displays the available HTTP 
download profiles, see 
page 134.

<Edit> Edits the marked profile,
see page 134 for changes to 
the individual settings.

Initialisation
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Display during HTTP download:

Display of test status:

- Current download/total number of 
downloads, in this example the first 
download attempt out of three (1/3) is 
displayed.

- Data transferred so far (in this example 
6 %)

- Current net average download rate (in 
this example 72,106 Mbit/s)

See page 137 for further result parameters.

Cancels test

- Currently selected test as well as test-
dependent result parameters, in this 
example the current net average 
download rate, the current progress and 
the size of the file to be transferred.
The display of results depends on the 
respective test. See the chapter on the 
individual test for more information on 
the result parameters.

- The current download in kbit/s is 
represented as a percentage of the 
entire downstream range.

- The current upload in kbit/s is 
represented as a percentage of the 
entire upstream range.

- Number of CRC and FEC errors in down- 
and upstream

 
or


Switches to the test result 
parameters, in this example for HTTP
download.

<Stop> Stops the test, in this example 
HTTP download.

HTTP download

Cursor down

Test status
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ARGUS in status screen.

Mark the VoIP destination
(default is indicated with ).

Scroll down with the cursor, mark a blank 
line and add a new VoIP destination using 
<Edit>.



Connecting

Opening test status

<Info> Duration of activation.

<Test> Opens test selection.

Switches to the test result 
parameters, in this example for of 
HTTP download.


e.g. select VoIP call

<Edit> Edits the VoIP destination 
number.

Switch to the service 
VoIP using the cursor 
keys and open test 
selection.

Initialisation
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. 
t 

P 

 

 

The called subscriber has taken the call 
("Connected!"), see page 163.

ARGUS executes an HTTP download and 
a VoIP call in parallel.

The VoIP call is stopped.

<Info> Displays the VoIP parameters.
<Volume> Opens volume control.

 When more than one test is 
executed, you can select the tests
with the left and right cursor keys
For more than three tests, the tes
row expands to the right.

<New> Selects a new single test.
<Stop> Stops the test, in this example VoI

call. Depending on the test, it can 
be reinitialised using <Start>. The
configuration remains unchanged.

<Finsih 
all>

Stops all tests.

Toggles the softkey assignment.

To start a new VoIP call test, the old
one must be cleared by pressing 

 twice.

 or Switches to the test result 
parameters, in this example from 
HTTP download.

<New> Selects a new single test.
<Stop> Stops the test.
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18 Auto tests

Concurrent tests (s. chapter 17 page 208) can also be executed automatically in an auto 
test. To to this, you can save different test scenarios in up to five auto test profiles.
The same rules as for the individual tests apply for the settings, execution and control. 

Cursor up

Continued on 
next page

ARGUS in status screen.

Physical layer, virtual line and two of the 
services are successfully activated.

ARGUS in test status

No test has been started yet.

<New>

<Auto 
test>

Selects a new individual test.

Opens auto test profiles.
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Continued on 
next page

ARGUS lets you preconfigure up to
five auto test profiles.

Define a scenario. You can configure up to 
ten individual tests (see page 208). 
The number of data tests (e.g. IP ping, 
download, ...) is limited to ten; IPTV and 
VoIP each can be selected only once (see 
page 208).

In general, at least one IP ping test is 
always preconfigured.

<Change>

<Add>

Replaces IP ping with a 
different test.

Adds a further test.
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Continued on 
next page

Cursor down

Select the desired test and confirm with

 

In addition to the IP ping test, a traceroute 
test is also started automatically 
and simultaneously via the auto test pro-
file.

 

<Delete>

The scenario is accepted and saved.

Removes the test from 
the list.
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2x

1x

Give the auto test a clear name, like 
“triple-play test” or similar.  
Use the alphanumeric keyboard.

Exit auto test setup by pressing  

twice and then start the test with . 

see page 210 for instructions.

The individual tests are 
configured as described starting 
on page 124.
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The voltages on the subscriber line may not exceed 48 VDC (BRI S/T) or 145 
VDC (BRI U) and should be free of AC voltage.

19.1 Setting the ISDN Interface and Access Mode
Use the included connection cable to connect either the ARGUS "BRI/PRI/E1" jack to the 
S-Bus access to be tested or the ARGUS "Line" jack to the U to be tested and then switch 
the ARGUS on. The ISDN settings are made in the chapter 5 Configuring accesses page 
23. In this example the ISDN TE mode was selected.

The menus, which are available for the 
type of access under test, are listed in the 
Main Menu.

 
The ARGUS will open the 
marked menu (in this example, 
Single tests).

 Select a menu.The selected 
menu will be marked blue in the 
display.

 
To return to the previous menu 
(in the example, the State 
display).

ARGUS State Display

Main Menu

ARGUS State Display, see page 220.

<Setting> Open the
"ISDN settings" menu, 
see page 222.

<Start> Repeat the B channel test.
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TE simulation
In the Access Menu (see page 218), select the desired simulation mode:

NT simulation
In the Access Menu (see page 218), select the desired simulation mode:

19.2 Initialization phase followed by a B channel Test

Initialization on a BRI S/T or U -interface access

The ARGUS will begin the initialization after taking over the existing, confirmed settings or 
new settings for the type of access and mode. Next the ARGUS will setup Layer 1. While it 
is setting up Layer 1, the "Sync/L1" LED above the display will blink. If the ARGUS cannot 
setup Layer 1, it will display the message “No net”. When the ARGUS is operated on a 
U interface access, it can take up to 2.5 minutes to activate Layer 1. As soon as Layer 1 is 
successfully setup, the "Sync/L1" LED will light continuously. 


Once Layer 2 has been setup, the "Rx/Tx/L2" LED will light.

If both modes (P-P / P-MP) are found when Layer 2 on the D channel is checked, 
the mode must be selected manually (see page 219). 

If everything has been detected without errors, the ARGUS will display the type and mode 
of access found. Additionally, a qualitative assessment of the level will be displayed.
The ARGUS will automatically determine the protocol (in both TE and NT mode) or use the 
protocol set manually (see page 223 protocol). On a bilingual access, the ARGUS will use 
the DSS1 protocol.

 - TE automatic

 On an S-Bus interface or U interface access, the ARGUS will automatically determined 
the D channel Layer 2 mode (P-P or P-MP). If the ARGUS determines that the access 
supports both modes, a configuration menu will open in which you can select the 
desired Layer 2 mode.

 - TE P-P (point-to-point) or TE P-MP (point-to-multipoint)

 Afterwards, the access and the protocol stack will be initialized in accordance with the 
selected setting.

 - NT P-P (point-to-point) or NT P-MP (point-to-multipoint)

 Afterwards, the access and the protocol stack will be initialized in accordance 
with the selected setting.
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The "IP / L3" LED will light after the ARGUS has setup Layer 3. At the same time the 
ARGUS will start a B channel test and then display the results. If an error occurs in the 
B channel test (e.g. access is not plugged-in), the ARGUS will display an error message 
(see appendix). The ARGUS will then idle in the State display:

Display:

If only one B channel is available, this can have an impact on the service check 
and the testing of the supplementary services.

- Type of access (in the example, BRI S/T)
- Access Mode
NTs 

NTm 
TEs 
TEm

NT Simulation Slave (see L1
page 223)
NT Simulation Master L1
TE Simulation Slave L1
TE Simulation Master L1

- Bus configuration
D channel Layer 2 mode
P-P
P-MP

Point-to-point
Point-to-multipoint

- D channel protocol
in the example, DSS1

- The availability of the B channels
B12
B1-
B-2
B--

Both channels are available 
Only B channel 1 is available 
Only B channel 2 is available
No B channel is available

Example:
ARGUS State Display on a BRI access
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It must be mentioned again, that the ARGUS only determines the general bus status once 
when switched on or when the ARGUS first connected. On the other hand, the status of the 
protocol stacks for Layers 1, 2 and 3 will be continually monitored and displayed.

- ARGUS State Display on a U interface
Display: 
- Access type (in the example, BRI U)
- Access mode (in the example, TEs)
- L2 protocol (in the example, DSS1)
- BRI U variant (line coding)
- Voltage when idle

- Level and voltage evaluation
OK normal
<<
>>
--
OK INV

Level/voltage is alright
Level/voltage too low
Level/voltage too high
No level/voltage
Emergency supply

<Start> Repeat the B channel test.
<Setting> Open the "ISDN settings" menu, see page 222.
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19.3 ISDN Settings

It is possible to configure the following "ISDN Parameters" as needed. The procedure for 
configuring a parameter will be illustrated with a single example: It is possible to restore the 
parameters, see page 355.



ARGUS - Main Menu.






Use the cursor keys to select, e.g. 
protocol.

Mark the desired protocol. The 
selected protocol will be marked in 
blue (in this example, Automatic). 
The default protocol will be marked 
in the display by a . The ARGUS 
will use the default protocol for the 
ISDN connection.

Open the next higher menu without 
making any changes. The ARGUS 
will continue to use the default 
setting.

Setting Explanation

ISDN:

L1 permanent? On a BRI S/T connection in NT mode, Layer 1 (L1) is permanently 
active.
Default setting: No

The ARGUS takes the marked setting 
for use as the default and returns to the 
next higher menu.

Settings

ISDN

Protocol

Automatic
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Protocol As an alternative to automatic protocol determination, you can also 
set the Layer 3 D channel protocol manually. If the protocol setting is 
changed, the ARGUS will save this new setting permanently, i. e. it 
will use this protocol the next time that it is switched on.
ISDN Protocols:
 - Automatic
 - DSS1
 - CorNet-N
 - CorNet-T (not for the access types "NT P-P" and "NT P-MP")
 - CorNet-NQ (for the access types "TE P-P" and "NT P-P" only)
 - QSIG (for the access types "TE P-P" and "NT P-P" only)
 - VN4
Default setting: Automatic

Alerting mode You can specify whether, for an incoming call on a S-Bus point-to-
point access, the ARGUS should only display the access number 
without extension or the complete number with extension. When set 
to "Manual", the ARGUS will display the extension. Incoming calls will 
be signaled. When the ARGUS accepts a call, it will send the Layer 3 
"Alert" message. The digits of the extension that have been sent by 
this point will be displayed.

With the Manual setting, an incoming call must be 
answered within 20 seconds or it will be lost. 
Furthermore, you should note that the remote subscriber 
will not hear a ringing tone.
If it is set to “Automatic”, the ARGUS will only display the 
access number without extension or, depending on the 
configuration of the access in the exchange, it may not 
display the number called at all.

Default setting: Automatic

Clock mode This parameter sets where the clock will be generated in the case of 
a S-Bus access. You can either specify that the ARGUS generates 
the clock (Master) or that it is the slave of a clock generated at the 
other end (Slave).

Setting:
In NT mode:
In TE mode:
Leased line:


Master
Slave
Slave

Any change to this setting will not be saved permanently; it will only 
apply to the current measurement.
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BRI 
termination

You can add terminating resistors to a BRI access. 

Setting:
In NT mode:
In TE mode:
Leased line:


Terminating resistor switched in 
No terminating resistor is switched in
No terminating resistor is switched in

Any change to this setting will not be saved permanently; it will only 
apply to the current measurement.

Call 
parameters

Four different parameters can be set for (ISDN) calls generated on 
both the network-side (ARGUS in NT mode) and on the user-side 
(ARGUS in TE mode):
1. Type of number (TON) for the CGN (=CGPN) or CDN (=CDPN) 
element of a SETUP signal

Network-side:    Net CGN TON 
Net CDN TON

User-side: User CGN TON 
User CDN TON

    Default setting: unknown

2. Numbering Plan for the CGN (=CGPN) or CDN (=CDPN) element 
of a SETUP signal:

Network-side: Net CGN NP 
Net CDN NP

User-side: User CGN NP 
User CDN NP

3. CGN/CDN Subaddress
    CGN/CDN Sudaddress Type: User specific and NSAP
    Default setting: User specific
4. UUI (User User Info)
*For more information, see Prefix on page 225.

Services Up to three user-specified services (user spec. 1 to user spec. 3) can 
be entered and saved. For each "user spec. service“, you must enter 
the info-elements BC, HLC and LLC in hexadecimal (switch with the 
left softkey). To do so, use the keypad and the A . . F  softkey (e.g. to 
enter a "C", press the softkey three times; for an "F", press it six 
times).
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Starting functions with the numeric keys / key combinations
Using the ARGUS keypad, you can start important functions / tests directly, regardless of 
the menu that the ARGUS is currently showing. If a function is called where the ARGUS 
expects the entry of a digit, pressing a number key will be interpreted as the expected 
input. The assignment of functions to the numeric keys can also viewed on the ARGUS 
display. Open the Main Menu and select "Help" or press number key "1". An overview of 
the available key combinations can be found on page 110.

Call 
acceptance

If the ARGUS is set to "own MSN/DDI" and is in TE mode on a P-MP 
access, it will only signal those calls which are placed to the MSN (on 
a P-P access, the DDI) of the access under test. If set to “all 
MSN/DDI”, the ARGUS signals all calls. 
Prerequisite: 
- the own number must be entered in the speed-dialling memory 
  under "own number" (see "Saving call numbers in the speed-dialling 
  memory" on page 358).
- the incoming call must have a destination MSN
Default setting: all MSN/DDI

Voice coding There are two options for coding voice data in a B channel:
- A-law (Default setting)
- µ-law

DTMF / Keypad DTMF or Keypad setting
Default setting: DTMF 

CUG Index Enter the CUG index that the ARGUS should use when testing the 
CUG (Closed User Group) service. 
Range: 0 to 32 767
Default setting: 148

Keypad A maximum of three Keypad Infos can be stored. First use the 
vertical cursor keys to select one of the three available memory 
locations for Keypad Infos. 

<Edit> Edit the selected Keypad Info. Afterwards, use the 
keypad to enter the Keypad Info. 

Save the Keypad Info.

Prefix Entry of the national or international telephone prefix. The prefix is 
selected in "Call parameters" under the selection "Type of number", 
see page 224.
National: 0 (Default setting) 
International: 00 (Default setting)

AOC Set wheter the NT simulation charging information to be transmitted.
Default setting: On
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19.4 Bit Error Rate Test

The bit error rate test (BERT = Bit Error Rate Test) is used to check the transmission quality 
of the access circuit. 


As a rule, the network operator will guarantee an average error rate of 1 x 10-7, in other 
words in long-term operation 1 bit error in 10 million transmitted bits. A higher bit error rate 
will be especially noticeable in transmitting data.

The application program detects the errors in the data blocks transmitted and requests that 
the remote partner send them again, which reduces the effective throughput of the ISDN 
connection.

In the bit error rate test, the tester establishes an ISDN connection to a remote tester 
(end-to-end) or calls itself (self call), sends a standardized (quasi-) random number string 
and compares the received data with that which was sent. The individual bit errors are 
summed and depending on the test procedure and equipment evaluated in accordance 
with the ITU Guideline G.821.

During the test, the ARGUS counts the bit errors and after the test is done it calculates the 
bit error rate and other parameters in accordance with ITU-T G.821.

As a rule, the quality of the network operator’s access circuits is quite good. Therefore, no 
bit errors should occur in a one-minute test. However, if an error occurs, the test should be 
repeated with a measurement time of 15 minutes to achieve higher statistical precision. 
The access circuit is heavily distorted, if more than 10 bit errors occur within a test period of 
15 minutes. 

Contact the network operator or the supplier of the PBX equipment and ask them to test 
your access circuit.





When used on an NGN (Next Generation Network), where a packet switched 
connection (e.g. IP) can follow a circuit switched network (e.g. ISDN), the 
"UDI64k" must be explicitly selected for the BERT. Then the ARGUS will, in 
accord with RFC 4040, switch to clear mode, deactivate the echo canceler and 
not use a codec.
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The BERT can be performed in three different ways:

BERT Parameter Configuration

ARGUS - Main Menu


The procedure for configuring a parameter 
will be illustrated with a single example. 
The default settings can be restored at any 
time (see page 355).

















1. BERT in an extended call to oneself

A remote number is not needed, since the ARGUS sets up the ISDN connection to 
itself. In this case, the ARGUS requires two B channels for the test.

2. BERT with a loopbox

A loopbox (e.g. another member of the ARGUS family of testers at the remote end) 
is required. The test uses one B channel.

3. BERT end-to-end

This test requires a waiting remote tester (e.g. a second ARGUS in the "BERT wait" 
mode)(see page 234, BERT wait). A bit pattern is sent to this remote tester.
Independent of the bit pattern received, the remote tester will use the same 
algorithm to generate the bit pattern that it sends back. Therefore, both directions 
are tested independently.

The ARGUS sets the value 
entered as the default BERT time 
and returns to the next higher 
menu.

Settings

BERT

BERT time

Enter the BERT time
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Setting Explanation

BERT:

BERT time You can use the keypad to enter measurement times ranging 
from 1 minute to 99 hours and 59 minutes (= 99:59).

If the time is set to 00:00 (= BERT with unlimited 
measurement time), the BERT will not stop 
automatically. In this case, the BERT must be 

terminated manually by pressing the .

Default setting: 00:00 (continuous)
In the case of an Autom. Test (see chapter 19.9 Automatic 
Performance of Multiple Tests, page 254) the ARGUS will 
automatically set this to a value of 1 minute.

Bit pattern 
S/T/U

This function is used to select the bit pattern to be sent cyclically 
by the ARGUS to perform a BERT on a S-Bus or U interface 
access. Several predefined bit patterns are available

Default setting: 211-1
Additionally, it is also possible to enter a 16 bit long pattern of 
your choice in binary: Use the horizontal cursor keys to move the 
cursor right or left.

<Delete> Changes the digit before the cursor from 1 to 0 

Error level This is the level used to evaluate whether the BERT had an 
"acceptable" bit error rate.
If the BERT has a bit error rate, which exceeds this error level, 
the ARGUS will display a "NO" (Not OK) as the test result. 
Using the keypad, this parameter can be set to any value from 

01 (= 10-01) to 99 (= 10-99). 

The default threshold (error level) is 10-06  (1E-06). That means 

that, in the event that the bit error rate is less than 10-06 (one 

error in 106 = 1,000,000 sent bits), the bit error rate test will be 
evaluated as "OK". 

HRX value Setting the HRX value (Hypothetical reference connection, see 
the ITU-T G.821). Using the keypad, you can enter a value 
ranging from 0 to 100 %.
Default setting: 15 %
228 ARGUS 155 



19 Operation on an ISDN Access

d

 

f 

d

BERT Start

Single tests

BERT

BERT start

Enter the phone number

Select service

Select B channel


ARGUS - Main Menu.







The speed-dialling memory will now open 
(see page 358). Enter/dial your own 
number to perform the BERT in an 
extended call to oneself (two B channels) 
Enter/dial a remote number for a BERT to 
a loopbox (one B channel) or end-to-end.

Using the cursor keys, select the service 
which should be used for the BERT.

First press <Delete> and then enter the 
B channel on the keypad. If you enter an 
"*", the ARGUS will choose any B channel 
that is free. 

BERT Start

The ARGUS display after the connection 
has been setup and synchronized in both 
the send and receive directions: 


Scroll through the speed-dialling 
memory.

- The bit pattern and B channel / bit rate use

- The synchronicity of the bit pattern 
(in this example, synchron)

- Sync. time in h:min:s 
(time in which the ARGUS can sync to the
bit pattern)

- LOS counter: shows the absolute number o
synchronization losses.
Synchronization is lost at an error rate 
greater than or equal to 20 % within a 
period of a second. 

- The number of bit errors that have occurre
ARGUS 155 229



19 Operation on an ISDN Access




If the ARGUS has been so configured and a bit error is detected, this will be signaled by a 
brief alarm; in the event that the synchronisation is lost, a constant alarm will sound (see 
page 353, Alarm tone).

After the BERT is over, the ARGUS will display the cause and the location which initiated 
the disconnect. If the test ran normally, the ARGUS will display “Active clearing” on this line.

<Error> The ARGUS will generate an artificial 
bit error, which can be used to test 
the reliability of the measurement (in 
particular for end-to-end tests).

<TM> Open the Test Manager, 
see page 270.

or
<Reset>

Restarts the BERT. The test time and 
number of bit errors will be reset.

Stop BERT
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Display of other characteristic values (in 
accordance with ITU-T G.821):

All values are given as relative values (in 
percentages) as well as in absolute 
figures. 
The ARGUS evaluates the measurement 
results to determine whether they satisfy 
the threshold limits defined in the CCITT 
G.821; with consideration of the defined 
hypothetical reference connection HRX 
(displaying OK or NO (Not OK)).


Scroll through the results

- The evaluation of the results depends on
the error threshold (in this example OK), 
see page 228.

- Trans. data (transferred data): 
(K = 1024  bits, k = 1000 bits)

- Sync. time in h:min:s 
(Time within which the ARGUS can sync
to the bit pattern)

- No. LOS (counter) 
Synchronization is lost at an error rate 
greater than or equal to 20 % within a 
period of a second. 

- LOS time: Duration of the BERT minus 
the sync. time (the time in which the 
ARGUS could not sync to the bit pattern 
after it had been in sync at least once)

- abs. err: The number of bit errors

- Rel. err: The bit error rate 
(e.g. 9.7E-07 = 9.7 · 10-7 = 0.00000097)


Scroll through the results

Return to the previous display

BERT results:
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Characteristic values (in accordance with ITU-T G.821)



HRX Defines the hypothetical reference connection.

EFS Error Free Seconds:
The number of seconds in which no error occurred.

ES Errored Seconds:
The number of seconds in which one or more errors occurred.

SES Severely Errored Seconds:

The number of seconds in which the bit error rate is greater than 10-3. In one 

second, 64,000 bits are transferred, thus BitErrorRate (BER) = 10-3 equates 
to 64 bit errors.

US Unavailable Seconds:
The number of all sequentially adjacent seconds (at least 10 sec) in which 
BER > 10-3.

AS Available Seconds: 
The number of all sequentially adjacent seconds (at least 10 sec) in which 
BER < 10-3.

DM Degraded Minutes:
The number of minutes in which the bit error rate is greater than or equal to 
10-6. In one minute, 3,840,000 bits are transferred, thus a BER = 10-6 

corresponds to 3.84 bit errors (3 errors = OK (no degraded minutes), 
4 errors = NO (Not OK) (Degraded Minutes).

LOS Loss of Synchronize:
Synchronization is lost at an error rate greater than or equal to 20% within a 
period of a second. The absolute number of synchronization losses will be 
shown.
232 ARGUS 155 



19 Operation on an ISDN Access
BERT saving
The ARGUS can store the results of several BERTs. The ARGUS saves the results 
together with the date, time and call number of the access under test (if this number has 
been entered as the "own" number in the speed-dialling memory, see page 358) in the next 
free memory location (see page 342). If all of the memory locations are used, the ARGUS 
will request permission to overwrite the oldest test results.



Use the keypad to enter the name under 
which the ARGUS should save the results, 
for more information see page 342.



BERT - saving the result







Display the saved BERT results, see page 343.

BERT start
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BERT wait
In “BERT wait” mode, the ARGUS will wait for the BERT at the remote end. This is required 
for an end-to-end test.


ARGUS - Main Menu.







Activate “BERT wait” 


The ARGUS first waits for a call and then 
sets up the connection. During the 
connection, the received bit pattern will be 
evaluated while an independent bit pattern 
will be sent back.

For information on the displays shown, see 
"BERT start" on page 228.

<TM> Opens the Test Manager (see 
page 270).

Display BERT results

Single tests

BERT

BERT wait
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B channel loop
“B channel loop” mode is required in order to run a bit error rate test using a loopbox (an 
ARGUS is the loopbox) at the remote end.

ARGUS - Main Menu.




Activate a “B channel loop”

The ARGUS will wait for a call. Any 
incoming call (regardless of the service) 
will be taken immediately. The ARGUS will 
switch a loop back in the B channel that is 
specified by the exchange and then send 
the received bit pattern back to the caller/
sender.


Display shown after accepting a call:

<TM> Open the Test Manager
(page 270).

<Menu> Open the Main Menu:
the “B channel loop” remains 
active.
From this menu, you can start a 
second B channel loop 
connection (this is also possible 
using <TM>). If you press <TM> 
(see page 270) the ARGUS will 
return to the "B channel loop, wait 
active" display. 

Exit the “B channel loop” mode.

- B channel used and service 

- The caller's number (from:) 

- The number dialled (to:)

- If available: TON, NP, UUS etc.

<TM> Opens the Test Manager (page 
270).

<Menu> Open the Main Menu.

Clear down the B channel loop 
connection; the B channel loop, 
however, remains active!

Single tests

BERT

B channel loop
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19.5 Supplementary Services Test 

The ARGUS checks whether the access under test supports supplementary services.

Suppl. service interrogation in DSS1


ARGUS Main Menu



The speed-dialling memory opens (see 
page 358).

Using the cursor keys, select the service 
which should be used for the 
supplementary services test.

Enter the B channel on the keypad. The 
ARGUS suggests the B channel used last. 
If you enter an "*", the ARGUS will choose 
any B channel that is free.

The ARGUS will determine whether the 
selected supplementary service is 
supported by this access.

Start test

Display the test results:

Scroll through to your own call 
number (the number of the access 
under test) or enter it using the 
keypad.
The ARGUS will test the availability 
of the supplementary service (in 
part by placing a call to itself). 

+
-

=
=

suppl. service supported
suppl. service not supported


Scroll through the results

Close the results display and open 
the next higher menu

Single tests

Supplementary Services

Enter own number

Select service

Select B channel

Select test case
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Test Explanation

TP The ARGUS tests the TP (Terminal Portability) supplementary service by 
making a self call.

HOLD The ARGUS tests the HOLD supplementary service by making a self call.

CLIP The ARGUS checks, one after the other, whether the 4 supplementary services 
CLIP, CLIR, COLP and COLR are supported. To do so, the ARGUS will setup 
as many as three calls to itself.

CLIP: Will the calling subscriber's number be displayed at the called 
subscriber?
t  = CLIP temporarily available
p = CLIP permanently available

CLIR: Will the display of calling subscriber's number at the called subscriber 
be suppressed or is it possible to temporarily suppress the display? 
If the ARGUS displays an *, it is not possible to determine the 
availability of the service, since no CLIP has been setup.
t  = CLIR temporarily available
p = CLIR permanently available

COLP: Will the call number of the subscriber who answered be displayed on 
the caller's phone?

COLR: Will the display of the call number of the subscriber who answered be 
suppressed on the caller's phone or is it possible to temporarily 
suppress the display? If the ARGUS displays an *, it is not possible to 
determine the availability of the service, since no COLP has been 
setup.

The suppl. services CLIP, CLIR, COLP and COLR will be tested in pairs. If 
CLIR or COLR is set up permanently, it is not possible to make a clear 
assessment.

DDI Can a caller directly dial in to an extension on the PBX access under test?

CF The ARGUS will check whether the 3 supplementary services CFU, CFB and 
CFNR are supported.

CFU: Can this access immediately forward an incoming call?

CFB: Can this access forward an incoming call when it is busy; in other 
words does it support Call Forwarding Busy?

CFNR: Can this access forward an incoming call when it is not answered?
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In the CF test, the ARGUS attempts to set up a call diversion to the call number 
that is in the speed-dialling memory location for “remote call number 1” (see 
"Saving call numbers in the Speed-dialling Memory" on page 24). When 
performing a CF test, the ARGUS will report an error if this location does not 
contain a valid call number to which it is possible to divert a call.

CW Does the access under test support call waiting?

CCBS / 
CCBS-T 

Will the access under test automatically recall a remote subscriber if the 
number called was busy?

CCNR / 
CCNR-T 

Will the access under test automatically recall a remote subscriber if the call 
was not answered?

MCID Does the access tested allow identification of malicious callers (call tracing)?

3pty Does the access under test support a three-party conference call?
For this test, you need the assistance of a remote subscriber, whose call 
number must be entered. A connection is necessary.

ECT Is an explicit call transfer supported by the access under test? 
For this test, you need the assistance of a remote subscriber, whose call 
number must be entered. A connection is necessary.

CUG The ARGUS then uses a self call to check whether the access under test 
belongs to a closed user group.

CD An incoming call will be diverted immediately. This form of call diversion differs 
from the others in that it is invoked on a call-by-call basis, and is not 
preconfigured to a specific destination.

AOC The ARGUS checks whether the charges can be sent to the access under test. 
The test uses a call to oneself to check both AOC-D (AOC during a call) and 
AOC-E (AOC at the end of a call). 

SUB A call is made to oneself and answered to check the transfer of the sub-
address in both directions.
Are sub-addresses supported on the access under test?

UUS Does the access under test support the transfer of user data?



No 
Screening

If the caller supports CLIP No Screening (CNS) and the ARGUS is in TE mode, 
the ARGUS will display all of the connected network-side call numbers. It is 
also possible to check the CLIP No Screening function by monitoring with the 
WINanalyse software on a PC.
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Error Messages
If an error occurs during the Supplementary Services Tests or if it is not possible to setup a 
call, the ARGUS will display the corresponding error code (e.g. 28).
Example: The error code 28 equates to "wrong or invalid number". 
In the table below, you will find that this is an error from the network and that it reports that 
the call number was incomplete or in the wrong call number format (see “ARGUS Error 
Messages (DSS1)” on page 376).

A few error codes and their meaning:

 Description Cause (from network) Cause ARGUS internal

DSS1

no or another access __ 201, 204, 205, 210, 220

wrong or invalid 
number

1, 2, 3, 18, 21, 22, 28, 
88

152 ,161, 162, 199

one or more 
B channels busy

17, 34, 47        ___

wrong service 49, 57, 58 ,63 ,  65, 70, 
79

       ___
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19.6 Service check

The ARGUS checks, which of the following services are supported by the access under 
test:

The test runs automatically.
The ARGUS will make a separate self call to test each of the user-specific services. 
However, the call will not be answered so no charges will be incurred.


ARGUS - Main Menu




Enter the own (local) number of the 
access under test or select it from the 
speed-dialling memory.

The ARGUS suggests the B channel used 
last. If you enter an "*", the ARGUS will 
choose any B channel that is free. 

Service Name displayed on the ARGUS 
Speech Speech

Unrestricted Digital Information 
(data telecommunications)

UDI 64kBit 

3.1 kHz audio 3.1

7 kHz audio 7 kHz audio

Data transfer with tones & displays UDI-TA

Telephony Telephony ISDN 

Telefax Groups 2/3 Fax G3 

Fax Group 4 Fax G4 

Combined text and facsimile communication Mixed 

Teletex Service basis mode Teletex 

International interworking for Videotex Videotex

Telex Telex

OSI application according to X.200 OSI

7 kHz Telephony Telephony 7kHz 

Video telephony, first connection Video telephony 1 

Video telephony, second connection Video telephony 2 

Three user-specific services (see, page 224) User-specified 1 to 3

Single tests

Service check

Enter own number

Select B channel

Service test starts
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There are PBXs that use separate call numbers for incoming and outgoing calls. 
In this case, for the Service tests, you can enter a “remote” call number that does 
not match the “own” number that is stored in the ARGUS. If the Service check 

should extend outside of the local exchange, it is possible to perform the Service check in 
an end-to-end mode. In this case, you must enter the remote call number for a second 
terminal device. The ARGUS will then automatically check whether the remote terminal can 
accept the call under the various services – in other words, whether it is “compatible” with 
these services. In the test results, the second part (second +, - or *) refers to the answer 
from the remote exchange.

The ARGUS will display the results of the 
test once it is done. The ARGUS makes a 
distinction between outgoing calls (the 
first +, - or *) and incoming calls (the 
second +, - or *).

Interpreting the test results:

If the outgoing call is not successful, it is not possible to make a statement about an 
incoming call. Therefore, you will never see “- +” or “- *” on the display.

+
-
*

=
=
=

suppl. service supported
suppl. service not supported
No definite assessment can be 
made so an error code is displayed.
In such case, it is recommended that
you have someone place a call to 
the access under test using this 
service.


Scroll through the results

Close the results display and 
open the next higher menu.

Display Explanation

+ + The self call functions OK or the remote end can take the call for this service.

+ - The call was sent successfully, however, it was rejected at the remote end due 
to a lack of authorization.

- An outgoing call with this service is not possible.

+ * The call was sent successfully, the call to the remote end failed (e.g. remote 
end busy thus no B channel was available for the call back).

* Wrong number, no B channel available or other error.

Test results:
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19.7 X.31 Test

The ARGUS will perform a “Manual X.31 Test” or, if desired, an “Automatic X.31 Test”:
In the case of an automatic test, the ARGUS will first setup the D channel connection and 
then an X.31 connection. The ARGUS will then automatically clear the connection and 
display the results.

In the case of a manual test, the ARGUS will setup a D channel connection and an X.31 
connection. The duration of this connection is determined by the user (or the opposing 
end). For the duration of the connection, the ARGUS will repeatedly send a predefined data 
packet. The ARGUS will count all of the data packets sent and received and will display 
(where possible) the contents of the data packets received.

Configuring the X.31 parameters

ARGUS - Main Menu.





The ARGUS stores the parameters of the 
X.31 Test in the three X.31 profiles.




The default parameters can be restored at 
any time (see page 355).




Mark a profile for editing. The 
selected profile will be marked blue 
in the display. The default profile 
will be marked in the display with a 

. The ARGUS will use the 
parameters in the current profile for 
the X.31 Test.

The ARGUS takes over the marked 
profile as the default and returns to 
the Settings menu.

The ARGUS saves the TEI entered and 
returns to the next higher menu.

Settings

X.31 profile

TEI

X.31 profile 1

<Edit>

Enter a TEI
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Setting Explanation

X.31 profile: Up to three user-defined X.31 profiles can be created.
<Edit> The selected profile will be opened for editing.

Packet number Number of packets sent
Range: 0 to 65 000
Default setting: 10

TEI Entry (from the keypad) of the TEIs (Terminal Endpoint Identifier) 
to be used in the X.31 test. If you enter **, the ARGUS will 
automatically select a TEI. 
Range: min. 0 to a max. of 63
Default setting: ** (automatic)

LCN Entry (from the keypad) of the LCN (Logical Channel Number) to 
be used in the X.31 test.
Range: 0 to 4 095
Default setting: 1

Packet size Size of the data packets: 16, 32, 64, 128 or 256 bytes.
Default setting: 128 Bytes

Agree packet size Negotiate with the network side (DCE) regarding the data packet 
size. If the desired data packet size is larger than the default, this 
parameter should be set to “yes”.
Default setting: No

Window size Window size of Layer 3, selection of 1 to 7 packets.
Default setting: 2 Packets

Agree window size Negotiate between the terminal (DTE) and the network (DCE) an 
agreement regarding the window size.
Default setting: No

Throughput Data throughput in bits/s: 75, 150, 300, 600, 1200, 2400, 4800 or 
9600 bits/s.
Default setting: 1200 bit/s

Agree throughput Agree on the data throughput
Default setting: No
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User data

Content of the user data
- Format setting for the user data

- Entry of the ASCII data



Use the cursor keys to select one of the 
three available memory locations for the 
ASCII data (in this example, the first 
location 1/3). 



Use the numeric keypad to enter the 
ASCII data.When the right softkey is 
pressed it assumes a different meaning 
and thus influences the entries made 
from the keypad (letters or digits):

<12>ab>
<ab>AB>



<AB>12>

Entry of the digits 0 to 9 plus * and #
Entry of lowercase characters (e.g. to 
enter a “C” press the “2” on the keypad 
three times), plus @, /, -, and .
Entry of the uppercase characters and 
@, /,- and .

Move the cursor

<Delete> Delete the character before the cursor

Do not save ASCII data.

Save ASCII data

ASCII data

ASCII data 1/3

Enter ASCII data

<Edit>
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- Entry of the hexadecimal data:



Select one of the three available memory 
locations for the hexadecimal data (in this 
example, the first location 1/3)


Use the keypad to enter the hex value. To 
enter the values "A...F", use the softkey 
<A..F> (e.g. to enter a "C", press the 
softkey <A..F> three times). To confirm 
the entry of the hexidecimal characters A 
to F press <OK> (the softkey in the middle 
changes from <Delete> to <OK>).

<Delete> Delete the character before the cursor

Do not save the hexadecimal values.

CUG Closed User Group.
Default setting: No

CUG Index Coding for Closed User Group
Range: min. 0 to 255 max. 
Default setting: 1

D bit Local: DCE acknowledges data packets, i. e. flow control on local 
DTE-DCE path.
End-to-end: DTE-DTE flow control
Default setting: Local

Facilities Coding for various supplementary services
A maximum of 3 facilities can be stored. For instructions, see 
User data on page 244.

Profile name Use the keypad to enter the profile name for the X.31 profile. The 
ARGUS will later display this name for the profile.

Save hexadecimal data

Hex data

Hex data 1/3

Enter hexadecimal data

<Edit>
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Automatic X.31 Test
D channel

The “automated X.31 Test in D channel“ consists of two steps:


ARGUS Main Menu.





Select the profile.






Start test

The test can take up to 4 minutes.
The ARGUS will display the currently 
tested TEI, the previously tested TEI and 
the results:




First step: The ARGUS tests whether it is possible to access the X.25 service via the 
D channel on the ISDN access under test. The ARGUS sequentially 
checks all the TEIs from 0 to 63. All the TEIs with which the X.31 service is 
possible on Layer 2 will be displayed.

Second 
step:

For each TEI with which X.31 is possible on Layer 2, a "CALL_REQ" 
packet will be sent and then the ARGUS will wait for an answer. 
Beforehand, the ARGUS will request the entry of the X.25 access number, 
which will be saved in speed-dialling memory under X.31 test number (see 
page 358). With the entry of the X.25 access number, you can - if you wish 
- select a logical channel (LCN) other than the default.

<Edit> Change to the profile parameters 
(see page 243).
The parameters can be edited.

OK
NOK

= X.31 is available for this TEI
= X.31 is not available for this 
   TEI 

Single tests

X.31 Test

D channel

Automatic

X.31 profile 1
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The ARGUS will check whether the X.31 
service is available for Layer 3 for the TEIs 
found in Step 1.
Example: Test results


If the X.31 service is not supported, the ARGUS will report “X.31 (D) n. impl.”.

TEI 02 The first valid TEI is 02.

Layer 2 +

-

First test step was 
successful
First test step was not 
successful

Layer 3 +

-

Second test step was 
successful
Second test step was not 
successful
In this case, the ARGUS 
will display the relevant 
X.31 cause for the failure 
(in the example above: 13) 
and the associated 
diagnostic code, if there is 
any (see the Appendix 
page 377).

Test results
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Manual X.31 Test
D channel

The ARGUS first requests a TEI, an LCN and an X.31 number (the ARGUS uses the 
values stored in the X.31 profile). If an "**" is entered for the TEI, the ARGUS will 

automatically determine a TEI. Using the first TEI with which X.31 is possible, the ARGUS 
will setup a connection.


ARGUS - Main Menu





Select the profile.








The ARGUS displays the TEI stored in the 
X.31 profile. It can be edited from the 
keypad. If you enter "**", the ARGUS will 
automatically select a TEI.


The ARGUS displays the stored LCN (see 
page 243). It is possible to edit the LCN 
from the keypad.

The ARGUS displays the X.31 number 
saved in the speed-dialling memory (see 
page 358). It can be edited from the 
keypad.

Setup an X.31 connection.

<Edit> Change to the profile parameters 
(see page 243).
The parameters can be edited.

<Delete> Delete the TEI

Single tests

X.31 Test

D channel

Manual

X.31 profile 1

TEI is displayed

LCN is displayed

X.31 number displayed

Continuation on 
next page
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The ARGUS will display the LCN, the TEI, 
the X.31 number and the negotiated 
connection parameters.

The X.31 connection will be maintained 
until the user or the remote end clears it. 
When the X.31 connection is cleared, the 
ARGUS will automatically clear the D 
channel connection.



























<Data> Sends a predefined data 
packet 

<Statistic> Displays the L1/L2/L3 
statistics

<L2> Scrolls to the L2 statistics

<L3> Scrolls to the L3 statistics

<Yes> The ARGUS saves the results 
(see page 342).

Save X.31 test?
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 /

:)
19.8 Call Forwarding (CF)

CF Interrogation
The ARGUS will check whether a call diversion has been setup in the exchange for the 
access under test. The ARGUS will show the type of diversion (CFU, CFNR or CFB) and 
the call diversion’s service. The display is limited to a maximum of 10 call diversions. The 
ARGUS will count any additionally set up call diversions. The ARGUS can clear any call 
diversion setup in the exchange.


ARGUS - Main Menu.


Start the CF Interrogation. The test can 
take a few seconds.


Display:



Security query

- Type of call diversion (in the example, 
CFU)

- The type of call diversion will be displayed
number of call diversions found 
In this example: Display the first of a total 
of one call diversion found (01/10)

- The call diversion service

- The number that should be diverted (from

- The number to which calls should be 
diverted (to:)

<Delete> Delete call diversion

<Yes> Clears the displayed call 
diversion in the exchange. If this 
is not possible, the ARGUS will 
report: "Call diversion not 
changeable!"

<All> Delete all call diversions.

Do not delete the call diversion!
Open the Single Tests Menu.

CF interrogation

Single tests

Delete the CF?
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Some PBXs or exchanges do not permit the use of the mechanism used (by the 
ARGUS) for the interrogation of the call diversions for all MSNs or they return a 
negative acknowledgement of the interrogation of call diversions, implying that no 
call diversions have been set up. In the event of a negative acknowledgment, the 
ARGUS will require that the local MSN is entered. The call diversion interrogation 
will be repeated MSN-specific. Naturally, in this case, the results of the 
interrogation of the call diversion only apply for the entered MSN and not for the 
entire access.

Abbreviations used for the services and service groups on the display:












Bearer Service Abbreviation

All services All

Speech Spch

Unrestricted Digital Information 
(data telecommunications)

UDI

Audio 3.1 kHz A3k1H

7 kHz audio A7KHz

Telephony 3.1 kHz Tel31

Teletext TTX

Fax Group 4 FaxG4

Video syntax based ViSyB

Video Telephony ViTel

Telefax Groups 2/3 FaxG3

Telephony 7 kHz Tel7k
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CF Activation
Using the ARGUS, call diversions can be setup in the exchange.



ARGUS - Main Menu.





Using the cursor keys, select the "Service" 
of the call diversion.

Using the cursor keys, select the type of 
call diversion.

The speed-dialling memory opens (see 
page 358).
Under own (local) number, enter the call 
number which should be diverted.


Enter the call number to which calls should 
be diverted.

Set up the call diversion













Open the Single Tests Menu.

Single tests

CF activation

Enter destination number

Select service

Select the type of call 
diversion

Enter own number
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CF Delete
The ARGUS can clear selected call diversions setup in the exchange.




ARGUS - Main Menu.





Using the cursor keys, select the "Service" 
of the call diversion.

Using the cursor keys, select the type of 
call diversion.


The speed-dialling memory opens (see 
page 358).
Under "Own number", enter the call 
number which should no longer be 
diverted.

Delete call diversion

Open the Single Tests Menu.

Single tests

CF delete

Call diversion deleted

Select service

Select the type of call 
diversion

Enter own number
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19.9 Automatic Performance of Multiple Tests

The ARGUS performs an automatic test series and displays the test results. The required 
parameters (e.g. measurement time and error level for the BERT, see page 227) should be 
checked before the automatic test series is begun. 

Using the ARGUS WINplus or WINanalyse software, the test results can be saved on a 
Windows PC. On the PC, WINplus / WINanalyse can be used to generate a 
comprehensive report that can then be printed, sent by e-mail and/or archived. The 
ARGUS automatically performs the following sequence of single tests:

On a BRI S/T or U-interface (ARGUS in TE mode)
- Status

- Level measurement

- Service check

- BERT in an extended call to oneself

- Supplementary service test (Suppl.serv.test)

- CF Interrogation (Call Diversions)

- X.31 test

On a BRI S/T or U interface leased line (permanent circuit)
- Level measurement

- BERT in end-to-end mode (e.g. with a loopbox on the remote end)
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ARGUS - Main Menu

Select Auto test.










Select the memory location. For each 
memory location used, the ARGUS will 
display the name assigned to the memory 
location (in this example, New result). 







Press the  on the numeric keypad to 
directly access a memory location. A 
indirection through the main menu is not 
necessary.



In TE mode:
Enter the “Own number”; on accesses 
using the DSS1 protocol you must also 
enter a “remote number”.

Select service
(required for Supp.Serv.test and BERT).

During the test sequence, the ARGUS will 
display the single test currently running.

Enter own (local) number

Enter destination number

Select service

Start the automatic 
test
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Terminating the test (early):














The ARGUS will terminate the test 
sequence, any test results already 
gathered will be lost. Any "old" data stored 
in this memory location from a prior test 
will be retained.





Skipping individual tests:


A single test can be skipped: In this 
example, the ARGUS is currently running 
a Service check.











Stop the current single test.





Open the 
next higher menu.

Interrupt test

Stop current test

In this case, the 
ARGUS will execute 
the next single test.
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Resuming a test:

The ARGUS can resume an interrupted 
single test: In this example, the ARGUS is 
running a Service test.










Stop the current single test










For information on displaying the test results, see page 343.

Test - resuming

The ARGUS repeats the 
“interrupted” single test (in the 
example: a Service check). 
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19.10 Connection

The ARGUS can set up a connection for the following services:


A headset or the integrated handset can be used as a phone during a telephone 
connection.

When a connection is set up, pressing the number keys (0-9) or the * or # will generate and 
send the corresponding DTMF tones.


Service


Display

Speech Speech

Unrestricted Digital Information (data telecommunications) UDI 64kBit 

3.1 kHz audio 3.1 kHz audio

7 kHz audio 7 kHz audio

Data transfer with tones & displays UDI-TA

Telephony Tel. ISDN

Telefax Groups 2/3 Fax G3

Fax Group 4 Fax G4

Combined text and facsimile communication Mixed 

Teletex Service basis mode Teletex

International interworking for Videotex Videotex

Telex Telex

OSI application according to X.200 OSI

7 kHz Telephony 7 kHz

Video telephony, first connection Videotel. 1

Video telephony, second connection Videotel. 2

Three user-specified services (see, page 224) User-specified 1 to 3
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Overlap sending (outgoing call)

In overlap sending, the digits entered for the call number are sent individually.

ARGUS - Main Menu

Select the service to be used for the 
connection.

Enter the B channel on the keypad. The 
ARGUS suggests the B channel used 
last. Press <Delete> first before entering 
a new B channel. If you enter an *, the 
ARGUS will choose any B channel that is 
free. The ARGUS will show whether the 
B channel is available.


To set up a connection


Enter the call number on the keypad.
Display:

<Call no.> Open the call number 
entry dialog

The ARGUS will open the 
Connection display.
Besides overlap sending (as shown 
on the left), one of the following can 
be selected here
- En-bloc sending (see page 261)
- Redialling (see page 262)
- Keypad dial (see page 266).

- B channel and service

- The number in the speed-dialling 
memory under “own number”, see page 
358 (from:)

- The number dialled (to:)

- Other information depending on the 
access, e.g. TON and NP

<TM> Start the Test Manager, see 
page 270.

<Volume> Set the volume

or Cancel setup

Single tests

Connection

Overlap sending

Select service

B channel select

Continuation on 
next page
ARGUS 155 259



19 Operation on an ISDN Access
The connection is setup using 
B channel 1.


- Display Advice of Charges (AOC):
If the charges are not given in units, rather directly as currency, the ARGUS will display the 
current charges in currency. If, in DSS1, the call charges are not provided in accordance 
with the DIN ETS 300182 standard, rather in the form of the information element DISPLAY 
(DSP), the ARGUS will display the DISPLAY message's character string.

Note regarding the entry of the own call number
Separate the extension from the access number with a # (e.g. 02351 / 9070-40 is 
entered on the ARGUS as: 023519070 #40). For an outgoing call, the ARGUS 
uses the entire call number (without #) as the number called (CDPN or DAD) and, 
for the calling number, only the extension (DSS1-CGPN).
A ‘#‘ at the beginning of a call number is treated as a valid character. A ‘#’ at the 
end of the own call number instructs the ARGUS to not send the caller’s number for 
outgoing calls (CGPN or OAD).

Depending on the type of access 
other information will be 
displayed. 
- Subaddress of the caller (SUB)
- Destination number
- User-User Information (UUI)
- Display Information
- Type of number (TON)
- Numbering plan (NP)
- Units for charges

<TM> Start the Test Manager, see 
page 270.

<Volume> Set the volume


Simplified overlap sending using the telephone key

pressed once: The ARGUS will open the Connection/Overlap window 
directly regardless of the currently open menu.

depressed again: A dial tone will be heard and once the call number is 
entered, the call will be setup.

or

Disconnect
260 ARGUS 155 



19 Operation on an ISDN Access
En-bloc sending (outgoing call)

In en-bloc sending, the ARGUS sends the entire dialling information in one block.

ARGUS - Main Menu






The speed-dialling memory opens (see 
page 358).
Use the cursor keys to scroll to desired 
the number or reenter the number on the 
keypad.





Enter the B channel on the keypad (for 
details on entry, see “Overlap sending”).

For more information on the displays and 
operation, see Overlap sending page 259.












<Call no.> Open the call number 
entry dialog

The ARGUS will open the Outgo. 
call display, operation like by 
overlap sending.

<TM> Start the Test Manager, see 
page 270.

<Volume> Set volume

Single tests

En-bloc

Select service

B channel select

Connection

Enter the phone number

or

Cancel setup
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Redialling (outgoing call) + Last caller (incoming call)

The ARGUS will set up a call using the last number dialled or the number of the last caller.


ARGUS - Main Menu









Enter the B channel on the keypad. The 
ARGUS suggests the B channel used last. 
Before entering a new B channel first 
press <Delete>. If you enter an *, the 
ARGUS will choose any B channel that is 
free. The ARGUS will show whether the B 
channel is available.

The dialling procedure will begin using the 
number last called or the number of the 
last caller.

For more information on the displays and 
operation, see Overlap sending page 259.




<Call no.> Open the call number entry 
dialog

<TM> Start the Test Manager, see 
page 270.

<Volume> Set volume

Single tests

Connection

Select service

B channel select

Redialling or Last caller

Cancel setup

or

Confirm number
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Incoming Call

An incoming call can be taken at any time even when a test (e.g. a BERT) is in process 
(see page 271). The ARGUS will signal an incoming call with an audible tone and a 
message on the display. On a P-MP access, you can use the Call acceptance (see page 
225) function to configure the ARGUS to only signal incoming calls which are addressed to 
the MSN that corresponds to your own call number. This function can only be used when 
your own call number has been entered into the speed-dialling memory (see page 358) and 
the incoming call has a destination MSN.

Display:


The ARGUS will display the complete 
destination number (DDI), if the Alerting 
mode is set to manual (see page 223).

Accept call


Depending on the type of access 
additional information will be displayed (in 
the example, CR value and length/flag).




The ARGUS displays the cause of the disconnect (see page 264).

- B channel used and service

- The caller's number (from:)

- Destination number (to:)

- Other information depending on the 
access, e.g. TON and NP

The call number of the last 
incoming call will be saved in the 
"Last caller" memory location.

<TM> Start Test Manager, see 
page 270.

<Volume> Set volume.

Reject call

Disconnect

or
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Charge information in NT mode:
In NT mode, the ARGUS will – for incoming calls – send advice of charges in accordance 
with DSS1 as units and as currency (in euros).

Clear (disconnect) the connection









The ARGUS will display the cause (see the 
table below) of the disconnect (e.g. Normal 
clearing) and the location where the cause 
occurred (e.g. subscriber).
Depending on the access, additional 
information will be displayed (in this 
example, Units).




The following causes are shown in clear text:

<TM> Start Test Manager, see 
page 270

<Volume> Set volume

Reason Display Explanation

255 Active clearing Clearing User actively initiated the disconnection

Length 0 Normal clearing Cause element with Length 0

01 unalloc. number Signals “No access under this call number”

16 Normal clearing Normal clearing

17 User busy The number called is busy

18 No user respond No answer from the number called

19 Call time too long Call time too long

or
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Other causes are not shown in clear text, rather as decimal codes (see ”ARGUS Error 
Messages (DSS1)" on page 376).

21 Call reject The call is actively rejected

28 Wrong number Wrong call number format or call number is 
incomplete 

31 Norm. clearing Unspecified “normal class” (Dummy)

34 No B chan.avail. No circuit / B channel available

44 Req.chan.unavail Requested B channel not available

50 Req.fac.not subs Requested supplementary service (facility) not 
subscribed

57 BC not authoriz. Requested bearer capability is not enabled

63 Srv./opt.n.avail Unspecified for “Service not available” or “Option not 
available” 

69 Req.fac.not impl. Requested facility is not supported

88 Incompat. Dest. Incompatible destination

102 Timer expired Error handling routine started due to time-out

111 Protocol error Unspecified for “protocol error class”

127 Interworking err Unspecified for “interworking class”
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Testing Features via the Keypad
This feature is only relevant on an S-Bus or U interface. Some network operators do not 
support the standard DSS1 features, rather they expect the user to control the network via 
so-called keypad command sequences. In these cases, the desired facility is usually 
activated by entering a series of characters and then sending these characters within a 
DSS1-specific protocol element. These so-called keypad elements are imbedded in a 
setup message. Each step is acknowledged either acoustically (handset) or via special 
protocol elements (cause). These causes are displayed by the ARGUS.



ARGUS - Main Menu.
















Using the cursor keys select the service 
that should be used for the connection.

Use the keypad to enter the B channel for 
the connection, see page 259.


Start the dialling procedure.
For more information on the displays and 
operation, see Overlap sending page 259.


Select keypad info,
see page 225.

<Edit> Edit the selected keypad info 
entry. Afterwards, use the keypad 
to enter the keypad info.

Single tests

Connection

Select service

B channel select

Keypad dial

Outgo. call
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19.11 Time Measurement

The ARGUS measures three different times:
- Connection setup time
- The propagation delay of the data 
- The difference between the propagation delays for the data on two B channels.

Connection setup time
The ARGUS places an outgoing call and measures the time between sending the SETUP 
and receiving the ALERT or CONN. The ARGUS disconnects automatically as soon as the 
measurement is completed.


ARGUS Main Menu









The speed-dialling memory opens (see 
page 358). Use the cursor keys to scroll to 
desired the number or reenter the number 
on the keypad.




Enter the B channel on the keypad

Perform measurement

Display:

If the ARGUS cannot perform the 
measurement - e.g. because the call 
number entered was wrong or no 
B channel is free - the cause (see page 
374) will be displayed.

- Connection setup time in seconds

- L3 message received when the 
connection has been fully setup

Single tests

Time measurement

Select service

B channel select

Conn. up time

Dial the number
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a 
d 
B channel delay
The ARGUS places a call to itself (self call) or to a remote loopbox and measures the 
propagation delay for the data in the selected B channel. The measurement (continuous 
measurement) must be terminated manually.


ARGUS Main Menu









The speed-dialling memory opens (see 
page 358).
Use the cursor keys to scroll to desired 
the number or reenter the number on the 
keypad.




Enter the B channel on the keypad

Perform measurement

Display

The measurement will be repeated in 
cycles (continuous measurement).

If the measurement cannot be performed (e.g. because the call number entered was wrong 
or no B channel is free) the ARGUS will display the corresponding cause. If the ARGUS 
does not receive the data back in the B channel within 13 seconds, it will display the 
message “No loop”.

avg: average B channel delay

min: shortest B channel delay

max: longest B channel delay

bit: The average B channel delay in bits 
(multiples of the time required to send 
bit at 64 kbit/s, it takes 15.26 µs to sen
a bit).

Stop measurement, the ARGUS will 
display the last measurement.

Single tests

Time measurement

Select service

B channel select

B channel delay

Dial the number
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Interchannel delay
The ARGUS establishes two separate connections to a remote loopbox. The loopbox 
sends the respective B channel data back on the same channel. The ARGUS measures 
the propagation delay for the data on each of the B channels and determines the difference 
between the two propagation delays (interchannel delay). The measurement (continuous 
measurement) must be terminated manually.



ARGUS Main Menu









The speed-dialling memory opens (see 
page 358). 
Use the cursor keys to scroll to desired 
the number or enter a new number.


Perform measurement



The measurement will be repeated in 
cycles (continuous measurement).

If the measurement cannot be performed (e.g. because the call number entered was wrong 
or no B channel is free) the ARGUS will display the corresponding cause. If the ARGUS 
does not receive the data back in the B channel within 13 seconds, it will display the 
message “No loop”.

avg: average interchannel delay

min: shortest interchannel delay

max: longest interchannel delay

bit: The average interchannel delay in 
bits (multiples of the time required 
to send a bit at 64 kbit/s, it takes 
15.26 µsto send a bit).

Stop measurement.The ARGUS will 
display the last measurement.

Single tests

Time measurement

Select service

Interchannel delay

Enter remote number
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19.12 Managing Multiple Tests on an ISDN Access

The ARGUS can simultaneously start several tests or “connections” independently of each 
other. As an example, a BERT can be run at the same time that you make a phone call. 
The individual tests or “connections” use resources.

All of the tests that have been started will be administered by the Test Manager. Using the 
Test Manager, you can start new tests, switch between tests running in parallel or terminate 
all of the tests that are currently running.


ARGUS - Main Menu


Open the Test Manager
























<TM>
or

Opens the Test Manager directly in 
the Single Tests Menu if a 
connection has already been setup 
or if the ARGUS is running a test.

Test Manager
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Starting Several Tests to Run Simultaneously
Starting a new test or connection during an existing connection


Example:
There is a connection on B channel 1.









Open the Test Manager (can also be 

opened by pressing the -key).








Select the desired test (e.g. bit error rate 
test, BERT).

Start BERT, the connection is still setup.

For information on running a BERT, see 
page 228.





Open the Test Manager,
mark “Outgoing connection”.



Open the 
Connection display.

Start new one

Single tests

Bit error rate test

Outgoing call
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If a test (or connection) is canceled (or cleared), the ARGUS will return to the Test Manager 
if there is another test (or connection) running in the background.

Some tests use so many resources that they cannot be run in every combination 
with other tests. In this case, the ARGUS will display the message “Test not 
possible at this time”.













Test / Connection Number of times that a test or connection 
can be started at the same time:

It is possible to 
change to 
another test:

Incoming call     2     Yes

Outgoing call     2     Yes

BERT     2     Yes

Loop     2     Yes

Service check     1     No

Suppl.serv.test     1     No

Time measurement     1     No

X.31 test     1     No

CF Interrogation / 
Active / Delete

    1     No

Automatic test     1     No

 Tests    1/02  B01

An example of the display

The connection 
was the first 
started

There are 2 
connections/
tests

The connection 
uses B channel 1
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19 Operation on an ISDN Access
Switching between Parallel Tests or Connections
This operation will be illustrated using the example of "Accepting an incoming call during a 
BERT". The ARGUS signals an incoming call both audibly and on the display (see page 
258). The incoming call can be accepted without influencing the currently running BERT.
If either the “B channel loop” or the “BERT wait” function is active, the call will be accepted 
automatically.

While running a BERT, the ARGUS 
displays information about an incoming 
call.







Accept call
The BERT will continue in the background.










Mark “BERT outgoing”.

Switch to BERT.

The connection remains active in the 
background, the handset is assigned to 
the connection.



The handset will be assigned to the appropriate currently active connection. The 
assignment of the handset to a given connection is also retained in the 
background.

<Reject> Reject the incoming call. 
The ARGUS will switch to the 
BERT.

or 

BERT active

BERT outgoing
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End All Currently Running Tests or Connections

ARGUS - Main Menu.



Open the Test Manager




































<TM>
or

Opens the Test Manager directly in 
the Single Tests Menu if a 
connection has already been setup 
or if the ARGUS is running a test.

Test Manager

All tests will be terminated and 
all connections cleared down.
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19 Operation on an ISDN Access
19.13 The L1 State of an S-Bus Access

The ARGUS displays the current status of Layer 1: i. e. which signal does the remote end 
receive and which signal does the ARGUS receive?

ARGUS - Main Menu


The ARGUS displays the state of Layer 1 
or of the signal, which is currently being 
sent (Info 0 to Info 4).


























<New> Layer 1 will be setup again

Close the display and open the 
Main Menu.

L1 State
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19.14 Monitor

The ARGUS accepts all of the D channel signals from the S-Bus access and sends these 
D channel signals over the USB interface to a PC which must be running ARGUS WINplus 
or WINanalyse. The Bus and Layer 1 are not influenced by the monitoring.

The Monitor settings are made in the chapter 5 Configuring accesses page 23. 

Monitoring is not yet active!


Start monitoring




The ARGUS displays the recording time 
in h:min:sec and the number of recorded 
signals.





Listening-in on voice data

Enter the second B channel from the 
keypad (first press <Delete>) or use the 
cursor keys to select it. The ARGUS will 
switch the handset to this B channel.

Stop monitoring. 

Status display

<Start>

B channel select

Continuation on 
next page
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19 Operation on an ISDN Access
Listening-in on voice data 
(Direction: Net --> User) possible.


 

The ARGUS displays the call parameters 
of the last SETUP received.
Display:

Depending on the type of access 
additional information will be displayed.



<Mute> To stop listening
<Talk> Parallel call display while 

monitoring

The ARGUS searches all of the 
D channel signals sent for a 
SETUP. If a SETUP is detected, 
the <Call> softkey will be 
displayed.

- Call direction (N -> U for Net -> User)

- B channel used

- Service

- Own number (from:)

- Destination number (to:)

- Sub-address (SUB)

- User-User-Info (UUI)

- DSP messages

- Type of number (TON)

- Numberin Plan (NP)

Display call parameters
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Listening-in when monitoring is not active

Monitoring is not active!

It is possible to passively listen-in on the 
network-side, the terminal-side or both 
sides.

Enter the B channel from the keypad (first 
press <Delete>) or use the cursor keys to 
set it.
















Stop listening-in and open the 
Main Menu.

Status display

<Menu>

B channel select

Status display

Listening-in

Network-side

Listening-in
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19.15 Leased Lines on an ISDN Access

Besides dial-up connections to any subscriber, ISDN also supports the use of permanent 
circuits switched to a specific remote location (leased lines). These leased lines 
(permanent circuits) are available after setting up Layer 1, in other words after 
synchronizing both terminals by exchanging HDLC-frames. The location where the clock is 
generated can be selected (see page 223). A quick and simple test of a leased line can be 
made by placing or taking a call on a selected B channel. However, for a more precise test, 
a bit error rate test should be run.


Both ends of the leased line (permanent circuit) must use the same channel.

Telephony
The Leased line settings are made in the 
chapter 5 Configuring accesses page 23. 

B channel select

Setup the telephone connection

Disconnect






Enter the B channel from the keypad (first 
press <Delete>) or use the cursor keys to 
set it.

The ARGUS will display the B channel 
used and the duration of the leased line 
(in h:min:sec).


Alternatively, the connection can be setup via Connection in the Single Tests Menu.



<Setting> ISDN parameter 
configuration, see page 
222.

<Volume> Set the volume
<TM> Start the Test Manager, see 

page 271.
Another connection can be 
setup.
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Bit Error Rate Test
There are a number of variants of the bit error rate test: In the simplest case, a B channel 
loop will be set up at the remote end; for information on parameter settings, see page 227.
After selection of the channel to be tested (B channel or D channel), the ARGUS will send 
the test pattern, receive it back and evaluate it accordingly.

The displays and operation are, in largest part, similar to those of a BERT on a dial-up 
connection (see page 226, Parameter settings, page 228), however, you need not enter 
call numbers or select a service.













In the case of a BRI in end-to-end mode 
(see page 227 and page 234), it is also 
possible to run a BERT in the D channel 
with HDLC framing (channel selection: 
D channel).

Single tests

Bit Error Rate Test

BERT start

B channel (64k)

Continuation on 
next page
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19 Operation on an ISDN Access

First press <Delete> and enter the 
B channel on the keypad, or use the cursor 
keys to set it.

BERT Start

During the BERT, the display shows:



For information on saving the test results, 
see page 233.











- The bit pattern and channel used

- The synchronicity of the bit pattern 
(in this example, synchron)

- Sync. Time in h:min:s 
The time in which the ARGUS can 
sync to the bit pattern.

- LOS
Synchronization is lost at an error 
rate greater than or equal to 20 % 
within a period of a second. The 
absolute number of synchronization 
losses will be shown.

- Fault: the bit errors that have 
occurred.

<Reset> The test time and number of bit 
errors will be reset.

<TM> Start Test Manager, see 
page 270. 

<Error> Insert artificial bit errors to test 
the reliability of the BERT.

Stop the BERT
Display the test results, see 
page 343.

B channel select
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Loopbox
The ARGUS can be used as a loopbox on a permanent circuit (leased line).


ARGUS - Main Menu









Channel selection:
The ARGUS will loop on either one 
B channel (Channel selection: B channel) 
or on all B channels and the D channel 
(Channel selection: All framed).


The ARGUS will display the B channel 
used and how long the loopbox has been 
activated (in h:min:sec).

























Deactivate the loopbox.

Single tests

Bit Error Rate Test

B channel loop

B channel select

Activate loopbox
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19 Operation on an ISDN Access
Time Measurement

B channel delay

The ARGUS will measure the delay on the selected B channel. If the ARGUS does not 
receive the data back in the B channel in about 13 seconds, it will display the message “No 
loop”. The measurement (continuous measurement) must be terminated manually.


ARGUS - Main Menu


First press <Delete> and enter the B 
channel on the keypad, or use the cursor 
keys to set it.

Perform measurement

Display:

The measurement will be repeated in 
cycles (continuous measurement).

avg: average B channel delay

min: shortest B channel delay

max: longest B channel delay

bit: The average B channel delay in bits 
(multiples of the time required to 
send a bit at 64 kbit/s, it takes 15.26 
µs to send a bit).

Stop measurement, the ARGUS will 
display the last measurement.

Single tests

Time measurement

B channel select

B channel delay
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Interchannel delay

The ARGUS will send the B channel data to a loopbox which will then send it back on the 
same channel. The ARGUS measures the propagation delay for the data on each of the 
B channels and determines the difference between the two propagation delays 
(interchannel delay). If the ARGUS does not receive the data back in the B channel in 
about 13 seconds, it will display the message “No loop”.
The measurement (continuous measurement) must be terminated manually.


 ARGUS - Main Menu 









Perform measurement

Display:

The measurement will be repeated in 
cycles (continuous measurement).






avg: average interchannel delay

min: shortest interchannel delay

max: longest interchannel delay

bit: The average interchannel delay in 
bits (multiples of the time required to 
send a bit at 64 kbit/s, it takes 15.26 
µs to send a bit).

Stop measurement, the ARGUS will 
display the last measurement.

Single tests

Time measurement

Interchannel delay
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19.16 Level Measuring on an ISDN Access

Level Measurement on a S-Bus Access
Level measurement – connected line
The ARGUS measures the level of the received useful signal and the phantom feed. The 
measurement will be updated continuously.


ARGUS - Main Menu





Start measurement

The ARGUS will display the level of the 
useful signal (Level) and the feed voltage.

Evaluation of the useful signal level:


Evaluation of the feed voltage:

<< Level is too low

>> Level is too high

OK Level is alright
(0.75 V +20 % 

-33 % i.e. from 0.9 V to 
0.5 V)

None No level 

Voltage OK
Normal 
voltage

Normal feed
(40 V +4,25 %

-13,75 % i.e. from 
41.7 V to 34.5 V)

Voltage OK
Feed voltage

The (inverted phantom) feed
is alright (OK).

Voltage
None

No feed (Voltage)

<R>On> 100resistor switched in
<R>Off> 100resistor switched off
<New> Setup Layer 1 again

Level measurement

Connected line

Stop measuring level.
Open the Level measuring 
menu.
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Level measurement other TE

In TE mode, the ARGUS will measure the level of a terminal connected in parallel. In this 
case, the ARGUS is passive. Layer 1 must be activated on the terminal. The ARGUS 
updates its measurement continuously.


ARGUS - Main Menu





Start measurement

The ARGUS displays the level and an 
evaluation of the useful signal:



















<< Level is too low

>> Level is too high

OK Level is in order
(0.75 V +20 % -33 % i.e. from 0.9 V 
to 0.5 V)

None No level 

<R>On> 100resistor switched in
<R>Off> 100resistor switched off
<New> Setup Layer 1 again

Level measurement

Other TE

Stop measuring level. 
Open the Level measurement 
menu.
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Level Measurement on a U interface 
Measurement of feed voltage on a U interface


ARGUS - Main Menu





Start measurement

The ARGUS will display the level of the 
feed voltage. The measurement will be 
updated continuously.

Level measurement

U interface feed voltage

Stop measuring level. 
Open the Level measuring menu.

Level measuring results
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20 Operation on a POTS access



The voltages on the subscriber line may not exceed 130 VDC and should be free 
of AC voltage.

20.1 Setting the POTS Interface

Use the included connection cable to connect the ARGUS (Line jack) to the POTS access 
to be tested and then switch the ARGUS on. The POTS settings are made in the chapter 5 
Configuring accesses page 23. In this example the POTS TE mode was selected:

Note: Open the Main Menu and select "Help" or press number key "1". An overview of the 
possible key combinations can be found on page 110.

The various menus available for the 
selected type of access will be shown in 
the Main Menu.

 
The ARGUS will open the 
marked menu (in this example, 
Single tests).

 Select a menu. The selected 
menu will be marked blue in the 
display.

 
Return to the previous menu (in 
the example, the State display).






The ARGUS displays the voltage on the 
line when it is "on hook“ (not busy). 
Positive voltage: Polarity on a+; on b-
(red wire is a, black wire is b)
Negative voltage: Polarity on a-; on b+

<Setting> Opens the Settings menu for 
POTS parameters, see page 
289.

<Menu> Open the Main Menu 

<Call> For information on setting up a 
call, see page 291. 

ARGUS State Display

Main Menu
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20.2 POTS Settings

It is possible to configure the following "POTS Settings". The default settings can be 
restored at any time (see page 355).

Setting Explanation

POTS

Dial mode Selection of the dial mode:
DTMF or pulse dialling
Default setting: DTMF

CLIP Mode Select the transfer procedure used to pass the call number:

FSK CLIP via FSK
(Frequency Shift Keying)
For Germany and some other places in Europe

DTMF CLIP via DTMF 
(Dual-tone multi-frequency)
For Scandinavia and the Netherlands
The ARGUS will automatically detect that a CLIP was 
sent using DTMF with the polarity reversal and will set 
itself accordingly (e.g. Netherlands).

Default setting: FSK

DTMF parameter Settings for the three parameters Level, Duration and Interval of the 
DTMF signals generated during POTS (analog) operation.

Level Setting the DTMF level:
The level can range between -30 dB and +9 dB.
Use the cursor keys to raise or lower the level by 3 dB.
Range: -30 to +9 dB
Default setting: -3 dB

Time Setting the DTMF time: 
Range: 40 to 1000 ms
Default setting: 80 ms
Use the cursor keys to raise or lower the setting:

In the range
In the range
In the range

40 - 200 ms:
200 - 300 ms:
300 - 1000 ms:

10 ms steps
20 ms steps
100 ms steps
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For information on restoring the default parameter settings, see page 357.

Interval Setting the interval between two DTMF characters:
Range: 40 to 1000 ms
Default setting: 80 ms
Use the cursor keys to raise or lower the setting:

In the range
In the range
In the range

40 - 200 ms:
200 - 300 ms:
300 - 1000 ms:

10 ms steps
20 ms steps
100 ms steps

Defaults Restores the default settings: 
Level = -3 dB, Time = 80 ms, Interval = 80 ms

FLASH time Sets the length of a FLASH.
This setting is needed in order to use special features of a PBX.
Range: 40 to 1000 ms
Default setting: 80 ms
Use the cursor keys to raise or lower the setting:

In the range
In the range
In the range

40 - 200 ms:
200 - 300 ms:
300 - 1000 ms:

10 ms steps
20 ms steps
100 ms steps
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20.3 Connection on a POTS Access 
Outgoing Calls
The ARGUS sets up a connection to another terminal. If the terminal at the other end is a 
telephone, the handset integrated in the ARGUS or a headset can be used to hold a 
conversation.

For information on the ARGUS in the 
"POTS telephony" access mode, see 
page 288.
The ARGUS - Main Menu

Simplified overlap signaling using the  key: and the ARGUS will immediately 
open the POTS telephony display. Once the call number is entered, the call will be 
setup.

Incoming Call 
The ARGUS signals an incoming call both audibly and on the display.


If the access supports CLIP, the ARGUS 
will display the number of the caller (for 
information on CLIP mode, see page 
289).

<Call>

or  
Setup the connection: 
Enter the number on the keypad. 
Each of the number's digits will be 
dialled individually. The ARGUS wil
display the number dialled. As soon
as the remote party answers, a voic
connection will be set up.

<Call 
no.>

The ARGUS will display the last 
number dialled (simplified last 
number redial) or that of the last 
caller.

<R> Generate a FLASH signal.

Scroll through the speed-dialling 
memory to select a different numbe
or enter a new one using the keypa

<Accept> or  


Accept call

The call number received will be 
saved in the “Last caller” memory 
location.

Single tests

Clearing the connection

or press the  key
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20.4 POTS Monitor

The POTS monitor function provides a high impedance tap (for listening-in) that does not 
influence the interface. You can listen-in on the line with the integrated handset or a 
headset without having the ARGUS send on or otherwise influence the interface.

The POTS monitor settings are made in the chapter 5 Configuring accesses page 23.


The ARGUS displays the voltage level on 
the line when it is “on hook” (not busy).





Start Monitoring

The ARGUS displays the voltage (when 
"off hook"), the number of the caller (if 
CLIP is supported) and the DTMF 
characters dialled by both telephone 
subscribers.
Any received DTMF characters will be 
appended to the line, which will shift left 
for each character once it is full. An 
incoming call will be signalled 
acoustically.



Press to display additional 
information, if available on the 
access

<Loud> Increase volume 
(The microphone is off.)

<Delete> Clears the display.

Stop monitoring and the 
ARGUS will open the State 
Display.
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20.5 Level Measuring on a POTS Access

The ARGUS measures the voltage level in both the normal case and when the line is 
“busy” (trunk line).


ARGUS Main Menu


Start Measurement

The ARGUS will display the polarity of the 
2-wire POTS line (red wire "a"; black wire 
"b") as well as the "on hook" and "off 
hook" voltage levels.
<New> To repeat the measurement

Open the Main Menu

Level measuring
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21 PESQ

To objectively assess voice quality, ARGUS performs a Perceptual Evaluation of Speech 
Quality (PESQ) analysis according to ITU-T P.862 directly on an ISDN, POTS, xDSL or on 
Ethernet. The PESQ test is only available for interfaces that have previously been enabled 
(e.g. ISDN option).
The PESQ analysis is not performed by ARGUS directly but by a PESQ server, which has 
its own telephone number. ARGUS is connected directly to the subscriber access and 
loops a standardised voice recording to the server.
To assess the talker side, ARGUS transmits the voice recording to the server, which returns 
the calculated PESQ value to ARGUS. ARGUS shows the PESQ value directly in the 
display. 
To assess the talker and listener sides, the voice recording is initially sent from the server to 
ARGUS, then looped back to the server.

21.1 PESQ configuration


ARGUS in Main Menu







Use the cursor keys to select the 
parameter (in this example Mode).





Select using the cursor keys (e.g. ARGUS 
Loop).



The entire network to be tested including all its gateways and other 
components must be RFC2833-compliant.

ARGUS adopts the marked 
setting.

ARGUS switches to the next 
higher-level menu without 
saving the altered parameter.

Settings

PESQ

ARGUS loop
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Setting Description

PESQ:

Mode Loop: Evaluation of talker and listener side.
ARGUS receives the voice recording from the server 
and loops this back to the server.

Sending: Evaluation of talker side.
ARGUS transmits the voice recording to the server.

Call number 

POTS

Enter the server number for the PESQ test at the POTS interface. 
Selection via the POTS speed dial list.

Call number 

ISDN

Enter the server number for the PESQ test at the ISDN interface.
Selection via the ISDN speed dial list.

VoIP 
destination

Enter the server number for the PESQ test at the xDSL interface 
and on Ethernet. Selection via the list of VoIP destinations.
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.

21.2 PESQ test on xDSL or Ethernet access via VoIP

You need to first start VoIP telephony before you can perform the PESQ test on xDSL or 
Ethernet. For details on configuring the VoIP parameters, see the chapter VoIP tests, 
page 154.

Starting VoIP telephony (example: operation on VDSL interface)

Connecting the service.








If no xDSL connection is established, 
ARGUS automatically connects at this 
point using the default profile (see 
page 50).

















<Edit> Assigns a virtual line to the 
service VoD or edits it.

<Info> Displays the VDSL connection 
parameters.

<Stop> Disconnects the VDSL connection

<Setting> Displays the PESQ settings, 
see page 294.

Continued on next 
page
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g 
 

ARGUS dials the number entered under 
"VoIP destination" in the PESQ 
parameters.




Test result:

ARGUS displays the set mode (in this 
example ARGUS loop) and the PESQ 
value calculated according to ITU-T P.862.

The PESQ quality scale ranges from +4.5 
(excellent) to -0.5 (bad).
These values may be assessed 
analogously to the MOS values 
(see page 160).


Exits results.

For saving results, see IP ping on 
page 129.
Sends trace file to PC, see page 100

<Test 
status>

Displays test status without endin
the test or starting a new test, see
page 208.

Synchronisation 
with PESQ server

Save result?
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21.3 PESQ test on an ISDN access

ARGUS in the main menu (BRI or U-
interface) must be selected as the access.






Select a voice service, e.g. ISDN 
telephony.


Enter the B-channel using the number 
keys. ARGUS suggests the B-channel last 
used. Press <Delete> before entering a 
new B-channel. Entering * causes 
ARGUS to select a free B-channel. 
ARGUS indicates whether the B-channel 
is available.

ARGUS dials the number entered under 
"ISDN number" in the PESQ parameters.








In the event of synchronisation 
problems, varying the DTMF 
parameters may lead to a 
solution. Under the menu option 
"POTS", you can also change 
the corresponding DTMF 
parameters
- Level
- Duration
- Inter-digit interval 
for PESQ and ISDN.

Single tests

PESQ test

Select the service

Enter the B-channel

Select the PESQ server

Synchronising 
with the PESQ server
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Test result:
ARGUS displays the set mode (in this 
example ARGUS Loop) and the 
calculated PESQ value according to ITU-T 
P.862 as well as the POTS  MOSLQO 
(LQO = Listening Quality Objective) 
according to ITU-T P.800.1.

The PESQ quality scale ranges from +4.5 
(excellent) to -0.5 (bad).
These values may be assess analogously 
to the MOS values (see page 160).



ARGUS saves the result in memory under 
the first free record number; you can enter 
a record name of your choice (default: 
New result) using the number keys.

21.4 PESQ test on an POTS access

ARGUS in main menu (POTS must be 
selected as the access).



ARGUS dials the number entered under 
"Number POTS" in the PESQ parameters.





The test result is displayed as described 
for the PESQ test on the ISDN interface.

Observe the information under 
(s. chapter. 21.3 PESQ test on 
an ISDN access page 298).

Save result?

Single tests

PESQ test

Select the PESQ server

Synchronising 
with the PESQ server

POTS PESQ test running
ARGUS 155 299



22 Copper tests
22 Copper tests

In the Access menu, ARGUS offers the menu option "Copper tests", which enables you to 
investigate the physical properties of the line.
This chapter briefly describes how to use the various functions. It is not possible to describe 
the interpretation of the results in the customary detail here. As the results are usually 
provided in graph form, they can only be interpreted correctly in conjunction with a know-
ledge of the line being measured. ARGUS supports this using a variety of aids, such as the 
Zoom and Cursor functions.

Note: 
The Ethernet cable tests (including Ethernet-TDR) are described in chapter „23 Ethernet 
cable tests“ (see page 333).

22.1 R measurement

When connected to the test points via the Line socket, ARGUS continuously measures 

resistance and displays the results in real time.

The chapter "Configuring accesses", page 27, explains how to set up the access type 
"Copper tests".

ARGUS in the status display.
Any DC voltage on the line is indicated 
here. 





Continued on next page



The line must be de-energised and voltage free for R measurement!

R measurement is a two-wire measurement that measures the loop 
resistance (short-circuit) between Tip(a) and Ring(b).

<Setting> Switches to Copper/cable test 
settings..

<Menu> Switches to main menu.
<Start>   Directly accesses "Single 

tests" menu.

Copper tests
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22.1.1 Wire types



 

Selects the wire types to be 
configured.







<Edit> Edits the wire-type parameters.

Setting Description

Wire type/VoP

Propagation 

speed

To determine the distance, the calculation must take into account a 
correction value dependent on the wire type that specifies the ratio 
of the pulse propagation speed in the cable to the speed of light in a 
vacuum (c0 = 299.792458 m/µs). 
For many cable types, the pulse time is also specified in V/2.
Minimum: 45.0 m/μs (VoP in %: 30)
Maximum: 149.7 m/μs (VoP in %: 99.9)
Default: 98.9 m/μs (VoP in %: 66.0)
The choice of propagation speed as VoP or V/2 is saved.

Line resistance Sets the line resistance per kilometer.
Range: 20 Ω/km to 200 Ω/km
Default: 80 Ω/km
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The configured cable types are also used for RC measurement and TDR 
measurement.

List of preconfigured default wire types:

Capacitance Sets the capacitance (operating (mutual) capacitance) per 
kilometer.
Range: 35 nF/km to 100 nF/km
Default: 39 nF/km

Name Enter the name of the wire type.
Default: PE 0.5 AWG24

No. Name Wire 
diameter
(mm)

Line 
resistance
(Ohm/km) 

Mutual 
capaci-
tance
(nf/km)

VoP
(%)

Note

1 PE 0.5 AWG24 0.5 80 39 66.0 Outdoor cable, Poly-
ethylene, air filled

2 PP 0.5 AWG24 0.5 80 39 66.0 Outdoor cable, Poly-
propylone, air filled

3 Pulp 0.4 AWG26 0.4 150 36 60.0 Outdoor cable, conductor 
with pulp jacket, air filled

4 Pulp 0.5 AWG24 0.5 80 39 67.0 Outdoor cable, conductor 
with pulp jacket, air filled

5 Pulp 0.6 AWG22 0.6 65 38 68.0 Outdoor cable, conductor 
with pulp jacket, air filled

6 PIC 0.4 AWG26 0.4 150 36 64.0 Outdoor cable, conductor 
with plastic jacket, air filled

7 PIC 0.5 AWG24 0.5 80 39 66.0 Outdoor cable, conductor 
with plastic jacket, air filled

8 PIC 0.6 AWG22 0.6 65 38 67.0 Outdoor cable, conductor 
with plastic jacket, air filled

9 PIC 0.9 AWG19 0.9 29 34 72.0 Outdoor cable, conductor 
with plastic jacket, air filled

10 Jelly 0.9 AWG19 0.9 29 34 68.0 Outdoor cable, petroleum/
jelly filled cable

11 Filled 0.4 
AWG26

0.4 150 36 58.0 Outdoor cable, filled

12 Filled 0.5 
AWG24

0.5 80 39 60.0 Outdoor cable, filled
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22.1.2 Starting R measurement

ARGUS status display.
Any DC voltage on the line is indicated 
here. 
- Max. measuring range: 200 V
- Resolution: 0.1 V
- Accuracy: ±2 %.


Before starting the RC measurement
disconnect any voltage on the line.

Select one of the Copper tests:
- Copper box
- R measurement
- RC measurement
- etc.


Start the desired copper test directly by 
selecting it.
In this example, R measurement.

13 Filled 0.6 
AWG22

0.6 65 38 62.0 Outdoor cable, filled

14 PTFE/Teflon 0.5 
AWG24

0.5 80 39 67.0 Outdoor cable, conductor 
with teflon jacket

15 Wire type 15 - 80 49 66.7 default, editable

16 Wire type 16 - 80 49 66.7 default, editable

17 Wire type 17 - 80 49 66.7 default, editable

18 Wire type 18 - 80 49 66.7 default, editable

19 Wire type 19 - 80 49 66.7 default, editable

20 Wire type 20 - 80 49 66.7 default, editable

Conversion of AWG to mm and mm to AWG:

<Menu> Switches to main menu.
<Start> Directly accesses the single 

test menu or starts the RC 
measurement (depending on 
options).Single tests

R measurement
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Initialisation

Loop:

The R measurement starts automatically.





In this example, the R measurement 
shows a resistance of 388 . This is the 
resistance for the entire core system, in 
which the a-core (tip) and the b-core (ring) 
are short-circuited (loop). This makes the 
two cores equivalent to a single core with 
a length of 388 /353  km = 1.1 km, see 
equivalent circuit diagram.


ARGUS generates a signal tone 
for a resistance < 20 

  <> Deactivate signal tone

Equivalent circuit diagram:

Loop resistance = 2x resistance

ARGUS alway calculates the length of the circuit. 
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22.2 RC measurement

ARGUS conducts a resistance test (loop) and a capacitance test (open). ARGUS is 
connected to the test points via the socket Line. Switch on ARGUS.

The chapter "Configuring accesses", page 27, explains how to set up the access type 
"Copper tests".


ARGUS status display.
Any DC voltage on the line is indicated 
here. 
- Max. measuring range: 200 V
- Resolution: 0.1 V
- Accuracy: ±2 %.

Before starting the RC measurement
disconnect any voltage on the line.

Select one of the Copper tests:
- Copper box
- R measurement
- RC measurement
- etc.

Start the desired copper test directly by 
selecting it.
In this example, RC measurement.



The line must be de-energised and voltage free for RC measurement!


When testing capacitance, note that the measured capacitance value 
can be falsified if a large capacitance is connected in series with a 
resistor.
RC measurement is a two-wire measurement that measures the loop 
resistance (short-circuit) and the capacitance (open line) between Tip(a) 
and Ring(b).

<Menu> Switches to main menu.
<Start> Directly accesses the single 

test menu or starts the RC 
measurement (depending on 
options).

Continued on next page or

Single tests

RC measurement
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ARGUS first measures the resistance. 
ARGUS determines the capacitance 
when it detects an open line (infinite 
resistance).

ARGUS displays the resistance. The 
capacitance is not displayed because a 
loop is used in this example. ARGUS also 
determines the approximate line length, 
see equivalent circuit diagram page 304.
 

Resistance test: 20  to 100 k  
Accuracy: 20  ≤ R ≤ 100 : ±10 % 
                            R > 100 : ±2 %

ARGUS displays the capacitance. The 
resistance is outside the possible range 
(> 100 k).

Capacitance test: 1 nF to 1 µF 
Test accuracy: ±5 %


Browse through the wire 
types.

<Wire 
types>

Switches to the wire types.

<New> Repeats measurement.

Switches to status display.


Browse through the wire types.

<Wire 
types>

Switches to the wire types.

<New> Repeats measurement.

Switches to status display.

Loop:

Repeat test

Open line:

Repeat test
306 ARGUS 155



22 Copper tests
22.3 Line scope

With the line scope, ARGUS performs a real-time analysis on the connected line. The high-
ohm line scope can e.g. be patched into an existing link between modem and DSLAM. 
You can display the results in either the time or frequency range (FFT).

22.3.1 Starting the line scope

Continued on 
next page

The chapter "Configuring accesses", page 27, explains how to set up the access type 
"Copper tests".




ARGUS status display.
Any DC voltage on the line is indicated 
here. 



<Menu>

<Start>



 
Select one of the Copper tests.
- Copper box
- R measurement
- RC measurement
- Line scope
- TDR

Start the desired copper test directly by 
selecting it.

In this example, the line scope.

The voltage on the line may not exceed 200 V DC or 100 Vpp AC.

Switches to main menu.

Directly accesses "Single 
tests" menu.
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Line scope status display

The line scope can identify a variety of 
states or occurrences on the line. 
This example shows the ADSL (Annex B) 
connection with ISDN-U interface estab-
lished between the modem and DSLAM.
The line scope is located in direct proxim-
ity to the modem, as it is particularly effec-
tive upstream in the spectrum. 
If the upstream were significantly less than 
the downstream, it would be in direct prox-

imity to DSLAM.
<Menu>


Finding the modem:
In addition to the general state of the line/
connection, a variety of events can be 
detected. 
In this example, we can see the hand-
shake tones that a modem connected to 
the line sends periodically in order to 
establish a connection with the DSLAM. 
This also reveals whether or not an active 
modem is connected to the other end of 
the line.


In addition to the wanted signals such as the DSL spectrum or the handshake tones, the 
line scope can also detect unwanted signals such as temporary interference sources (real-
time operation) or peculiarities in noise (with respect to background noise).

Connection example without probe:



Opens the graph function, see 
page 310
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Gain:
To ensure optimum detection of different signals, match the gain (y-axis) with the reduction 
of the frequency range shown (x-axis). ARGUS always begins with the lowest gain (-26 dB 
in the frequency range up to 3 MHz). Measuring range: -130 to +10 dBm/Hz.

 
Gain-Y: Gain settings:
-26 dB, - 20 dB, 0 dB, 20 dB

ARGUS displays all measurement results as dBm/H
values. These values are only comparable with oth
when the resolution of the measured frequency ban
taken into account, as here the total energy of the 
frequency band is determined "per Hz". The bandw
ARGUS is measuring is indicted in the display as Δ




Frequency range:
A frequency range of from 20 kHz to 30 MHz is available for measurement; the resolution 
varies depending on the selected range.



The bandwidth Δf at the top right in the 
display shows which frequency range 
is being shown in the display.

 Frequency-X: Setting the 
displayed frequency range. Every 
press of the cursor key halves, 
respectively doubles the displayed 
range.




Example:

In a measuring range up to 32.768 MHz, 
up to 2048 values can be displayed, so:
Δf = 32,768 MHz / 2048 values = 16 kHz.
Consequently, a y-value marked by the 
cursor and displayed (in this example 16 
MHz) is the mean (in this example -133.3 
dBm/Hz) across the frequency range of 16 
MHz - Δf/2 to 16 MHz + Δf/2, or 15.992 
MHz to 16.008 MHz.
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22.3.2 Graph functions





The graph functions Zoom and Cursor 
enable detailed analyses of the graphs.

<Menu>





Press  in the status display (in the graph) to save the results and stop 

the line scope.  

The "Graph functions" menu opens:


Zoom (2):
The magnifying glass shown in the display 
rests on a white background. 
It has not yet been zoomed. 
When the magnifier is over a dark 
background, the graph is zoomed.

<Zoom(x)++>

<Zoom(x)--> Not yet zoomed! Reverses 
<Zoom(x)++> and resets 
magnification.

 lets you toggle the meaning of the softkeys and choose between x-axis and y-axis 

zoom, see page 56.

Opens graph functions.

Exits the menu without changing.

You can also use this number 
key to activate the Zoom function 
within a graph. 

The function of the cursor is 
described on page 311.

Accepts the selection and returns 
to the graph.

Magnifies the middle section of
the graph (100%).
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Cursor (3):

When the Stop function 
(see page 316) is activated, you 
can move the cursor faster.

When the Cursor function is started, a 
green cursor line appears in the middle of 
the graph.

<Cursor>



The values of the graph for the position 
under the cursor are displayed in the 
graph as follows:
x:

y:



The zoom function and the cursor function can also be combined. For example, you can 
determine a certain value using the cursor more easily when you have previously zoomed 
in on a specific range. However, the starting position of the cursor can vary.

Measuring range (4):

When the line scope starts, it is in the 
measuring range in the status display. You 
can set the frequency range (x) and the 
gain (y) in the measuring range. If you 
have hidden the measuring range in order 
to work with the cursor or zoom, you can 
restore it:
 
<Menu>

or 

You can toggle the cursor on 
and off as needed using the 
Cursor softkey after activating it 
in the menu.

 +1024 kHz (accuracy ± 1 %)

 -63.4 dBm/Hz (accuracy ± 2 dB)

You can use the left and right 
cursor keys to move the 
cursor to any position on the 
graph to measure it.
Briefly pressing a cursor key 
causes the cursor to jump to 
by one position in the graph. 
When the cursor key is held 
down, the steps the cursor 
covers in the graph become 
progressively larger.


Restores measuring range.
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Total power (5):

ARGUS displays the total power. The total 
power is the sum of all individual power 
measurements (Δf)  over the entire visible 
range, in this example -299 dBm over 
2.2 MHz.

<Menu>

or 

Probe (7):
The line scope is high-ohm.
Input impedance: 3.6 k
Input capacitance: 30 pF

However, even with the line scope you 
may also need to use a high-ohm probe 
(ARGUS Active Probe).




ARGUS Active Probe II:
Input impedance: 70 k
Input capacitance: 1 pF
Functions: Symmetry/asymmetry toggling

After connecting the probe, you can switch 
it on using this menu.






Restores total power display

To activate the probe, see 
page 319.
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Symmetry (8): 

Once the probe has been switched on and 
detected, you can switch between sym-
metric and asymmetric operation using 
Symmetry.
In asymmetric operation, the useful signal 
is hidden so that you see only noise and 
any interference sources (see example 
illustration).

Time domain (9):

<Menu>

or 



In the line scope, you can switch from the 
frequency range to the time domain. In 
this respect, the line scope operates like 
an oscilloscope that permits display of AC 
voltages from 0 to 40 Vpp with a resolution 
of 2 mVpp. 
This makes it easy to recognize different 
AC voltage signals, e.g. the square-wave 
signal of an E1 access.

      

If ARGUS detects that the connected 
signal regularly exceeds a certain thresh-
old, ARGUS tries to trigger automatically 
in response to this so as to optimally 
display the signal in the time domain.

The trigger symbol is green. 
If no signal is present or the level is too 
low, the trigger symbol is red. ARGUS 
does not trigger.

Symmetry/asymmetry toggling


Opens time domain



The gain and time base can be set using the horizontal and vertical cursor 
keys analogous to the frequency range.

The cursor functions are also available in the time domain for analysing the 
signal. However, there is no zoom function.
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Peak hold (min/max) (0):

The peak-hold function can be additionally 

activated using the number key .

When the peak-hold function is used, positive (blue) and negative (yellow) peaks are 
shown graphically. The result is a blue curve of maxima and a yellow curve of minima over 
time. The instantaneous values continue to be displayed in red. 
In the maximum values in particular, sporadic fliers (interference pulses) are visible and 
permit comparison between different lines (e.g. particularly clearly with the aid of a suitable 
clip-on ammeter). 

100 Ohm Input resistance (#):

Particularly when using a suitable clip-on 
ammeter, it may be necessary to adjust 
the input resistance of the line monitor 
(input impedance, see page 312). The red 

symbol indicates that the line monitor 
is operating with an input resistance of 
100 ..
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Reference curve (*0):

<Menu> or

 amd 

<Set>

When the reference curve is set, an 
orange line is displayed in the graph. 

<Hide>

<Set>

Restores reference 
curve function.

Set reference curve.

Hide reference curve. 

Set a new reference curve. 
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Run/Hold


You can stop and restart a running test 
(realtime mode) at any time.









Test running

Stop test

Test is stopped

Restart test
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Clipping:
Frequency range:

Time domain:



If the signal at the line scope input is too 
strong or the gain in the frequency range 
and time domain are displayed as too large, 
the input stage of the line scope is over-
driven.
In this case, ARGUS displays the clipping 

symbol . 

The displayed signal is clipped both in the 
frequency range and the time domain. You 
can remedy this by reducing the gain. 










Saving test results without terminating the line scope
You can save your results of the measurement without disconnecting in the same way as 
for VDSL, see page 72.
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22.4 Active Probe

The ARGUS Active Probe is an active, high-impedance probe that can be passively 
patched into an existing connection without interfering with it.



The ARGUS Active Probe II is designed to be used with the ARGUS line scope. The high-
ohm line scope (input impedance 3.6 k) can also be used without the ARGUS Active 
Probe II (see page 310).

22.4.1 Active Probe II

The ARGUS Active Probe II has the following technical specifications:
 - Input impedance: 70 k 
 - Input capacitance: 1 pF
 - Frequency range: 10 kHz to 30 MHz (± 1.5 dB)
 - Attenuation, symmetrical 14.5 dB
 - 2 x 4 mm banana plug sockets (spacing 12 mm)
 - Data transmission to ARGUS via RJ45 lead (pins 4/5)
 - Supply voltage: 5 V via ARGUS USB-host interface and USB cable

The Active Probe II can be operated in both symmetric and asymmetric mode. You can 

switch between these two operating modes using the hotkey  or via the menu. See 

page 313, line scope for an application example.


The Active Probe II:

In spite of the high impedanceprobe, it can cause transient losses of existing 
connections when it is patched in.
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22.4.2 Connecting the Active Probe II

Connect ARGUS to the Active Probe II via the Line socket and the USB-A interface (host). 
ARGUS supplies the Active Probe with a voltage of 5 V via the USB host interface.
Connect the Active Probe to the line to be tested (in this example Active Probe II between 
modem and DSLAM) using a lead that is as short as possible (< 5 cm).

Connection example:



22.4.3 Starting Active Probe II (example with line scope)



After starting a test (in this example with 
Line scope), you can open the Probe 
menu using the graph functions or the 

number key .

Continued on 
next page



The connection cable and adapter supplied with the device have been 
designed to be as short as possible. The Active Probe II should be operated 
using leads that are as short as possible. To obtain optimum measurement 
results, it is important for the Active Probe to be connected in direct proximity 
to the line to be tested. Every extension of these connecting leads increases 
the input capacitance of the Active Probe, which can falsify the measurement 
results. Even the positions of the two leads in relation to each other can falsify 
the results as the lengths increase. When the Active Probe is used as 
supplied, ARGUS automatically subtracts the additional attenuation from the 
measurement results.
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 yes









Select "yes" to use the probe.
ARGUS then switches on the supply
voltage to the USB-A interface and auto-
matically subtracts the additional 
damping caused by the Active Probe 
from the measuring results.

When the Active Probe is active and 
properly supplied from ARGUS, the 
green LED on the probe lights up. 


A green tick mark in the lower right of the 
display indicates during a test that the 
Active Probe is connected correctly.






If the Active Probe is not connected 
correctly and thus not detected by 
ARGUS or intentionally deactivated via 
the Probe menu, ARGUS displays an 
exclamation point in the lower right of 
the display.

Opens the Probe menu directly.

Activation of the probe can take 
up to 10 seconds.
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Toggling symmetry/asymmetry:


See the Line scope description on 
page 313 for an example for toggling 
symmetry/asymmetry.










Once the test is started and Active Probe 
II activated, you can toggle the probe input 
between symmetric and asymmetric 

operation using the number key .










When switched to asymmetric mode, 
ARGUS displays possible interference 
sources and the line noise. The usable 
signal is hidden.

Saving test results without terminating the Line scope
You can save your results of the measurement without disconnecting in the same way as 
for VDSL, see page 72.
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22.5 TDR

The TDR function enables you to determine line lengths in realtime or localise interference 
sources. Correct interpretation of the pulses displayed by ARGUS permits e.g. detection of 
stub lines, poor contacts or short-circuits. For this purpose, ARGUS transmits a pulse on 
the connected line and displays its reflection response.

22.5.1 TDR settings

The chapter "Configuring accesses", page 27, explains how to set up the access type 
"Copper tests".

22.5.2 Starting TDR

The chapter "Configuring accesses", page 27, explains how to set up the connection type 
"Copper tests".

Continued on 
next page

TDR



ARGUS status display.
ARGUS indicates any DC voltage on the 
line. 


<Setting>

<Menu>

<Start>   




Select and start TDR.

The line may not carry a DC voltage greater than 200 V DC and must be free 
of AC voltage components.

The result of a TDR measurement in the ARGUS display may give the 
impression of multiple interference sources on the line. It is recommended that 
you eliminate the first interference source on the line and then repeat your 
measurement. It is possible that the first interference source caused one or more 
reflections, which can greatly falsify the reflection at the second interference 
source. Often, there is no second interference source on the line.

ARGUS generates a reflection at approx. 3 m. To precisely measure short lines 
and avoid this reflection, using e.g. a 5 m long connection lead is recommended. 
The pulse continues to be displayed in the graph but using the cable ensures that 
this is not on the line.

Switches to the settings for the 
wire-type list, see page 301.

Switches to main menu.

Directly accesses "Single 
tests" menu.
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TDR status display:

Gain:

Range:



ARGUS displays possible interference 
sources on the copper twisted pair 
directly.
In this example, after the input pulse 
(starting at 0 meters) we can see a second 
pulse that spikes at approx. 150 m. This 
can indicate a 150 m long line that is open 
at its end.

The adjustable range, the gain and the 
graph functions permit more detailed 
analysis.



To ensure optimum detection of pulse 
reflections, match the function for adjust-
ing the gain (y-axis) with the reduction/
enlargement of the range shown (x-axis).
ARGUS always starts with the lowest gain 
(-26 dB) at a range of 1500 meters.

 
Gain-Y: Sets the gain
from -26 dB, -20 dB, 0 dB, +14 dB 
+24 dB, +34 dB, +44 dB




The measurements with the TDR can take 
place in a measuring range of from 3.5 to 
6000 meters. The resolution is approx. 0.3 
% of the displayed measuring range. 

 The accuracy is approx. ±2 % of the 
measuring range. When determining 
the distance, try to determine the 
start of a pulse where possible, and 
not the relative maximum.



Range-X: Sets the displayed 
measuring range. Every press of 
the cursor key halves or doubles 
the displayed range.
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22.5.3 Graph functions


The graphic functions Zoom and Cursor 
enable detailed analyses of the graphs.





<Menu>

Press  in the status display (in th

graph) to save the results and stop th
TDR function.

Zoom (2):

Continued on 
next page

The Graph functions menu opens.


The magnifying glass shown in the display 
rests on a white background. 
It has not yet been zoomed. 
When the magnifier is placed over a dark 
background, the graph is zoomed.

<Zoom(x)++>

<Zoom(x)--> Not yet zoomed! Reverses 
<Zoom(x)++> and resets 
magnification.



When zooming, the y-axis always remains 
at 100 %. No y-axis zoom is available.

Opens graph functions

Exits the menu without changing.

You can also use this number 
key to activate the Zoom function 
within a graph. 

The function of the cursor is 
described on page 325.

Accepts the selection and returns 
to the graph.

Enlarges the middle section of
the graph (100%).
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You can vary the graph size from 25% to 
100% using the zoom softkeys. This 
doubles or halves the resolution.
When concurrently using the cursor, you 
can precisely localise the reflection on the 
measured line.








When the Cursor function is started, a 
green cursor line appears in the middle of 
the graph.
<Cursor>




The values of the graph for the position 
under the cursor are displayed below the 
graph:

x:




The Zoom function and the Cursor function can also be combined. For example, you can 
determine a certain value using the cursor more easily when you have previously zoomed 
in on a specific area. However, the starting position of the cursor can vary.

You can toggle the cursor on 
and off as needed using the 
Cursor softkey after activating it 
in the menu.

 
+151.4 m

Use the left and right cursor 
keys to move the cursor to any 
position on the graph to 
measure it. Briefly pressing the 
cursor key causes the cursor to 
jump to a new position in the 
graph. When the cursor key is 
held down, the steps the cursor 
covers in the graph become 
progressively larger.

Cursor (3):

When the Stop function (see 
page 328) is activated, you can move 
the cursor faster.
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Measuring range (4): 

When the TDR function starts, it is in the 
measuring range in the status display. You 
can set the range (x) and the gain (y) in 
the measuring range. If you have hidden 
the measuring range in order to work with 
the cursor or zoom, you can restore it:

<Menu>

or

Pulse width/height (5): 

You can configure the width and height of 
the pulse that ARGUS outputs to the line.









Height:
The pulse height sets the level of the pulse ARGUS outputs to the line in volts. The default 
value is 5 V, but can be increased to 20 V. In principle, it is recommended that you increase 
the pulse height as the distance increases. 
On short, very noisy lines as well, increasing the pulse can make the reflection stand out 
better against the noise, for a more reliable interpretation.

Width:
The pulse width sets the duration of the pulse ARGUS outputs to the line in nanoseconds 
(ns). The default value is 500 ns, but you can increase this up to 2000 ns (2 µs) depending 
on the measuring range. Just like a more powerful pulse, a longer pulse contains more 
energy, and thus is generally more suitable for use on longer lines. However, a longer pulse 
can also conceal important reflections, which can then no longer be correctly interpreted.


Restores the measuring range



Configuring the pulse
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Wire types (6):
The absolute VoP value must always be less than 1. However, ARGUS always displays 
this in percent. In a wire with a VoP value of 0.7, a signal propagates at 70 % of the speed 
of light (c0). 
For many cable types, the pulse time is also specified in V/2: V/2 = VoP [%] * 1.5. In this 
example, the V/2 value would come to 95.5 m/µs for a VoP of 0.637 resp. 63.7 %. 
A typical patch cable has e.g. a VoP of 0.667 resp. 66.7%, which corresponds to a V/2 of 
exactly 100 m/µs.

To measure e.g. building wiring precisely, it is important to set the correct VoP 
value. You can determine the correct VoP using a reference cable of known length 
before the measurement.

Reference curve (*0):


In this example, the line is open at 
143.3 m (reference value).

<Set>

When the reference curve is set, an 
orange line is displayed in the graph. 
In this example, the line is terminated. 

<Hide>

<Set>

Set reference curve.

Hide reference curve.

Set a new reference curve. 
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Start/stop






You can stop and restart a running test 
(realtime mode) at any time.







Saving test results without terminating the TDR
You can save your results of the measurement without disconnecting in the same way as 
for VDSL, see page 72.

Test running

Stop test

Test is stopped

Restart test
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22.5.4 Examples

The following signal forms can help you in interpreting the reflection responses that 
ARGUS displays.

Examples:


Open cable
The reflected pulse is positive. No proxi-
mate interference sources or the far end of 
the line can be seen. 






Short-circuit
The reflected pulse is negative. No proxi-
mate interference sources or the far end of 
the line can be seen. 






Mismatch
Different line cross-sections were used. 
The greater the mismatch, the greater the 
amplitude of the reflection.





Poor contact point
A poor contact between two lines distorts 
the reflection into an S-shape. The worse 
the contact, the greater the reflection.
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Stub line
The beginning of a stub line appears in the 
form of a negative reflection, followed by a 
positive reflection corresponding to the 
length of the stub line when the end of the 
stub line is open.





Loading coils
Loading coils deployed on the line are 
optimally designed for transmitting voice 
frequencies. They do not let DSL signals 
through. The TDR function enables you to 
detect the first coil in a line. The reflection 
is positive with a long tail in the direction of 
the end of the line. The following faults 
cannot be detected.




Capacitive network
Like a short-circuit, the reflection from a 
capacitive network is negative.  






Moisture
Moisture penetrating the cable has the 
same effect on the reflection as a stub 
line. However, the zone between the 
negative and positive reflection appears 
significantly noisier than for a normal stub 
line.
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Loose/intermittent contact
Realtime operation is extremely suitable 
for detecting intermittent contacts. The 
amplitude of the positive reflections varies 
depending on the intermittent contact 
frequency. 





Open shielding
Broken or open cable shielding can be 
detected by connecting the “a“ and “b“ 
cores to ARGUS via one contact and the 
shielding to a second. The reflection looks 
like an open line.



Correct line termination
When the line is properly and correctly 
terminated, the pulse generated by 
ARGUS is completely absorbed. No 
further reflections are visible.
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23 Ethernet cable tests



The local loop must be voltage-free.

The Ethernet cable tests can only be performed on the LAN interface.

23.1 Configuring the Ethernet interface

Connect the local loop to the ARGUS socket "LAN" and switch on ARGUS. The chapter 
"Configuring the local loop", page 27, explains how to set up the connection type "Ethernet 
Cable Test".

23.2 Ethernet cable test settings

You can configure the following "Ethernet parameters". You can restore the default settings 
at any time (see page 357). The following example is used to illustrate how to modify a 
parameter.

Test not yet started: 
red LED in display!
Meaning of LED image in display:
Red LED: no test started

<Setting> Opens the Ethernet cable test 
setup, see page 333.

<Menu> Switches to main menu.
<Start> Starts the Ethernet cable test, 

see page 335.

Status screen

ETH cable tests

Settings

Copper/cable tests
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Select e.g. ETH/TDR cable test.

Setting Description

ETH TDR/cable tests: Configuring the cable test parameters.

Propagation 

speed

To determine the distance, the calculation must take into account a 
correction value dependent on the wire type that specifies the ratio of 
the pulse propagation speed in the cable to the speed of light in a 
vacuum (c0 = 299.792458 m/µs). 
For many cable types, the pulse time is also specified in V/2.
Minimum: 45.0 m/μs (VoP in %: 30)
Maximum: 149.7 m/μs (VoP in %: 99.9)
Default: 98.9 m/μs (VoP in %: 66.0)
The choice of propagation speed as VoP or V/2 is saved.

Line resistance Sets the line resistance per kilometer.
Range: 20 Ω/km to 200 Ω/km
Default: 80 Ω/km

Capacitance Sets the capacitance (operating (mutual) capacitance) per kilometer.
Range: 35 nF/km to 100 nF/km
Default: 39 nF/km

Name Enter the name of the wire type.
Default: PE 0.5 AWG24

ETH port flash

Interval that ARGUS keeps the port active before performing a link disconnect. The 
disconnect time depends on the switch.
Range: 1 - 5 seconds
Default: 1 s
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23.3 Ethernet cable test 

The Ethernet cable test checks for faults in LAN cabling. ARGUS interprets the 
measurement result and determines whether this indicates an open line, a short-circuit or a 
mismatch.

23.3.1 Starting Ethernet cable test

<Setting>

<Menu>

<Start>


ARGUS in the status line.

Select one of the Ethernet tests:
- ETH TDR/cable test
- ETH port flash

Start the desired Ethernet test directly by 
selecting it.
In this example, this is the ETH/TDR cable 
test.

The Ethernet TDR/cable test is executed.

Opens the Ethernet cable test 
settings, see page 334.

Opens the main menu.

Starts Ethernet cable test.

The Ethernet TDR should always 
be measured at both ends of the 
cable. This reveals e.g. contact 
problems at the remote line end in 
the second, twisted test, as this 
type of fault can not be 
distinguished from the line end. 
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The cable test was executed with "First 
peak" mode. 

Display:

In this example, the line is correctly termi-

nated. ARGUS returns "OK" for all cores.
<Max>

<New>

If no line is connected, the device may deliver false results.


The Ethernet cable test is standard-compliant to a length of 100 m.

- Pin pair
- Status of respective pin pair
- Display of distance to fault.
- Reflection coefficient

Switches the measuring mode 
to "Maximum peak".

Starts a new test.
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Example measurements:

Open end
In this example, the line is open on all 
pairs. ARGUS locates the fault in the area 
from 49.3 m to 51.7 m. 
This indicates that the line is open at 
approx. 50 m.

Short
In this example, the line is short-circuited 
between pairs 1-2 and 7-8. ARGUS 
displays the value "Short" as the status.

Mismatch
This example shows a mismatch (>115  
at pairs 3-6 and 4-5. This indicates an 
open cable end or an impedance 
transition >115 
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Mismatch
This example shows a mismatch (<85  
at pairs 3-6 and 4-5. This indicates a short 
or an impedance transition <85 
338 ARGUS 155



23 Ethernet cable tests
23.4 Ethernet port flash

ARGUS can identify the port currently in use on the Ethernet switch using the test "Ethernet 
port flash". To facilitate identification, the flash frequency at the switch can be set in 
ARGUS.

23.4.1 Starting Ethernet port flash

<Setting>

<Menu>

<Start>


ARGUS in the status line.

Select one of the Ethernet tests:
- ETH TDR/cable test
- ETH port flash

Start the desired Ethernet test directly by 
selecting it.
In this example ETH port flash.

The Ethernet port flash test is executed.

Opens the Ethernet cable test 
settings, see page 334.

Opens the main menu.

Starts Ethernet cable test.
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23 Ethernet cable tests
The test "ETH port flash" has been 
executed. 

Display:
- Indication whether the port LED is 

flashing (in example "off").
- Link speed attained.
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24 Test results

The saved test data are displayed either in the ARGUS display or on the PC. You can 
transfer the results to the PC, where the software WINplus / WINanalyse generates a 
detailed measurement log (along with other functions).

ARGUS stores the test results together in 50 definable save slots. The system suggests 
"New result" as the default save name. The saved test results are also deleted when all 
configuration settings are reset.
The functions ("View", "Rename", "Send to PC", "Delete") in the Test results menu refer to 
one test result. You must thus first select a save slot with a test result:


ARGUS in Main Menu

When ARGUS is in the selection list for 
preconfigured accesses, you can switch to 

the abbreviated main menu with .


ARGUS displays the name of the stored 
result and the number of occupied slots.

When multiple test results are saved, 
ARGUS lets you sort them by name and 
time (as in this example). You can also 
sort them manually.
<Sort 
time>

Sorts test results by time.

<Sort > The marked test result is moved
up one place in the list.

<Sort > The marked test result is moved
down one place in the list.

<All> Deletes all test results or send to
PC.

Test results
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e.

, 

us 
24.1 Saving test results

You can save the result after the end of a 
test or after disconnecting a connection.


ARGUS saves the test result in the first 
free slot. If all slots are occupied, you need 
to manually select a slot to overwrite.

ARGUS proposes "New result" as the 
save name.

You can accept the displayed save name 
or enter a new one using the number keys. 
The right softkey changes its meaning 
when pressed, affecting your entry. You 
can enter up to 24 characters. ARGUS 
displays the number of characters used so 
far.

<Last 
name>

ARGUS suggests the last save 
name used. 

<Ab>AB> Entry begins with upper-case 
letters and continues in lower-cas

<AB>12> Entry of upper-case letters.

<12>ab> Numerical entry.

<ab>AB> Entry of lower-case letters.

Entry of special characters, e.g. @
/, -, ., *, ?, %, =, &, ! etc.

Entry of special characters 
e.g. _, :, +, # etc.

<Delete> Deletes the place in front of the 
cursor.

Moves cursor

Don't save result, return to previo
display.

Save result
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24.2 Displaying saved test results

ARGUS in Main Menu

When ARGUS is in the selection list for 
preconfigured accesses, you can switch 

to the abbreviated main menu with .




24.3 Sending test results to a PC

You can send the test results to a PC for viewing and archiving. Connect ARGUS (ARGUS 
socket "USB-B") to the interface of your PC using the cable supplied with the device and 
start the software WINplus or WINanalyse.

ARGUS in Main Menu

When ARGUS is in the selection list for 
preconfigured accesses, you can switch 

to the abbreviated main menu with .






Select a save slot (in this example 
selection of the first slot with the 
save name "New result").

Select a save slot (in this example 
selection of the first slot with the 
save name "New result").
All test results are transmitted.

Test results

New result

View

Display of test result

Test results

New result

Send test results to PC

Start data transmission to PC
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24.4 Delete test results

ARGUS in Main Menu

When ARGUS is in the selection list for 
preconfigured accesses, you can switch 

to the abbreviated main menu with .


Deletes the test result stored in the 
selected slot.

To deletes all test results, see on page 
357 “Restoring the factory settings”.

24.5 Sending all test results to PC

ARGUS transfers all saved test results to the connected PC. Connect ARGUS to the PC 
and start ARGUS WINplus or WINanalyse.

ARGUS in Main Menu

When ARGUS is in the selection list for 
preconfigured accesses, you can switch 

to the abbreviated main menu with .



Select a save slot (in this example 
selection of the first slot with the save
name "New result").

Test results

New result

Delete

The test result is deleted.

Test results

Send to PC

Start data transmission to PC
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24.6 Deleting all test results

ARGUS deletes all saved test results from its internal memory. 

ARGUS in Main Menu

When ARGUS is in the selection list for 
preconfigured accesses, you can switch 

to the abbreviated main menu with .









Test results

Delete

Confirm the security prompt with 
<Yes>; all 50 possible test results 
are deleted.
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25 WLAN

You can make your ARGUS WLAN-capable with the ARGUS-WLAN option (Article no.: 
015550) or the ARGUS-WLAN kit (Article no.: 015551). The WLAN-option and the WLAN 
kit each contain a USB nano WLAN stick and an options key (see "Software option", 
page 354). You must enter this in ARGUS one time.

You only need the WLAN kit (or the ARGUS USB mini-hub) if your ARGUS only 
has one USB host interface and you wish to connect two USB devices (e.g. 
WLAN + ARGUS Copper Box). 

Always insert your USB devices in the hub first before you power up ARGUS.

Technical features:

USB nano-stick

Interface USB 2.0 type A 

Antenna internal 

WLAN standard IEEE 802.11 b/g/n

Encryption WPA2

 

WLAN USB 
Nano Stick

ARGUS Mini 
USB Hub

Options key

WLAN option
(Article no.: 015550)
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25.1 Starting WLAN

Access list or any point in the menu.

ARGUS manager display

- M-interface ETH / WLAN, see page 351

- LCD brightness, see page 350

- Automatic shutdown, see page 353

- Auto. charge, see page 359

- VNC server start, see page 351

You can activate/deactivate or change 

settings using the cursor key . 

The WLAN interface is now activated. 

See page 351 for WLAN settings such as 
SSID, password, channel, etc.

 Switch on ARGUS

kurz

rechts
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The WLAN interface is now activated. ARGUS is now in access-point mode (ARGUS-AP). 
The WLAN symbol in the status line is green .

You can set up a WLAN connection with ARGUS by selecting the WLAN access with the 
name Argus155_SerialNumber on a smart phone, tablet or laptop and entering the 
password stored in ARGUS.

Electronic job management applications can also access ARGUS and pick up 
measurements using WLAN.

25.2 Test results via WLAN

If for example a laptop has a working WLAN connection with ARGUS, you can open the 
Web server by entering the IP address of the ARGUS unit (see page 352) or myargus.info 
in your browser's address bar.

The test results with the name data.csv can be 
opened directly or saved on the laptop. You can 
also use this functionality to save, delete and 
rename measurement logs. For this, you require a 
WebDAV application/app on your PC/laptop or 

smart phone/tablet. 

The .csv file contains the connection 
parameters of the last measurement 
conducted.

The command "VNC" lets you control ARGUS 
remotely via your browser.


You may first need to activate the VNC server on ARGUS, see page 351.

Further information regarding the VNC server is available on request.

The ARGUS Web server has its own SSL certificate (myargus.info), which permits 
https:// access. 

You can also access ARGUS using WebDAV via myargus.info. By this means, 
you can download measurement logs in .amp format directly from ARGUS via 
Ethernet or WLAN.
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25.3 WLAN in router mode

When the ARGUS WLAN interface is active, it is always connected directly with the 
ARGUS router. If you want to use ARGUS as a true WLAN access point (ARGUS-AP) and 
e.g. start a download with this device as the gateway, you must first start a DSL access 
(ADSL, VDSL, SHDSL, see page 50).

If the router (see diagram) has been 
started, both WLAN and LAN are 
connected to the ARGUS router.

The smart phone, tablet or laptop can use ARGUS as an access point. All applications 
such as data, VoIP or video that can be run e.g. on a smart phone can now be executed to 
test the connecting devices via ARGUS - thus replacing all customer devices. 

WLAN and LAN are not linked via an Ethernet bridge. Each requires its own 
configuration. They may not be configured identically. A test from WLAN to LAN or 
vice-versa is not possible.
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26 ARGUS settings

ARGUS can be custom-configured for special requirements. The default values are 
restored using "Reset" (see page 357).

26.1 Configuring the device

Changing a device setting is described using the setting "Alarm tone" as an example.

ARGUS in Main Menu

When ARGUS is in the selection list for 
preconfigured accesses, you can switch 

to the abbreviated main menu with .


Select a setting (e.g. Alarm tone) using 
the cursor keys.

The default is indicated with a  in the 
display.

Mark the desired setting. The 
marked setting is highlighted in 
blue in the display. 

Return to next-higher level menu 
without saving setting change.

Setting Description

Menu 

language

Select the operating language
Default: depends on country

LCD
brightness

Sets display contrast: 16 contrast levels are possible. You can increase or 
decrease the contrast using the cursor keys. The vertical arrow shows where
the current contrast lies in the range from low to high contrast.  

Date / time 

setting

Enter the date, time, time offset and daylight savings time via the number 
keys. Switch between the lines using the up and down cursor keys. Change 
the three following settings, from top to bottom, so that all settings take effect:

Time offset: Set the time offset (coordinated world time: UTC-12 to 
UTC+14) for your time zone here. UTC+1 is the setting for 
central Europe. 

Settings

Device

ARGUS adopts the marked 
setting as the default. 

Off

Alarm tone
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-

 
 

Daylight 
savings time: 

If central European time is selected, ARGUS calculates with a
total time offset of UTC +2 during the summer months. 

Date / time: To set the time manually, enter the correct time in your time 
zone using the ARGUS number keys. In automatic time set-
ting, ARGUS automatically reads the time from a preconfig-
ured time server.
Default: 0.de.pool.ntp.org
This can be changed to a different server. The prerequisite is 
that ARGUS can connect to the internet. Carry out e.g. a ping
test (e.g. ping www.argus.info).

The time you enter runs on the built-in ARGUS realtime clock until the power
supply is interrupted. When ARGUS is switched off and the batteries 
removed, the clock continues to run for a few days on its internal buffer. The 
time is undefined as soon as the buffer is exhausted, and must be set again.

Management 

interface

Start 
management 
interface

Determines whether the management interface is used. If 
WLAN was selected as the management interface, ARGUS 
operates as a WLAN router, see page 352. 
Depending on the selected interface, ARGUS displays either 
a WLAN or an Ethernet symbol.

WLAN: WLAN is not active (gray)

             WLAN is active (green) 

Ethernet: Ethernet is selected

Default: off

VNC server Start VNC Determines whether the VNC server is used.
Default: off 

VNC 
scaling 

Determines the scaling used to display the 
ARGUS screen on the PC. 
Range: Factor 1 - Factor 4
Default: Factor 2

WLAN When WLAN is grayed out, the management interface must 
first be halted (see above) by setting "Start management inter
face" to off. Then restart it again.

SSID The service set identifier (SSID) is a user-defin-
able name with which ARGUS can be identified as
a network. Your SSID can also be displayed using

the keyboard shortcut and  
Default: Argus155_SerialNumber 
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Password If WLAN was selected as the management inter-

face (see page 353), mobile devices log in using a
password query. 
The password (default: argus155) can also be 

displayed using the keyboard short-cut and 

.

Channel Selects the WLAN channel on which the WLAN 
stick transmits.
Range: Channel 1 to 11
Default: 1

DHCP 
server

Settings for the DHCP server:
- Starting and ending IP address
  Range: Range 0.0.0.0. to 255.255.255.255
  Default: (assignment see RFC 3330)
  Start: 192.168.10.30
  End: 192.168.10.40
- Domain name, see "User name" page 96 for
  details
- Duration of reservation for IP addresses
 Range: 1 - 99999 seconds
 Default: 240

Interface Interface Selection of the management interface 
(Ethernet or WLAN).
Default: ETH 

IP 
address

ARGUS IP address
Range: 0.0.0.0 to  255.255.255.255
Default: 192.168.20.1 (for issuing see 
RFC 3330)

Netmask IP netmask
Range: 0.0.0.0 to 255.255.255.255
Default: 255.255.255.0 (issuing see 
RFC 3330) 

Gateway Gateway IP address 
Range: 0.0.0.0 to 255.255.255.255
Default: 0.0.0.0 (assignment see RFC 
3330)
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Ring
volume

You can set the volume of the ring tone ARGUS uses to signal an incoming 
call.
For one thing, you can adjust the initial volume.
- Default: Level 1 (very quiet)
You can also adjust the end volume.
- Default: Level 7 (very loud)
For an incoming call, ARGUS begins with the initial volume (very quiet) and 
increases the volume with each ring until it reaches the final volume level 
(very loud).

Alarm tone ARGUS generates alarm tones in different situations, e.g. as soon as a bit 
error occurs in BERT or ARGUS has synchronised with an xDSL access, and
when error counters reach high counts.

Short - long Successfully synchronised

Long - short Lost synchronisation 

Short - short Error counter spike (the tone relates only to the last 
second. Only one tone sounds even when multiple errors are 
displayed.)

The setting "off" suppresses all alarm tones.
Default: off

Jingle An ARGUS jingle is played after the device powers up and initialises. 
Default: off

Power 
management

Automatic off: Sets the no-activity period after which ARGUS switches to 
power-saving mode when the power supply is not connected. When power-
saving mode is turned off entirely, ARGUS will display a warning that 
switching off power-saving mode reduces the battery time the next time it is 
powered up. You can deactivate this warning with the "X" key. <On> cancels 
deactivation.
Default: after five minutes

Company 

address

Entry of the customer address for the measurement log. Each configuration 
item permits up to 29 characters. 

Company name Default: */*

Street Default: */*

ZIP/City Default: */*

Phone number Default: */*
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Software 

option

Activates a software option. You must enter an activation key via the keypad.
A variety of  options can be activated in ARGUS; each one requires entry of a
20-digit code via the number keys.This code will be provided on request.

There are also codes for resetting options. You should only 
enter these codes when you understand what they do.

ARGUS 
manager

You can also access the ARGUS manager via the  key.

Display ARGUS manager

- Managem. interface ETH/WLAN, 
  see page 352

- LCD brightness, see page 350

- Automatic shutdown, see page 353

- Automatic charge, see page 359

- VNC server start, see page 351

Use the cursor keys  to 

activate / deactivate or change the 
settings.
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26.2 Backing up and restoring settings

With ARGUS, you can back up all settings (speed dial memory, PPP user name, PPP 
password, IP addresses, profile names, user-specific details, keypad information and 
more) and restore them if needed.

Backing up settings

ARGUS in Main Menu









All settings made in ARGUS are backed 
up unchanged and can thus be restored 
later.




Settings

Backup/restore
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The settings are now backed up and can 
be restored as necessary. 

Restoring settings
Select "Restore settings"

Enter the security password to 
back up or restore settings.
You can obtain this from your 
Technical Support or directly from 
intec (see page 10).

Restores the saved test 
settings. 

If no settings have been 
backed up, this function 
has the same effect as 
"Restore factory setting", 
see page 357.
A security password is not 
required.

Restore now?

<Yes>

and
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26.3 Restoring the factory settings

ARGUS resets all settings to the factory defaults.

The speed-dial memory, PPP user name and password, IP addresses, profile-
names, user-specific services, keypad information and all test results stored in 
ARGUS are erased.









All parameters are reset to the factory 
defaults.



ARGUS jumps directly to 
the security prompt.

Enter the security password to 
delete all settings.
You can obtain this from Technical 
Support or directly from intec (see 
page 10).

Restores the saved test 
settings.

If no settings have been backed 
up, this function has the same 
effect as "Restore factory 
defaults", see page 356.

Settings

Backup/restore

The following steps are performed 
as for "Backup settings", see 
page 355.

and

and
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26.4 Saving numbers in the speed dial memory

You can save ten 24-digit numbers in the speed dial memory.

The own number of the test access must must be entered in the first speed dial slot 
(display shows own number); this is important in particular for the automatic 
services test on ISDN accesses). In the speed dial menu, you can jump to the end 
of the list by moving up one slot from the top entry.

You can store remote numbers in the slots "Remote numbers 1 to 8". In the slot "X.31 test 
number", ARGUS expects the X.25 access number for the X.31 test (see page 242).


ARGUS in Main Menu




When entering the own number with and extension (operating ARGUS on a PBX), 
note the following: The extension is separated from the number using a "#". For 
outgoing calls, ARGUS uses the entire number (without "#") as the destination 
address (CDPN resp. DAD) and the number after the "#", i.e. the extension, as the 
sender address (CGPN resp. OAD). A "#" at the beginning of a number is treated 
as a valid digit.

Example: 02351/9070-40 is entered as 023519070#40.

If the number ends with "#", later calls are made without CGPN resp. OAD. This is 
important for some PBXs.

Scroll down to the desired spee
dial slot. Enter the number usin
the keypad.

<Delete> Deletes the space when the 
cursor is behind the last 
character, otherwise deletes the
character under the cursor.

Switches to the next higher-leve
menu without saving the numbe

Settings

Numbers

ARGUS saves the number and 
switches to the next higher level 
menu.

Entering a number
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27 Using the battery pack

Changing the battery pack
Power down ARGUS and disconnect the power adapter. Then release the knurled screw 
securing the battery pack.

Handling the battery pack 
ARGUS may only be operated using the battery pack supplied with the device; 
connecting other power supply units to the contacts of the device will damage 
ARGUS.

Automatic charging of the battery pack when ARGUS is powered down
ARGUS automatically charges the battery pack as soon as the device is powered down 
when the power adapter is connected and the battery voltage is too low. During charging, 
ARGUS displays "Charging battery" in the display. Hold down the power button to switch 
ARGUS off before the batteries are charged. ARGUS remains powered up after the battery 
pack is fully charged.

- Only charge the supplied battery pack in ARGUS.

- Do not use the ARGUS battery pack in other devices.

- Active charging of the battery pack and automatic charging (on by default) may only 
be carried out in a temperature range of 0 °C to +40 °C. 

- Charge the battery pack completely at least once a month (even if the device has not 
been used for a longer period!).

- The lithium ion battery pack should be stored with a charge of  40 to 60 %. When 
storing the device for longer periods, you should refresh this charge level every six 
months. To prevent full discharge, remove the battery pack from the device for long-
term storage.
To maximise battery life, do not store the battery long-term at temperatures above 
+50 °C.

- See the chapter Safety information (page 11) for detailed information on using and 
transporting the lithium ion battery pack safely.
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Status
ARGUS indicates the current state of the battery graphically in the display when no power 
adapter is connected. A battery symbol flashes in the display when it is down to a power 
reserve of approx. 8 minutes (depending not the operating mode). Tone errors, and in 
extreme cases malfunctions, can occur in this period. Connect the power adapter. ARGUS 
can recharge the battery completely when the power adapter is connected. The ARGUS 
power pack does not require manual discharge. A complete charging process can take up 
to approx. 6 hours.

ARGUS in Main Menu

When ARGUS is in the selection list for 
preconfigured accesses, you can switch 

to the abbreviated main menu with .
Connect the power adapter!
Start the charging process.

During the charging process, ARGUS 
displays the current status and the 
voltage.


Automatic battery charging in the background

ARGUS in Main Menu

When ARGUS is in the selection list for 
preconfigured accesses, you can switch 

to the abbreviated main menu with .

ARGUS charges the battery automatically 
in the background when the mains 
adapter is connected as soon as the 
battery status falls below a threshold 
value (battery symbol in display)


When ARGUS is disconnected from the power adapter before that battery is 
completely charged, ARGUS does not automatically continue charging when it is 
subsequently reconnected because the charge is no longer below the threshold.

<Charge> Starts the charging process.

Battery (status, charging)

Status

Battery (status, charging)

Automatic charging

on

ARGUS adopts this setting and switches to 
the next higher level menu.
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28 Firmware update

You can download firmware files online free of charge at www.argus.info/service and then 
upload them to ARGUS.
Go to the Web page www.argus.info.

Click the menu option "Service" (highlighted in blue here) in the navigation bar.







This opens up a product overview.








Select your ARGUS 
device.

In the drop-down 
Service menu, click 
the option "Down-
loads". 
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Once you select your device, you are automatically taken to the firmware updates. Select 
your country-specific firmware variant.

When you select your variant, a browser dialogue opens that enables you to save the 
firmware to your local PC. The following steps are explained in the WINanalyse manual and 
in the update tool instructions.

Important information on updating your ARGUS firmware

- Never under any circumstances update ARGUS when it is operating in battery 
mode.

- Connect ARGUS to the power adapter before uploading the update file from the 
PC. 

- An ARGUS USB cable is required for updating (USB cable with mini-USB plug). 
- You should back up the configuration and measurement logs to a PC before 

performing an update. 
- Do not disconnect ARGUS from the PC during the update. 
- Do not switch off ARGUS during the update. 
- Be sure to observe the messages in the ARGUS display, and not just the 

instructions of the update tool on the PC. 
- The update is only complete when the update tool displays the corresponding 

message on the PC and ARGUS starts with the "normal" startup screen after 
being restarted by the update tool.

- ARGUS only powers back up when you click one of the two buttons ("Back to 
step 1" or "Exit program") at the end of the update. 
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28 Firmware update
If problems occur because of a failure to follow these instructions, repeat the 
update process up to three times. Each repetition makes it possible to overwrite 
further faulty software components.


When connecting an ARGUS Copper Box, it can occur that ARGUS automatically 
initialises the Copper Box with the correct firmware in order to avoid compatibility 
issues. This can take a moment.
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29 Appendix

A) Abbreviations
Characters

.bis Reference to SHDSL.bis (Enhanced SHDSL)
1TR6 Signalling protocol (D-channel protocol) for national ISDN of the former 

German national PPT (Bundespost)
2B1Q 2 binary 1 quaternary - line code
3PTY Three party service 
4B3T 4 binary 3 ternary - a modified monitored sum 43-code (MMS43)

Δf Bandwidth

Ω Ohm (electrical resistance)
A

A Ampere (electrical current)
A3K1H Audio 3.1 kHz
A7kHz Audio 7 kHz
AAL ATM adaptation layer
AC Alternating Current or Access Server
ADSL Asymmetric Digital Subscriber Line
Al Action indicator
AIT Application information table
AMP ARGUS measurement protocol
ANSI American National Standards Institute
Anx. Annex
AOC Advice of charge
AOC-D Advice of charge

Charging information during the call 
AOC-E Advice of charge 

Charging information at the end of the call
APL ("Anschlusspunkt Linie") Service termination point
AS Available second
ASCII American Standard Code for Information Interchange
ATM Asynchronous Transfer Mode
ATU-R ADSL Transceiver Unit 
Auto-MDI-X Automatic Medium Dependent Interface Crossing
Avg Average
AWG American Wire Gauge
AWS ("Anrufweiterschaltung") Call forwarding (1TR6)

B
BC Bearer capability
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BER 1. Basic Encoding Rules
2. Bit error rate

BERT Bit error rate test 
BR Bridge
BRAS Broadband access server
BRI Basic rate interface

C
C Celsius
c0 Speed of light
CALL PROC CALL PROCeeding message
CAT Conditional access table
CC Continuity counter
CCBS Completion of calls to busy subscriber
CCNR Call complete no response
CD Call deflection
CDN see also CDPN
CDPN CalleD party number 
CF Call forwarding 
CFB Call forwarding busy 
CFNR Call forwarding no reply 
CFU Call forwarding unconditional 
CGN see also CDPN
CGPN CallinG party number
CLIP 1. Calling Line Identification Presentation 

2. Clipping
CLIR Calling Line Identification Restriction
CNS CLIP-no screening
CO Central office 
Codec Coder decoder
COLP Connected Line Identification Presentation
COLR Connected Line Identification Presentation

CONN CONNect message
CONN ACK CONNect ACKnowledge message
CQE Conversational Quality Estimated
CR Call reference
CRC Cyclic redundancy check
CT Call transfer
CUG Closed user group 
CW Call waiting

D
DAD Destination address (1TR6) 
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dB Decibel
dBm/Hz Performance measurement with the reference quantity 1 mW (milliwatt) 

per hertz
DC Direct Current 
DCE Data communication equipment
DDI Direct dialling in 
DDM Digital diagnostic mode
DF Delay factor
DFU ("Datenfernübertragung") Remote data transmission
DHCP Dynamic Host Configuration Protocol
DiffServ Differentiated services
DIN Deutsches Institut für Normung - German Institute for Standardization
DISC DISConnect message
DL Download
DM ("Dienstmerkmal") Service
DMT Discrete Multitone Transmission
DNS Domain Name System
DPBO Downstream power backoff
DSCP Differentiated services codepoint
DS DownStream band
DSL Digital Subscriber Line
DSLAM Digital Subscriber Line Access Multiplexer
DSS1 Digital Subscriber Signalling System No. 1
DTE Data Terminal Equipment
DTMF Dual Tone Multi Frequency 
DTU Data Transmission Unit

E
E1 Primary Rate Interface
EAZ ("Endgeräteauswahlziffer") Local calling number (1TR6) 
EC European Community
ECT Explicit call transfer 
E-DSS1 European Digital Subscriber Signalling System Number 1
EFM Ethernet in the First Mile (see protocol IEEE 802.3ah)
EFS Error Free Seconds
EIT Event Information Table
ElektroG Elektro- und Elektronikgerätegesetz, German law governing electrical 

and electronic devices
EMC Electromagnetic compatibility
EN European standard
EoA Ethernet over ATM
EOC Embedded operations channel
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ES Errored seconds
ESHDSL Enhanced SHDSL (SHDSL.bis)
ete end-to-end 
ETH Ethernet
ETSI European Telecommunications Standards Institute

F
F Farad (unit of electrical capacitance)
Fax G3 Telefax group 3
Fax G4 Telefax group 4
FEC Forward error correction
FFT Fast Fourier transform
FSK Frequency shift keying 
FTP File Transfer Protocol
FV ("Festverbindung") leased line
FW Firmware

G
GB Gigabyte
Gbit/s Gigabits per second
GBG ("Geschlossene Benutzer Gruppe") Closed user group
G.hs ITU-T G.994.1 handshake procedure
GigE Gigabit Ethernet

H
h hour 
HD High definition
HDLC High-level data link control
HDSL High bit rate digital subscriber line
HEC Header error checksum
hex Hexadecimal
HLC High layer compatibility
HLOG Amplitude of transmission function per tone
HOLD Call hold 
HRX value Hypothetical reference value
HTTP Hypertext Transfer Protocol
HVT ("Hauptverteiler") Main distribution frame
Hz Hertz (measuring unit of frequency)

I
IAD Integrated access device
ID Identifier
IEEE Institute of Electrical and Electronics Engineers
IGMP Internet Group Management Protocol
INFO INFOrmation Message
ARGUS 155 367
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INP Impulse noise protection
IP Internet Protocol 
IPCP Internet Protocol Control Protocol
IPoA Internet Protocol over ATM
IPoE Internet Protocol over Ethernet
IPTV Internet Protocol Television
ISDN Integrated Services Digital Network 
ISO International Standards Organization
ISP Internet service provider
ITSP Internet telephony service provider
ITC Independent TC
ITU International Telecommunication Union

K
KB Kilobyte
KVZ ("Kabelverzweiger") Cable branch box
kbit/s Kilobits per second

L
L1 Layer 1 in the OSI reference model
L2 Layer 2 in the OSI reference model
L3 Layer 3 in the OSI reference model
LAN Local Area Network
LAPD Link access procedure for D-channels
LCD Liquid crystal display
LCN Logical channel number 
LCP Link Control Protocol
LED Light-emitting diode
LLC Low layer compatibility
LOS Loss of synchronize
LOSWS Loss of sync word seconds
LQ Line qualification
LQO Listening quality objective

M
m Meter
MAC Media Access Control
MB Megabyte
Mbit/s Megabits per second
MCID Malicious call identification
MDF Main distribution frame (see also HVT)
MDI Media Delivery Index (RFC 4445)
min. Minute
MLR Media loss rate
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MMS Microsoft Media Server Protocol
Modem Modulator-demodulator
MOS Mean opinion score (ITU-T P.800)
MPEG Moving Picture Experts Group
MSA Multiple source agreement
MTU Maximum Transmission Unit
mVpp Millivolt peak-to-peak

N
n/a not available
n/r not received
n/u not used
NAT Network address translation
NGN Next generation network
NIT Network information table
NOK Not OK 
NP Numbering plan
NSAP Network service access point
NSF Network specific facilities
NT Network termination
NTBA Network termination for ISDN basic rate access
NTR Network timing reference 

O
OAD Origination address (1TR6)
OAM Operation, Administration and Maintenance
OM Omni mode
OoS Out of Sequence
OSI Open Systems Interconnection
OUI Organizationally unique identifier 

P
P/N Part number
PABX Private automatic branch exchange
PADI PPPoE active discovery initiation
PADO PPPoE active discovery offer
PADR PPPoE active discovery request
PADS PPPoE active discovery session confirmation
PADT PPPoE active discovery termination
PAM Pulse amplitude modulation
PAP Password Authentication Protocol
PAT Program association table
PC Personal computer
PCR Program clock reference
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PD Protocol discriminator
PDU Protocol data unit
PE Polyethylene
PESQ Perceptual evaluation of speech quality (ITU-T P.862)
PIC Plastic-insulated conductor
PID Packet identifier
PLR Packet loss ratio
PMT Program map tables
POTS Plain old telephone service (PSTN)
P-P Point-to-point
P-MP Point-to-multipoint
PMMS Power measurement modulation session
PMS Physical media specific
PP Polypropylene
PPP Point-to-Point Protocol
PPPoA Point-to-Point Protocol over ATM
PPPoE Point-to-Point Protocol over Ethernet
PPTP Point-to-Point Tunneling Protocol
PRI Primary rate interface
PSD Power spectral density
PSI Program specific information
PTFE Polytetrafluoroethylene
PWR Power

Q
Q in Q IEEE 802.1.ad, S-VLAN
QLN Quiet line noise
QoS Quality of service

R
RC Resistance (R) and capacitance (C)
REIN Repetitive electrical impulse noise 
REL RELease message
REL ACK RELease ACKnowledge message
REL COMPL RELease COMPLete message
RF Radio frequency
RFC Request for comments
RJ Registered jack (standardised socket)
RoHS Restriction of Hazardous Substances
RT Router
RTCP Real-Time Control Protocol
RTP Real-Time Transport Protocol
RTSP Real-Time Streaming Protocol
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Rx Received 
S

s second
S/N Serial number
SBC Session Border Controller - Outbound Proxy
SCI Sending complete indication
SDT Service description table
SES Severely errored second
SHDSL Single-Pair High-speed Digital Subscriber Line
SHINE Single high impulse noise event 
SIN Service indicator (1TR6)
SIP Session Initiation Protocol
SNR Signal-to-noise ratio
SNRM Signal-to-Noise ratio margin
Spch Speech 
SRU SHDSL regeneration unit 
SSL Secure Sockets Layer 
STB Set-top box
STU-C SHDSL Transceiver Unit - Central Office
STU-R SHDSL Transceiver Unit 
STUN Session Traversal Utilities for NAT
SUB Subaddressing 
SUSP SUSPend message 

T
T Trigger
TAL ("Teilnehmeranschlussleitung") Subscriber line
TC 1. Trellis code

2. Transmission convergence
TCP Transmission Control Protocol
TC-PAM Trellis-coded pulse amplitude modulation
TDM Time division multiplex
TDR Time domain reflectometry
TDT Time and date table
TE TErminal, terminal equipment
TEI Terminal endpoint identifier
Tel31 Telephony 3.1 kHz
Tel7k Telephony 7 kHz
TLS Transport Layer Security 
TM Test manager
ToN Type of Number
ToS Type of service
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TP Terminal portability 
TS 1. Technical specification 

2. Transport stream
TTX Teletext
Tx Transceived 

U
UDP User Datagram Protocol
UL Upload
URI Uniform Resource Identifier
URL Uniform Resource Locator
US VDSL: Upstream band or 

SHDSL: Unavailable second
USB Universal Serial Bus
UTC Coordinated Universal Time 
UUI User-user info
UUS User-to-user signalling 

V
V Volt
V/2 Pulse propagation time
VC Virtual channel
VCC 1. Virtual channel connection

2. Voltage at the common collector
VCI Virtual channel identifier
VC-MUX Virtual circuit multiplexing
VDSL Very High Speed Digital Subscriber Line
ViSyB Video syntax-based
ViTel Video telephony
VLAN Virtual Local Area Network
VL Virtual line
VLC Video LAN client
VNC Virtual Network Computing 
VoD Video on demand
VoIP Voice over Internet Protocol
VoP Velocity of propagation 
VPI Virtual path identifier
Vpp Volt peak-to-peak 
VTU-R VDSL transceiver unit

W
WAN Wide Area Network
WEEE Waste Electrical and Electronic Equipment
www World Wide Web
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B) Vendor identification numbers

X
xDSL Collective term for the different DSL variants
xTU-C xDSL Transceiver Unit - Central Office
xTU-R xDSL Transceiver Unit

Z
Z Apparent resistance
ZWR See SRU

Abbreviation Manufacturer
ALCB Alcatel (STMicroelectronics)
ANDV Analog Devices
BDCM Broadcom
GSPN Globespan
IKNS Ikanos
IFTN Infineon
META Metanoia
STMI STMicroelectronics
TSTS Texas Instruments
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C) CAUSE-Messages – DSS1 Protocol



Dec. Cause Description
01 Unallocated (unassigned) number No access under this call number
02 No route to specified transit network Transit network not reachable
03 No route to destination Wrong route or routing error
06 Channel unacceptable B channel for the sending system not acceptable
07 Call awarded and being delivered in 

an established channel
Call awarded and connected in an already existing channel 
(e.g.,  X.25 virtual switched connection)

16 Normal call clearing Normal clearing
17 User busy The number called is busy
18 No user responding No terminal equipment answered (Timer NT303 / NT310 

time-out)
19 No answer from user (user alerted) Call time too long
21 Call rejected Call rejected (active)
22 Number changed Call number has been changed
26 Non-selected user clearing Incoming call not awarded to this terminal
27 Destination out of order Destination / access out of order
28 Invalid number format (address 

incomplete)
Wrong call number format or call number incomplete

29 Facility rejected Requested service is rejected
30 Response to status inquiry Response to status inquiry
31 Normal, unspecified Unspecified for "normal class" (Dummy)
34 No circuit / channel available No circuit / B channel available
38 Network out of order Network not operational
41 Temporary failure Network is temporarily not operational
42 Switching equipment congestion Switching equipment is overloaded
43 Access information discarded Access information could not be transferred
44 Requested circuit / channel not 

available
Requested circuit / B channel is not available

47 Resources unavailable, unspecified Unspecified for "resource unavailable class" (Dummy)
49 Quality of service unavailable The requested quality of service is not available
50 Requested facility not subscribed Requested service attribute not subscribed
57 Bearer capability not authorized The requested bearer capability is not enabled
58 Bearer capability not presently 

available
The requested bearer capability is not currently available

63 Service or option not available Unspecified for "service unspecified or option not available 
class" (Dummy)

65 Bearer capability not implemented Bearer capability is not supported
66 Channel type not implemented Channel type is not supported
69 Requested facility not implemented Requested facility is not supported
70 Only restricted digital information 

bearer capability is available
Only limited bearer capability is available
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79 “Service or option not implemented, 
service or option unspecified, option 
not implemented class“ (Dummy)

Unspecified

81 Invalid call reference value Invalid call reference value
82 Identified Channel does not exist Requested channel is invalid
83 A suspended call exists, but this call 

identity does not
The call identity entered is the wrong one for the parked call

84 Call identity in use The call identity is already in use
85 No call suspended No call has been parked
86 Call having the requested call 

identity has been cleared
The parked call has been cleared

88 Incompatible destination Incompatible destination
91 Invalid transit network selection Invalid format for the transit network identifier
95 Invalid message, unspecified Unspecified for "invalid message class" (Dummy)
96 Mandatory information element is 

missing
The mandatory information element is missing

97 Message type non-existent or not 
implemented

This type of message is in this phase not permitted, not 
defined or not supported

98 Message not compatible with call 
state or message type non-existent 
or not implemented

In this phase, the message is not permitted, not defined or 
not supported

99 Information element non-existent or 
not implemented

In this phase, the content of the information element is not 
permitted, not defined or not supported

100 Invalid information element contents Invalid content in information element
101 Message not compatible with call 

state
Message not valid in this phase

102 Recovery on timer expired Error handling routine started due to time-out
111 Protocol error, unspecified Unspecified for "protocol error class" (Dummy)
127 Interworking, unspecified Unspecified for "interworking class" (Dummy)
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D) ARGUS Error Messages (DSS1)

Network The network is not in a state defined for DSS1. This may, 
however, occur in connection with normal clearing on a PBX.

Network DSS1 causes

ARGUS An error occurred during the supplementary service test.
Frequent cause: no response from network

ARGUS The CF-Test was started with the wrong own number.

ARGUS No HOLD is available, but HOLD is required to test the 
supplementary service (ECT, 3pty).

ARGUS CLIR or COLR could not be tested, since CLIP or COLP is not 
available

ARGUS The party called did not answer within the prescribed time 
(approx.10 sec)

ARGUS A call was setup to a remote subscriber, instead of being setup – 
as was expected – to your own number.

ARGUS The Auto-Test could not setup a connection and therefore the 
AOC-D supplementary service could not be tested. 

ARGUS During the Suppl.services test, a call came in without a B 
channel (call waiting). Therefore, it was not possible to accept 
the call and test.

ARGUS A call number was entered.

ARGUS Internal error

ARGUS Network did not confirm acceptance of the call (CONN sent, no 
CONN_ACK received from network)

ARGUS a) Layer 2 connection has been cleared down
b) No response to SETUP
c) Layer 2 connection could not be setup

ARGUS Reestablish the Layer 2 connection

ARGUS The selected B channel is already busy.

ARGUS No response to the clear-down (REL sent, no REL_CMP/
REL_ACK received from network)

ARGUS Remote end signaled that it is in State 0.

ARGUS Keypad sent via ESC, but no response was received from 
network

ARGUS FACility was sent, but no response was received from network

ERROR 

Number

Cause Description

0

1 to 127

150

152

153

154

161

162

163

170

199

200

201

204

205

206

210

220

245

250
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Network See ISO 8208: 1987(E)
Table 5- Coding of the clearing cause field in clear indication packets, page 35

ARGUS No answer from network (to a CALL-REQUEST or a CLEAR-REQUEST)

ARGUS Unexpected or wrong answer from network (no CALL-CONNECTED or CLEAR-
INDICATION as answer to CALL-REQUEST)

ARGUS The network has indicated in a DIAGNOSTIC message that the logical channel 
is invalid. 
Origin: No (=1) or a wrong LCN was set.

ARGUS It was not possible to determine an internal or external cause.
Origin: Layer 2 could not be setup or remote end does not support X.31

ARGUS The X.31 Layer 3 test was not performed. The error can only occur in a test log.

Network See ISO 8208: 1987(E)
Figure 14a page 121
Figure 14b page 123 et seq.
And/or CCITT Recommendation X.25, Annex E

X.31 Test – Error messages

X.31 Causes
0 to 255

257 

258

259

512

65535

X.31 Diagnostic (only for a cause less than 256)
0 to 255
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E) 

Negotiation err

Idle release

Time out rel

PPP: Echo req. 
error

Hanging up rel

Loopback erro

Authent. Error

PADO timeout

PADS timeout

Error message: PPP connection

ARGUS Display Description
External fault:

Cannot negotiate the network protocol for PPPD, so the remote 
site is not reachable.

Connection was terminated, since there was no activity.

Connection was terminated, since the maximum connection time 
elapsed.

Remote site did not answer echo requests so the connection has 
been terminated. (PPP connections are tested at regular intervals 
by sending echo requests to the remote site.)

Disconnected by remote site.

The setup of the PPP connection was cancelled, since a loopback 
was detected.

Authentication error: Wrong user name or password - rejected by 
remote site.

No PADO packets received.

No PADO packets received.
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F) Error message: Download test

Http redir.error

http: no response

Http serv.error

Http encod.error

Ftp open error

Ftp login error

Ftp passiv err.

Ftp rec. error

Network error

Ftp error

URL error

Socket error 2

Http Head.error

Ftp no file

Unknown address

Unknown download 
error



ARGUS Display Description
External fault:

Fault: Too many HTTP redirects.

No answer from HTTP server.

HTTP server has returned an error.
(for details see the table below "HTTP Error Messages")

Due to an encoding problem, data transfer with HTTP is not 
possible.

Error when opening the FTP connection.

FTP login error. Wrong user name or password or anonymous 
login not supported.

FTP server does not support passive transmission mode.

FTP receive error.

Network error

General FTP error.

Fault: No HTTP or FTP URL specified.

Error when connecting a socket. The server's HTTP service is not 
available.

Error in the header of the requested HTTP file.

FTP download error: No such file or directory found.

Unknown host address.
Possible cause: Error in the address entered, DNS resolution not 
working or network not accessible.

Unknown download error
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G) HTTP status codes:

Display on 
ARGUS:
Code No.

Meaning

100 Client should continue its request.

101 The protocol is being changed at the Client's request.

200 The Client's request has succeeded.

201 The Client's request that a new document be created was successful.

202 The Client's request has been accepted for processing.

203 The Client's request will be answered with information from a source 
other than the server.

204 The Client's request was successful. The server sends [no content] only 
the HTTP header.

205 The Client's request was successful. The server [resets content] sends a 
new HTTP body.

206 The Client's request was successful. The server sends only part of the 
requested document [partial content].

300 The request was not precise enough so multiple documents have been 
returned.

303 The requested resource has been found at a different URI and should be 
retrieved from there.

304 The requested document has not been changed in the interim.

305 The requested document must be retrieved from a proxy instead of from 
the server.

307 The requested resource has been temporarily relocated to a different 
URI [temporary redirect].

400 Syntax error in the Client's request [Client error].

401 The request requires user authentication.

402 Payment is required to process this request.

403 The Client's request has been refused. (e.g. because 
authentication failed.)

404 The requested document was not found (e.g. because of an error in the 
URL entered or while the document is no longer available).

405 The method specified by the Client in its request is not allowed by the 
server.

406 The requested document in a format that is not supported by the Client.

407 The request requires that the Client authenticate itself with a proxy.
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408 The Client did not place its request within the time allowed by the server 
[Request Timeout].

409 Due to a conflict (e.g.another request) the Client's request cannot be 
completed by the server.

410 The requested URL is [gone] no longer available on the server.

411 The Client sent data to the server without a defined Content Length.

412 The preconditions in the Client's request could not be satisfied by the 
server.

413 The Client's request has been refused by the server because the 
request entity is too large.

414 The Client sent a URL to the server that is too large 
(e.g. because of the form values contained).

415 The Client's data is not supported by the server.

416 The range (in a document) requested by the Client does not exist.

417 The server could not (or did not wish to) satisfy the Client's expectation 
given in the Expect request header field.

424 Due to a failed dependency, the requested document will not be sent by 
the server.

500 Due to an unexpected condition, the server cannot fulfill the Client's 
request (e.g. faulty configuration, missing or wrong CGI program).

501 The server does not support the function required to fulfill the Client's 
request.

502 The server received an invalid response from an upstream server or 
proxy which it accessed in attempting to fulfill the request.

503 The server is currently unable to handle the request due to a temporary 
overloading of the server.

504 The Client's request (of a gateway or proxy) did not receive a response 
within the specified time.

505 The server does not support the HTTP protocol version that was used in 
the Client's request.
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H) General Error Messages 

Prot. not supp.

Unknown error

No PPP connec.

Test aborted

Ping start error

Fault: PPP con-
nection

Unexp. PING end



Display on ARGUS Description
The protocol (IP, PPPoE, etc.) is not supported in the selected 
mode.

Unknown error occurred.

No PPP connection can be setup. 

Test aborted by user.

Error when starting the Ping test.

Unexpected termination of the PPP connection.

Unexpected termination of the Ping test.
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I) VoIP SIP status codes



SIP requests:

The six basic requests / methods:

INVITE Invite a user to a session (call - initiates a session)

ACK Acknowledge an INVITE request

BYE Terminate a session (hangup)

CANCEL Terminates the setup of a connection

REGISTER Provides data regarding subscriber availability (host name and IP address)

OPTIONS Supplies information regarding the functions supported by the other SIP 
telephone

SIP responses:

SIP responses are answers to SIP requests. There are six basic types of SIP responses 
with numerous sub-responses:

1xx Informational responses (180 indicates for example that the phone of the 
party called is ringing)

2xx Reports that the request has been successful

3xx Redirection responses

4xx Client failure responses

5xx Server failure responses

6xx Global failure responses

Display 
on 
ARGUS: 
Code No.

Meaning Explanation

100 Trying The ARGUS is attempting to setup a call.
180 Ringing The phone at the other end is ringing.
181 Call Being Forwarded The call is being forwarded.
182 Call Queued The call is in a wait loop.
183 Session Progress The call is being setup.
200 OK Everything is all right.
202 Accepted Connection has been accepted.
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300 Multiple Choices There is no unique destination address for 
the remote end. Please select one.

301 Moved Permanently Calls are being permanently forwarded.
302 Moved Temporarily Calls are being temporarily forwarded.
305 Use Proxy A proxy must be used.
380 Alternative Service Alternative service
400 Bad Request The request is not OK.
401 Unauthorized You are not authorized.
402 Payment Required Payment is required.
403 Forbidden This is not permitted.
404 Not Found The remote end was not found or does not 

exist.
405 Method Not Allowed The method (e.g. SUBSCRIBE or NOTIFY) 

is not permitted.
406 Not Acceptable The options used in the call are not 

supported.
407 Proxy Authentication Required The proxy must be authenticated.
408 Request Timeout The time for the request has been 

exceeded (timeout).
409 Conflict There is a conflict.
410 Gone The subscriber is no longer reachable here.
411 Length Required The length must be supplied.
413 Request Entity Too Large The values are too long.
414 Request URI Too Long The URI is too long. (Destination address)
415 Unsupported Media Type The codec is not supported.
416 Unsupported URI Scheme The URI scheme is not supported. 

(Destination address)
420 Bad Extension The extension is wrong.
421 Extension Required An extension is necessary.
423 Interval Too Brief There is a problem with the SIP 

parameters. 
(Register Expire is too short)

480 Temporarily Unavailable The subscriber is currently not reachable.
481 Call/Transaction Does Not Exist This connection does not exist (any longer).
482 Loop Detected A redirection loop has been detected.
483 Too Many Hops Too many redirects.
484 Address Incomplete The SIP address is incomplete or faulty.
485 Ambiguous The SIP address is not unique.
486 Busy Here The destination is busy.
487 Request Terminated The request has been terminated.
488 Not Acceptable Here The call cannot be accepted.
491 Request Pending A request is waiting.
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493 Undecipherable Decryption error.
500 Server Internal Error Internal error in the server.
501 Not Implemented The requested method (functionality) has 

not been implemented.
502 Bad Gateway The gateway is bad.
503 Service Unavailable The service is not available.
504 Server Time-Out The gateway did not respond in time.
505 Version Not Supported The SIP protocol version is not supported.
513 Message Too Large The message length is too long. Use TCP.
600 Busy Everywhere All terminals are busy at the remote end.
603 Declined The system at the remote end refused to 

accept the call.
604 Does Not Exist Anywhere This user does not exist any longer.
605 Not Acceptable SIP request not acceptable.
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J) Software Licenses

The ARGUS firmware includes code from what are known as Open Source packages, 
which have been published under various licenses (GPL, LGPL, MIT, BSD, etc.). 
Additional information can be found – if requested in your order – on the CD-ROM included 
in the package (see Software_License.htm) or can be viewed at 
http://www.argus.info/web/download/Software_License.
In the event that you are interested in the sources licensed under GPL or LGPL, please 
contact support@argus.info. A machine-readable copy of the source code can be obtained 
from intec Gesellschaft für Informationstechnik mbH for a minimal fee - to cover the cost of 
physically copying the code. This offer is valid for 3 years.
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